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NEW FEATURES IN A FAMILIAR ENVIRONMENT 
The project management package InLoox operates within Outlook, simplifying the combined administration of projects, 
documents, resources and budgets and providing highly effective support for everyday standard business processes. 

InLoox provides a current overview of the status and development of all projects, including incurred costs and budgets. It 
is thus possible to call up all financial data during the course of the project and to have the latest situation at your 
fingertips. InLoox ensures a high level of planning and scheduling reliability and furnishes comprehensive project 
documentation. Your project team, as well as your partners and customers, will appreciate this greatly. InLoox can be 
learned in the shortest time and is easy to use and simply structured. 

Further information about the InLoox product range, updates and new versions can be found on the internet. 

To be sure of a smooth start with InLoox, please read first the chapter on Basics. 
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CONTACT AND SUPPORT 
Thank you for choosing the integrated project management system InLoox. 

InLoox is a product of IQ medialab GmbH in Munich. As a customer of IQ medialab your are entitled to the manufacturer's 
direct service and support. We are also pleased to answer any questions you may have about the product generally 
during the normal office hours of 9:00 am till 5:00 pm Monday to Friday except public holidays. Please note that we are in 
the CET time zone (GMT+1). 

  

IQ medialab GmbH 

Address: Lotte-Branz-Strasse 14, D-80939 Munich, Germany 

Internet: www.inloox.com 

E-Mail: info@inloox.com 

Phone: +49 (89) 323 919 22 

Fax: +49 (89) 323 919 55 
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Everyday Tasks 
EVERYDAY TASKS 
Get to know the basic features of InLoox - via a series of brief instructions. 

Tip: Basic knowledge of Microsoft Outlook is assumed. If you have any general questions concerning the setup or use of 
Outlook, please look up the Microsoft Outlook Help or ask your system administrator. 

  

What would you like to do? 

• Create a new project 

• Open a project 

• Find a project 

• Record an activity or a document 

• Generate a project plan 

• Check resource workload 

• Display or process work packages 

• Save files and documents 

• Create a budget 

• Create an invoice 

• Monitor a project 

• Lock or complete a project 

• Create a report 

• Define views 
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Working with Projects 
CREATING A NEW PROJECT 

A brief summary of how to create a new InLoox project: 

  

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. Double-click on an empty field or use the button New Project 
A new project is opened  
As creator of the project you will automatically be registered as project manager 

3. Input the required information, e.g. Project name or Customer 
The list of customers contains a preliminary selection of all companies participating in InLoox projects 

4. Click on Save and Close 

  

Continue with Open project 
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OPENING A PROJECT 

A brief summary of how to open an InLoox Project: 

  

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. Double-click on one entry in the list, e.g. Demo project  
The selected project is opened 

3. Click on a tab, e.g. Document 

4. Input new entries or make any required changes 

5. Click on Save and Close 

  

Or: 

1. Click on the button Recent Projects in the InLoox Toolbar 

2. Select a project from the list which displayed 

   

Continue with Finding a project 
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FINDING A PROJECT 

A brief summary of how to search for information in all InLoox projects: 

  

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. Input a search text into the field Search, e.g. InLoox 

3. Click on Start search 
InLoox carries out the search. A list of results is displayed 

4. Double-clik on one entry to open the required project 

  

Or: Use views 

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. Select a view from  the Aktuelle Ansicht area in the InLoox Toolbar, e.g. Grouped by managers 

3. Double-click on one entry to open the required project 

  

Or: Use filter 

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. The filter row is above the list of projects: 

 
Filter row with active filter *Marketing* 

3. Input text, e.g. Marketing and press ENTER 
InLoox filters the Projects according to the criterion ("Project name contains Marketing")  

4. Double-clik on one entry to open the required project 

  

Continue with Record an activity or a document 
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RECORDING AN ACTIVITY OR DOCUMENT 
A brief summary of how to record an activity or document in an InLoox project: 

  

Method A: Adding directly from Outlook  

1. Select an email, for example, from your personal Outlook Inbox (or any other Outlook folder) 

2. Click on the button Add element... in the InLoox Toolbar 
The dialog box Select project is displayed. 

3. Select a Project 

4. Select the action to be taken:  

• Record new activity 
Activities are records of time spent for a project, e.g. work carried out 

• Add to document folder  
Documents are files which are assigned to a project 

1. Select the action InLoox is to take on the attachment, if present 
Details of this feature can be found under Attachment management  

2. Select a sub-folder if needed 

3. Select Link document to activity 
InLoox will then display a paper clip ( ) in the Activities area under the Activities 
tab. 
The paper clip gives access to all documents linked to a given activity. 

5. Click in OK 
If you have selected the option Create new activity, the dialog box New activity is displayed 

6. Please input at least the following:  

• Date and time (proposed automatically) 

• Duration 

• Group, to which the activity belongs 
or alternatively: the Phase to which the activity belongs 

7. Click on OK 

  

  

Method B: Open a project and add via the project form 

1. Open a project or create a new one 

2. Click on the button New in the Activities area under the Activities tab. 
The dialog box New Activity is displayed. 

3. Please input at least the following:  

• Date and time (proposed automatically) 

• Duration 

• Group, to which the activity belongs 
or alternatively: the Phase to which the activity belongs 



Everyday Tasks 

10 

4. Click on OK 

5. Click on the Document tab  

6. Create a new entry in the Documents area:  

• Click on New 
The dialog box New document is displayed: 

• Select a type, e.g. File 

• Specify the path of the document. Click on the button "..." to open a search window 

• Specify whether InLoox is to copy the document into the project folder 

• Select if required an activity, to which the document is to be linked. 
InLoox then displays a paper clip ( ) in the Activities area under the Activities tab. 

• The following additional information can also be input:  

• Status, e.g. completed or awaiting release 

• Notes (multiple-line) for comments and remarks 

• Click on OK 
If sp defined, InLoox will copy the document automatically to the project folder 

7. Click on Save and Close 

  

Continue with Create a project plan  



Everyday Tasks 

11 

Planning 
CREATING A PROJECT PLAN  

Concise instructions on the planning of a project: 

  

1. Open a project or create a new one 

2. Click on the Planning tab  

3. Under Planning:  

• Click on New..., then on Phase or Milestone  
The dialog box New Phase or New Milestone, respectively, is displayed. 

• Enter at least a Name and a Group  

Enter a time period (for a phase) or a date and time (for a milestone) 

• The following can also specified under the Standard tab:  

• Location 

• PSP code ("Work breakdown structure code"), to permit easier identification of an 
element 

• Element cannot be moved on the timeline 
Specifies that the element cannot be postponed or brought forward 

• Enter additional information under the Details tab:  

• Flag, for color highlighting 

• Description (multiple-line), e.g. for work instructions 

• Progress (for a phase, as a percentage) 

4. Optional: Select a predecessor:  

• Click on the Linking tab  

• Select an available successor in the list left 

• Click on Add (>>) 

5. Optional: Add resources:  

• Click on the Resources tab  

• Click on add  
The dialog box New Resource is displayed.  

• Click on the button "..." 
The dialog box Select contact is displayed.  

Select a contact or a distribution list  

• Click on Select >> 

• Click on OK 

• Specify separately for each resource:  
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• Notification via email, task request, appointment request or InLoox Task 
In this case resources are informed automatically.  

• Change Workload (only for a phase) 

• This task is already completed indicates whether the resource has completed the 
assigned work. 

• Click on OK 

• Check if needed the workload 

6. Click on OK to close the dialog box 

7. Use the mouse to adjust the sequence and duration of elements. 
Hold down the Ctrl key and drag predecessors and successors between phases and milestones with the 
mouse 

8. Use the Shift key when moving or expanding elements in order not to affect predecessors and 
successors  

9. Zoom, by holding down the Ctrl key and scrolling with the mouse wheel 

10. To save the project, click on Save and Close 

  

The following symbols may appear alongside the planning elements: 

• A check mark shows that the element is completed 

• An alert symbol shows that an element lies in the past but has not yet been completed 

• A flag highlights an element 

• A pin shows that an element is fixed, i.e. cannot be moved along the timeline 

• The symbol resource shows that resources have been assigned to the element 

• The symbol resources have completed work shows that all resources of an element have completed their 
tasks successfully 

• A paper clip is displayed alongside an element to which documents are linked 

  

Elements can be rearranged as follows: 

• moves the selected elements upwards or downwards 

• assigns the selected element to the element above it 
The element above is automatically incorporated in a grouping. 

• assigns the selected element one grouping level higher 

 
Continue with Check resource workload 
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CHECKING RESOURCE WORKLOAD 

Concise instructions for checking a resource's workload: 

  

The Resources Overview can be called up in three different ways: 

• Click on the menu command Tools >> Resource Overview in the InLoox Toolbar 
In this case the Resources Overview shows all resources of all projects existing  

• For an opened project: 
In this case the Resource Overview shows all resources of the selected project 

1. Open a project or create a new one 

2. Click on the Resource Overview button in the Toolbar or use the key combination Ctrl + O 

• For an opened planning element: 
In this case the Resource Overview shows all resources of the selected phase 

1. Open a project or create a new one 

2. Switch to the Planning tab  

3. Click on New >> Phase 

4. Switch to the Resources tab  

5. Click on Workload 

  

Uses of the Resource Overview: 

• Check one specific resource by clicking on it 
A graphical overview of the workload in the specified time period is displayed 

• A yellow field ( ) indicates that a resource is occupied but not overloaded in the specified time period 
A shaded yellow field ( ) indicates that a Resource is overloaded in the specified time period 

• It is possible to change the workload of a resource by editing the relevant phase 

• enlarges or reduces the view 

• updates the view 

• The option Show Exchange Calendar displays or hides the information of the Free/Busy service of Microsoft 
Exchange Server. 
When display is activated InLoox takes account of the Exchange Server calendar information when calculating 
the workload  

  

Continue with Display or process work packages 
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DISPLAYING AND PROCESSING WORK PACKAGES 

A brief summary of how to transfer work packages to your calendar or task folder: 

  

If you are planned into an InLoox project, the project planner can pass information to you in various ways: 

• by automatic Outlook task or meeting request 

• by automatic email 

• by InLoox task 

  

Option 1: by Outlook task or meeting request (*) 

1. You receive an email, for example with the title "New element ( Strategic Project #2007-0002 ) : Max Smith 
(msm@test.com)". Sender is the project planner. 

2. You see the following planning data:  

• Project name and number 

• Time frame or date 

• Your own effort 

• Location 

• involved resources 

3. You have the following options:  

• agree, whereupon Outlook automatically creates an entry in your task list or calendar. 

• decline 

Outlook reports the response to the project planner. In the case of a task request the project planner is kept 
constantly formed about the progress of and changes to all tasks assigned to you. 

  

Option 2: by email (*) 

1. You receive an email, for example with the title "New element ( Strategic Project #2007-0002 ) : Max Smith 
(msm@test.com)". Sender is the project planner. 

2. You see the planning data:  

• Project name and number 

• Time frame or date 

• Your own effort 

• Location 

• involved resources 

3. You have the following options: 
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• accept and create an entry in your calendar or task list manually. 

• decline and reply in free form via your email software. 

  

Option 3: by InLoox task (*) 

1. Outlook displays the dialog box InLoox task: 

 

2. Click on an entry in the list. You see the planning data:  

• Project name and number 

• Time frame or date 

• Your own effort (in hours) 

3. Click on one of the following:  

• Open details 
Further information on the task is displayed 

• Open project  
The project is opened 

• Close all 
Closes the dialog box 

4. You see the open InLoox tasks in the InLoox Task Overview. You are informed automatically of any 
changes. 

  

(*) The type of communication is selected by the project planner. Users without InLoox can only be informed via task 
request, meeting request or email. The project planner can also decide to withhold information from a resource. 

  

Continue to Storing files and documents 
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STORING FILES AND DOCUMENTS 
A brief summary of how to assign files, Outlook objects and internet addresses to a project: 

  

1. Open a project or create a new one   

2. Click on the button New in the Document tab 
It may be necessary to enter the project number and the customer name in the Manage tab. 
The dialog box New Document is displayed. 

3. Proceed as follows:  

• Select a type, e.g. file 

• Specify the path of the document. Click on the button "..." to open a search window 

• Specify whether InLoox is to copy the document into the project folder 

• Select as required an activity to link the document to an activity. 
InLoox displays a paper clip ( ) in the Activities area under the Activity tab 

• Add other information as appropriate:  

• Status, e.g. complete or awaiting release 

• Notes (multiple lines), for comments and remarks 

• Click on OK 
InLoox copies the document into the project folder automatically if so specified. 

4. Tip: Documents can be added to the list with Drag and Drop 

5. Click on Save and Close 

  

Alternative method: Save directly from mail inbox 

1. Select for example an email from your personal Outlook inbox 

2. Click on the button Add element... in the InLoox Toolbar 
The dialog box Select project is displayed. 

3. Select a project 

4. Activate the option Add to document folder 

5. Specify how InLoox should process any attachments 
Details of this feature are to be found under Attachment management.  

6. Click on OK 

  

Continue with Create a budget 
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Working with Budgets 
CREATING A BUDGET 

A brief summary of how to create a new budget document: 

  

1. Open a project or create a new one 

2. Click the tab Budget 

3. Create a new document in the Budget area: 

• Click on New >> Expenses 
The dialog box New Budget is displayed. 

• Specify a Date 

• Select the Status, e.g. open 

• Enter a Name, e.g. Estimation or Customer offer 

• You can also add assets from an existing document belonging to the same project (e.g. Costs). 
Details of this feature can be found under Add Asset 

• Click on OK 
InLoox creates a new budget. 

4. Add an item manually:  

• Click on the Plus sign (+) on the right 
The dialog box New item is displayed: 

• Select a Group 

• Select an Asset 
InLoox loads the data from the InLoox Assets 

• Change the Name, description, Quantity, Unit price or Amount as required 

• Click on OK 

5. Optional: export the budget:  

• Flag one budget in the list at left. Click on Report... 

• Select a report 

• Output the budget to Excel or as a PDF or Word document or send it by email 

6. Click on Save and Close 

  

Continue with Create an invoice  
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CREATING AN INVOICE 

Concise instructions on creating an invoice: 

  

1. Open a project or create a new one 

2. Click on the Budget tab 

3. Create a new document in the Budget area:  

• Click on New >> Invoice 
The dialog box New Budget is displayed: 

• Input a Date  

• Select the Status, e.g. open 

• Input a Topic, e.g. Invoice or 20% discount 

• You can also add assets from an existing document (e.g. calculation) from the same project. 
Details of this feature can be found under Adding Assets. 

• Click on OK 
InLoox creates a new Budget. 

4. Add items manually:  

• Click on the plus sign (+) on the right 
The dialog box New Asset is displayed: 

• Select a Group 

• Select an Asset 
InLoox loads the information from the InLoox Budget Assets 

• Change Description, Quantity, Unit price or Total 

• Click on OK 

5. Optional: export the invoice to Excel, Word or Adobe PDF:  

• Flag one invoice in the list on the left. Click on Report >> Expenses / Calculations / Invoice 

• Print the invoice or send it by email 

6. Click on Save and Close 

  

Continue with Project controlling 
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PROJECT CONTROLLING 

Concise instructions on project controlling: 

  

1. Open a project 

2. Click on the Budget tab 

3. Click on the button Overview. 
The overview area is displayed 

4. In the overview area you will see the figures cumulated by Group 
Details can be found under Budget: Overview area 

5. Optional: export the report to Microsoft Excel:  

• Click on Report >> Budget Overview 

• Print the report or send it by email 

6. Click on Save and Close 

  

Further instructions on project controlling: 

• Check the totals under the columns Actual costs, Revenues (actual) and Margin (actual)  

• A line marked in red ( ) shows an anticipated negative result 

  

Use specific views to carry out controlling for more than project at once: 

1. Click on button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview 

2. Select a view from the InLoox Toolbar, e.g. Project controlling 

3. Double-click to open the required project 

  

Continue with Locking and completion of projects 
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COMPLETING OR BLOCKING A PROJECT 
Concise instructions on completing or blocking a project: 

  

1. Open a project 

2. Click in the Time/Status area: 

• Select locked in the Mode list 
The project can now only be edited or deleted by authorized users. 

• Select Completed or Aborted as status 

3. Click on Save and Close 

  

Continue with Create report 
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CREATING A REPORT 
A brief summary of how to create a report: 

  

1. Click the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox Project overview. 

2. Select one or more projects from the list with the mouse 

3. Click the menu item Reports >> Create Report... in the InLoox Toolbar 
Details of the report generator are to be found under Creating and editing reports 

4. Select a report template from the list and click OK  

• InLoox transfers the data - for example to Excel, Word or an Adobe PDF file 

• Print the document or send it by email 

  

Continue to Define views 
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DEFINING VIEWS 
A brief summary of how to create and save views: 

  

1. Click the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox project overview. 

2. Click the list Current View 

3. Select a view from the list, e.g. Project Controlling 

4. Change the view in the InLoox Folder (e.g. filter, sort, Grouping, field selection) 

5. Click Save current view  in the InLoox Toolbar (under Current View)  

1. Enter a view name 

2. Select whether the view is for all users to see or just for yourself 

3. Click OK 
The new view is created. 

  

Continue to Create a new project  
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Basics 
INLOOX BASICS 
This chapter contains a description of the structure and basic features of InLoox. Basic knowledge of Microsoft Outlook is 
required. 

If you have any general questions about the installation or operation of Outlook, please refer to the Microsoft Outlook Help 
or ask your system administrator. 

  

The structure of InLoox is very simple and consists of the following: 

1. the InLoox Toolbar, which is displayed at all times 

2. the InLoox Folder, an overview of your InLoox projects 

3. the individual InLoox Projects, which are to be found in the Project overview 

4. the InLoox Task Overview, which shows currently open and completed work packages  

5. the InLoox Options, which govern base parameters and permissions 

  

Important: 

• Users should read the chapter on Everyday tasks thoroughly 

• Administrators should also read the chapter on Detailed information 
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InLoox Toolbar 
INLOOX TOOLBAR 

Once the InLoox installation has been successfully completed on your computer you will see the InLoox Toolbar: 

 

  

  

The InLoox Toolbar is always displayed and provides the following commands: 

1. InLoox Folder: switches to the InLoox Project Overview in the InLoox Folder. The InLoox Folder is 
comparable to an email, calendar task folder. The InLoox Folder can be located on a network server or on 
your own hard disk, depending on the version installed. 

2. Recent Projects: displays a list of projects, organized by project number, opened most recently. A 
maximum of ten projects is stored per user. A click on an entry opens the project, provided it has not been 
deleted in the meantime. This feature provides faster access to projects you are currently working on. 

3. Current View: provides a list of different versions of the project overview and includes view customizing. It is 
possible to set up common views for all users or personalized views just for your own use. 

4. Add to Project...: select for example an email or a calendar entry. A click opens the dialog box to record an 
activity or document for a project. It is possible to post emails, tasks, contacts, journal entries and calendar 
entries directly from Outlook to a project. Further information can be found in the chapter on Adding an 
element. 

5. Reports: transfers the data from a project to a variety of document and file formats. Select one or more 
projects from the InLoox Project Overview and click on Reports >> Create Report. You can store your 
own report definitions (e.g. filters). Further information can be found in the chapter on Creating and Editing 
reports 

6. Tools: this is where for example supplementary functions such as the InLoox Options can be called up, 
Software licences managed, or the user interface language defined. In the InLoox Workgroup and 
Enterprise Edition some of these commands are reserved for the InLoox administrator. 
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ADDING AN OUTLOOK ELEMENT TO INLOOX 

A significant advantage of InLoox is its close integration with Outlook. To record activities (dates and effort) and 
documents (e.g. emails or attachments) for a project, use the button Add to Project... in the InLoox Toolbar. 

Detailed information on the recording of entries can be found in the chapter on Hints: adding elements. 

  

Proceed as follows: 

1. Select for example an email from your personal Outlook inbox (or any other folder) 

2. Click on the button Add to Project... in the InLoox Toolbar 
The dialog box Select Project is displayed. 

3. Select a project 

4. Select the action to be taken:  

• Create new activity 
Activities are records of time spent for a project e.g. work carried out 

• Add to document store 
Documents are files assigned to a project 

1. Select the Operation InLoox is to carry out with the attachment - if any 
Details of this feature can be found in the chapter Attachment Management 

2. Select if required a Subfolder 

3. Select Link document with activity  
InLoox will then display a paper clip ( ) in Activities under the Activity tab. 
The paper clip can be used later to access all documents linked to the activity. 

5. Click on OK 
If the option Create new activity was selected, the dialog box New Activity is displayed. 

6. Please enter at least the following:  

• Date and Time (these are set automatically and can be changed if needed) 

• Duration 

• Group, to which the activity belongs 
or alternatively the Phase to which the activity belongs 

7. Click on the button OK 

  

Note 

The following standard elements can be posted directly to an InLoox project: emails, contacts, tasks, journal entries 
and calendar entries.  

Non-standard message types are not supported by InLoox. 

Hint 

It is possible to customize the project list view. Click with the right-hand mouse button on a column header. A popup 
menu is displayed. Insert new fields or hide insignificant ones with the command Choose fields. Filter the project list 
with the command Display filter. 
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HINTS: ADDING ELEMENTS 

A few practical hints to assist the everyday use of the button Add element: 

• Maintain data promptly - especially when many activities have to be recorded per day. Advantage: nothing gets 
forgotten, you colleagues can always see the latest situation and you save yourself trouble of the awkward 
reconstruction work and the end of the day or month. The project is always fully documented 

• Keep your calendar in such a way you can always show it to a third party without having to explain this or that 
entry. Proper recording of time, work and documentation is automatic, since activity descriptions do not have to 
be written anew each time. You also benefit from a clearer overview of your daily work 

• Post entries that are related to more than one project separately for each one. Do not forget to allocate the time 
correctly 

• Microsoft Outlook creates journal entries automatically for work with Office documents (e.g. Word, Excel or 
PowerPoint) and records also how long the documents were open. Use the journal entries as a memory aid for 
recording work and time in InLoox 
 
Automatic time recording for Outlook journal entries is carried out as follows:  

1. Click on Tools >> Options in the Outlook menu 

2. On the tab Preferences click on the button Journal Options... 

3. The list Also record files from shows all installed Microsoft Office products. Activate all entries. 

4. Click on OK 

5. Click on OK 

Now you can post the automatically created journal entries in the usual manner using the button Add element 
in the InLoox Toolbar. The duration is automatically recorded by InLoox. Important: Check for each posting 
that the times automatically recorded by Outlook are correct. It can be that the document was not being viewed 
for the whole time it was opened 
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ATTACHMENT MANAGEMENT 

Information on using InLoox in connection with Outlook elements with attachment: 

When you insert an Outlook element with attachment into an InLoox project, there are various processing options. 

Outlook elements such as emails, tasks or calendar entries can be inserted via the InLoox Toolbar using the button Add 
to Project... or via an opened InLoox project using the Document tab 

  

The example of an email is shown to help you select the most practical method: 

Method Action Pros & cons 

Element with attachment InLoox assigns the email and the 
attachment in file form to a project. 
(Outlook does the same.) 

Email and attachment are stored 
together. 

The document list shows whether 
the element is carrying an attachment 
but no details of the attachment, such 
as name or type. 

Element without attachment InLoox assigns only the email to the 
project. All attachments will be 
removed. 

Saves storage space. 

Attachments can neither be 
displayed nor saved in InLoox. 

Attachment only InLoox assigns only the attachment to 
the project. The email is discarded. 

Removes superfluous 
correspondence. 

Correspondence (including notes) 
can neither be read nor saved in 
InLoox. 

Element and attachment 
separately 

InLoox assigns the email and 
attachment to the project separately. 

Correspondence is kept. 
Attachments can be seen in the 
document list with name and type. 

Relationship between 
correspondence and attachments is 
lost. 
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CREATING AND EDITING REPORTS 

Under Reports in the InLoox Toolbar it is possible to output analyses and summaries in a wide variety of file formats.  

 

  

To create a report 

1. Select one or more projects from the InLoox Project Overview 

2. Click on Create Report... 
The dialog box New Report is displayed 
 

 

3. Specify the Selection and select a Template 

4. Optional: Filter the report data 

5. Optional: Save the report for faster access 
Details can be found in the chapter on Saving reports 

6. Click on OK 
InLoox creates the report. The dialog box Ouput Parameters is displayed. 

7. Select the required Output Parameters and click on OK 
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FILTERING REPORT DATA 

Under Reports >> Create report in the InLoox Toolbar it is possible to output analyses and summaries in a wide variety 
of file formats. 

 

 
Filtering Data 

1. Data can be filtered in the dialog box New Report in a number of ways: 

 
 
Filter for the Planning Page: 

• Select All planning elements to include the entire list of planning elements 

• Select Following planning elements only to filter:  

• Grouping, to transfer grouping elements (phases with sub-elements)  

• Filter Phases and Milestones by switching off the relevant parameters 
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• The time interval can also be restricted by specifying ("Date between")  

 

 
 
Filter for the Activities Page:  

• Select All activities to include the entire list of activities 

• Select Following activities only to filter:  

• by date interval 

• by name of person carrying out the activity 

• by group  
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Filter for the Budget Page:  

• Select All Budgets to include the entire list of budgets and Budget assets 

• Select Following budgets only to filter:  

• by type (activity costs, calculations, costs, invoices)  

• by date interval 

• by budget state  

• by billing state of each asset 
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SAVING REPORTS 

In the InLoox Toolbar under Reports >> Saved reports it is possible to store and manage reports under a user-defined 
name for quick and easy access. 

Saved reports can be found under the Menu Reports in the InLoox Toolbar: 

 

 
To manage saved reports 

1. Click on Saved reports ... 
The dialog box Saved reports is displayed 
 

 

2. A new report is created by clicking on New and can be stored away under a recognizable name 

3. An existing report can be changed by clicking on Edit  

4. Click on Save 
New reports can now be viewed under the menu Reports in the InLoox Toolbar  
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InLoox Project Overview 
INLOOX PROJECT OVERVIEW 

Click on InLoox Folder in the InLoox Toolbar. A project overview is displayed. Each entry shows information on one 
project. The normal display includes all projects for which you have permission.  

Information on daily work can be found in the chapter on Hints on the InLoox project overview 

  

Important features of the project list include: 

• A double-click on an entry opens an existing InLoox project 

• A double-click on an empty field creates a new InLoox project 

• A keystroke switches to the project whose name begins with the corresponding letter. 

• The search list permits any information, including within a project, to be found quickly.  

  

The format is as follows: 

• projects displayed in red are overdue 

• projects striked out are completed or discontinued. 

  

Sample view:  

 

  

The following short-cut keys are available for the project overview: 

• F4: create new InLoox project 

• F2: update project list 
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• Ctrl + P: print project list 

• Ctrl + A: select all projects 
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HNITS ON THE USE OF THE PROJECT OVERVIEW 

We have gathered some information on the InLoox Project Overview for new users of Outlook. The basics described 
here also apply to all other Outlook folders. They will help you to optimize your personal productivity and keep better track 
of your project work 

  

Hints: 

• You can define new views, for example projects with open budgets or projects sorted by state. Do take 
advantage of this facility. Select a different view from the list Current view in the InLoox Toolbar. More 
information on this topic can be found in the chapter on Defining views 

• Search through the project list for relevant information that you have input for your projects, no matter whether it 
be an offer, a contact, a specific amount or a note in the activities. You can also use filters to seek out a specific 
project or reduce the view to shows only the data you need. More information on this topic can be found in the 
chapter on Finding Projects 

• You can also modify the columns of the project overview. All Outlook sorting, filtering and grouping features can 
be used in the InLoox Project Overview. More information on this topic can be found in the chapter on Hints 
on the use of personalized views 
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InLoox Project 
INLOOX PROJECT 

A double click on an entry in the InLoox Project Overview opens the corresponding InLoox project. It is possible to 
create a new project by double-clicking on an empty field in the Project Overview or by clicking the button New Project. 

  

The entire information on an InLoox project is contained in a form consisting of five pages: 

1. The Manage page contains the project header information. This includes project number, name, customer, 
persons in charge, contact persons, objectives and degree of urgency. 

2. The Planning page provides a chronological overview of the project in the form of phases and milestones. 
Resources, dates, duration and interdependencies are held in the database. Automatic planning 
communications and project cost estimation facilities are available. 

3. The Activities page lists all activities carried out by project team members (time and effort), events and 
notes. Thus, this page shows activities already performed. 

4. The Documents page supports the straightforward management of all documents concerned with the 
project. Outlook elements, internet links and information are assigned to the project. Documents can be 
opened and edited within InLoox. 

5. The Budget page is for the management of expenses, calculations and invoices. All budgets are assigned a 
state and can be exported using a simple procedure. The budget overview maintains an ongoing 
comparison of planning, activity costs and budgets.  A cost controlling facility displays all amounts 
summarized by Group and highlights negative items. 

  

Information on the Menu and Toolbar in the InLoox Project can be found here. 
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Manage Page 

MANAGE PAGE 

The Manage Page is the principal starting point for anyone involved in the project. This aspect of InLoox can be looked 
upon as a portal through which all significant project data can be looked up and stored away in condensed, structured 
form.  

  

Information in the Manage Page: 

• Detailed information on the page areas Project, Time / State, In charge, Custom and Notes 

• Concise instructions on how to create a new project and lock or discontinue a project 

• Descriptions of the dialog box Categories and of Menus and Toolbars 
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MANAGE PAGE: PROJECT AREA 

Detailed information on Manage Page: elements, features and descriptions. 

  

The Project area: 

Element Description 

Name Freely definable short description of the project. The project name can be used 
more than once. 

Number 
(mandatory) 

Unique project number. Once assigned, this number cannot be changed by the 
user. This field is a mandatory input. The format of the project number can be 
customized under InLoox Options 

Customer Customer name. For internal projects a department or business area can be 
named. InLoox will display a selection list of the customer names already 
entered for all visible projects. 

Categories... Enter a defining characteristic for the project, e.g. customer initials, internal 
department name or business area. The category is freely definable. This field 
helps the sorting and selection of similar projects from a large project base. 
Clicking on a button causes the dialog box Categories to be displayed 
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MANAGE PAGE: CATEGORIES DIALOG BOX 

Detailed information on the Manage Page: An existing project is assigned to a category as follows: A category is a 
keyword or expression that is useful in project administration for searching, finding, filtering or grouping projects. 

  

A brief summary of how to use categories 

1. Open a project or create a new one 

2. Click on the button Categories in the Project area of the Manage Page)  
The dialog box Category is displayed: 
 

 

3. Activate the relevant category in the list 

4. Click on OK 

  

Hint 

It is possible to add, change or delete categories. Further information can be found in the chapter on Editing Categories 
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MANAGE PAGE: TIME / STATE AREA 

Detailed information on the Manage Page: elements, features and descriptions. 

  

The Time / State area: 

Element Description 

State Specify here the state of development of the project. Possible options are In 
progress, Completed or Discontinued. The project state options can be 
customized under InLoox Options  

Start Select from the calendar a date for the start of the project. This may also be 
typed in directly. When a new project is created, today's date is proposed 
automatically 

End Select from the calendar a date for the anticipated end of the project. This may 
also be typed in directly. When a new project is created, today's date is 
proposed automatically. The end date must not be earlier than the start date 

Fixed deadline Specifies whether the end date can be postponed. Typical examples of fixed 
deadline projects are trade fairs and Christmas card mailings. 

Priority Specifies the urgency of the project. Possible settings are low, normal or high. 
The standard proposed setting is normal. Projects of low or high priority are 
flagged in the Project Overview with or  respectively. 

Mode Select locked to shield the project from any changes. The mode can only be 
changed by authorized users. Permissions can be changed under InLoox 
Options for each user separately or on a role basis  
If mode is set to inactive, project notifications are deactivated. No messages 
are sent to the project resources 

Hint Use views to monitor the state of several projects at once. Further information 
on this can be found in the chapter on Generating personalized views 
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MANAGE PAGE: IN CHARGE AREA 

Detailed information on Manage Page: elements, features and descriptions. 

  

The In charge area: 

Element Description 

Manager... Click on this button and select from the list one or more managers for the 
project 

Team... Click on this button and select from the list one or more internal team members 
or employees for the project 

Customer... Click on this button and select from the list one or more contact persons from 
the Sold-to party or Customer for the project 

Partner... Click on this button and select from the list one or more contact persons from 
Partners or Supplier, who are currently involved in the project 

More... Click on this button and specify any other contacts, e.g. quality management 
staff, heads of department or other stakeholders 

 Important 
When using InLoox Workgroup or Enterprise Edition, persons in charge may 
have permissions to access the project. This depends on how InLoox has been 
configured. 

Further information can be found in the chapter on User-based permissions in 
the InLoox Option 

 Hints The following is also possible:  

• View a contact by double-clicking on the name 

• Create a new contact by clicking on one of the buttons Team..., 
Customer... or Partner.... There is also a select contact option 

• Select a mailing list containing for example all members of the 
customer's project team. Mailing lists are automatically resolved by 
InLoox 

• A click with the right-hand mouse button will open a popup menu to 
delete and alter the sequence of contacts 
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MANAGE PAGE: CUSTOM AREA 

Detailed information about the Manage Page: elements, features and descriptions. 

  

The Custom area: 

Element Description 

List (Name / Value) For the input and display of supplementary information, for example security 
rating, risk factor, project code or technical abbreviations. 

New fields can be added via the dialog box Edit Custom Fields. 

Hint 
Define new fields as soon as possible to allow information to be structured. 

Displays of custom fields within the project and can be sorted, grouped and 
filtered. Further information can be found in the chapter on Hints on 
personalized views 
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MANAGE PAGE: NOTES AREA 

Detailed information on the Manage Page: elements, features and descriptions. 

  

The Notes area: 

Element Description 

Title Displays the date of last update and the name of the person carrying this out, 
identified by Outlook or Windows account name.  
In new projects the remark "Not yet created" is to be seen here. 

Input field Multiple-line free text field for the concise recording and sharing of significant 
project data. Enter here for example the project objective, the order type or 
internal remarks. 
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Planning Page 

PLANNING PAGE 

The Planning Page displays the phases, milestones and resources of a project. Costs and descriptions of the work 
steps can also be recorded. Everyone who is involved in the project is kept automatically informed about the planning 
elements by InLoox or via Outlook. Links to files and internet addresses can also be assigned to specific planning 
elements if needed 

  

Information on the Planning Page: 

• Details of the areas of the page: Planning 

• Concise instructions are available: Create planning, Display and process work packages, Create grouping 

• Descriptions of the dialog boxes: New Phase / Edit Phase, New Milestone / Edit Milestone, New Grouping / 
Edit Grouping,  Load Template, Save template, Resource Overview, Print 
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PLANNING PAGE: PLANNING AREA 

Detailed information on the Planning Page: elements, features and descriptions. 

  

The Planning Area: 

Element Description 

New Creates a new element in the Gantt chart: Milestone or Phase. A click on this 
button causes the dialog box New Milestone or New Phase to be displayed, 
according to type. The element is inserted behind the currently selected element  
It is also possible to load or save a planning template  

Edit Changes the selected element in the Gantt chart. A click on this button causes 
the dialog box Edit Milestone, Edit Phase, or Edit Grouping to be displayed, 
according to type 

Delete Removes the selected element from the Gantt chart 

Up/Down ( / ) Moves the selected element up or down the list 

Group ( / ) groups the selected element one level deeper 

moves the selected element one group level higher  
More information can be found in the chapter on Creating Groupings 

Done Sets the selected phase to "Done". If the phase has already expired, the alert 
( ) is removed 

Report... Copies the contents of the planning into a report. The report template can be 
customized. Permission is required. Details can be found under Customizing 
Report Templates 

Copy to... Select Task List to create a new Outlook task ( ) in your personal task list. 
The command Calendar creates a new appointment in your personal calendar 
( ). The data from the selected element (phase, milestone or grouping) are 
transferred automatically 

Print... Prints the Gantt chart. Clicking on this button causes the dialog box Print to be 
displayed 

Today Switches to today. The red day line is centered in the Gantt chart. 

Display all Adjusts the date interval of the Gantt chart to the project end or start (Manage 
Page) 

Zoom ( / ) Changes the Gantt chart view. Possible values:  

• Years 
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• Quarters 

• Months 

• Weeks 

• Days 

• Hours 

• Quarter-hours 

• Minutes 

Gantt chart • Use the mouse to adjust the position and duration of the elements. 
Hold down the Ctrl key and "draw" the predecessor/successor 
relationship between phases and milestones. Scrolling with the 
mouse changes the zoom level 

• Use the shift key when moving or enlarging elements to prevent 
the successor and predecessor from being influenced 

• Zoom by holding down the Ctrl and scrolling with the mouse wheel 

• The present time, or day line, is represented by a vertical red line 

• One click centers the selected element in the Gantt chart 

• A double-click edits the selected element 

• A green bar show the progress of a phase in percent (%) 

• A paper clip is displayed beside elements to which documents are 
linked 

• A click on the minus sign ( ) besides a grouping hides all elements 
belonging to it. The plus sign ( ) causes them to be displayed. See 
also the commands Expand all groups and Collapse all groups in 
the popup menu 

• A context menu is displayed on clicking with the right-hand mouse 
button in the Gantt chart. The commands New Phase, New 
Milestone, Edit..., Delete, Expand all groups, Collapse all groups, 
Fix/Unfix, customize view (Choose fields) 

• A context menu is displayed on clicking with the right-hand mouse 
button in the header area of the Gantt chart. It allows the 
customization of the view (Choose fields) and the hiding and 
displaying of specific columns 

• If you have no read permission, no planning elements will be 
displayed 

  The following symbols are displayed beside the planning elements:  

• A check mark shows that the element is completed 

• An alert shows that an element is already overdue but has not 
yet been completed 
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• A flag is used to highlight specific elements 

• A Pin shows that the element is fixed (i.e. has a fixed deadline) and 
cannot be moved on the timeline 

• The symbol resource shows that resources have been assigned to 
the element 

• The symbol resources have completed their work shows that all 
resources of the element have completed their tasks successfully 

• A paper clip shows elements to which documents are linked 

  The following short cut keys are available in the Gantt chart:  

• Ctrl + P: New Phase 

• Ctrl + M: New Milestone 

• Ctrl + A: Select all elements 

• Ctrl + Arrow to right: move selected elements to right (same as ) 

• Ctrl + Arrow to left: move selected elements to left (same as ) 

• Ctrl + Arrow upwards: move selected elements upwards (same as 

) 

• Ctrl + Arrow downwards: move selected element downwards (same 

as ) 
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PLANNING PAGE: DIALOG BOX NEW PHASE / EDIT PHASE 

Detailed information on the Planning Page: Described here is the method for creating a new phase or modifying an 
existing one. 

A phase is a planning step within a time period. It is possible to add resources and successors to a phase. Automatic 
notifications can be added to keep team members, partners and customers informed. Links to documentation, files and 
internet addresses can also be added to a phase. 

  

Concise instructions for creating a plan are available 

  

The dialog box New Phase / Edit Phase: Standard tab 

 

Element Description 

Name (*) A description for the phase, e.g. Development or Design  

Element is a milestone Indicates the type of element (Phase or Milestone). In this case the flag is not 
set 

Group (*) Group to which the milestone belongs. The Group can be a sort criterion or a 
project cost center  
An internal price per hour is on file for each group. The internal prices per hour 
and the available groups can be customized under InLoox Options 
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Parent Grouping to which the phase belongs 

Location Free text field, in this case, where the activity of the phase is to take place 

PSP code PSP code = Work Breakdown Structure code. Free text field for identifying 
phases and milestones in large projects 

Begin (*)  Date and time of the planned start of the phase. When adding a new phase 
today's date and the Starting Working Time for the corresponding day of the 
week are proposed automatically and can be changed 

End (*)  Date and time of the planned end of the phase. When adding a new phase 
tomorrow's date and the Finishing Working Time for the corresponding day 
of the week are proposed automatically and can be changed 

Duration Length of the phase. Specify the following: 

• Days / Hours / Minutes 

Use working time calendar Specifies whether the duration given is working time (as set down under 
Working Time Options).  
Sample: 

A phase beings on a Friday; the next working day is a Monday. The phase has 
a duration of one day. If Use working time calendar is activated, the phase 
ends on mondays, if not, on saturdays 

Element cannot be moved on 
the timeline 

Prevents the phase from being moved. If predecessors or successors are 
moved, the phase does not move but the available buffer time is used up 

Note (*) These fields are mandatory inputs when adding or modifying phases 

  

The dialog box New Phase / Edit Phase: Details tab 
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Element Description 

Description Multiple-line free text field for activities and instructions concerning the phase. 
Input here the required work results or internal remarks 

Progress Degree of completion of the phase in percent (number between 0 and 100). 
Click on done to set progress to 100% 

Flag Select a flag for the phase (none,  ,  ,  ). The phase will be color-
highlighted accordingly in the Gantt chart on the Planning Page  

  

The dialog box New Phase / Edit Phase: Linking tab 
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Element Description 

Successors (available)  Select a milestone or phase from this list and click on the button ">>". InLoox 
creates the chronological interdependency between the phase and the selected 
successor 

Successors (selected)  The list contains all successors of the phase currently being edited. To remove 
a successor click on the button "<<". InLoox deletes the chronological 
interdependency between the phase and the selected successor 

Note InLoox checks the interdependencies and notifies any need to move the start or 
end of an element 

  

The dialog box New Phase / Edit Phase: Resources tab 
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Element Description 

Add Opens the dialog box New Resource 

1. Click on the button "..." to select a contact. 
Select on or more contacts from the list and click on OK  

2. Select the type of Notification. The notification determines when 
and how a contact or resource is to be informed . Select one of: 
(none), Email, Task request, Appointment request, InLoox Task  

3. Change the work done of the resource (optional). The workload of 
the resource in percent in the specified time period is displayed. The 
work done determines the planned time and costs in the Overview 
Area (column 2: planned costs resources) on the Budget Page 

4. The state shows whether the resource concerned has completed 
his/her tasks for this phase 

Edit Changes the data of the selected resource 

Remove Removes the selected resource from the list 

Workload Opens the dialog box Resource Overview 

Additional Costs  Input an amount to include additional costs for your project plan. These include 
machine, material and other costs such as travel expenses. The work done 
determines the planned time and costs in the Overview Area (column 3: planned 
costs other) on the Budget Page 
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 Hint: More information on automatic notification can be found in the chapter on Message Types 

  

The dialog box New Phase / Edit Phase: Documents tab 

 

Element Description 

Add Opens the dialog box Add Document  
Select a document Type (file or internet link), enter a Path and click on OK 

Open Calls up the link or opens the file 

Remove Deletes the selected link from the list 

List of documents  Hint: 

• A double-click calls up the link or opens the file 

• It is possible to link files on your local computer or on a server with 
the InLoox project plan. If you are a member of a team, specify the 
server path for the link to which all project team members have 
access 

  

The dialog box New Phase / Edit Phase: Custom tab  
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Element Description 

Custom fields For inputting and displaying supplementary data such as billing information, 
technical abbreviations, work location, etc. New fields can be added using 
the dialog box Edit Custom Fields 
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PLANNING PAGE: DIALOG BOX NEW MILESTONE / EDIT MILESTONE 

Detailed information on the Planning Page: Described here is the method for creating a new milestone or modifying an 
existing one. 

A milestone is a time of completion. It is possible to add resources and successors to a milestone. Automatic 
notifications can be added to keep team members, partners and customers informed. Links to documentation, files and 
internet addresses can also be added to a milestone. 

  

Concise instructions for creating a plan are available 

  

The dialog box New Milestone / Edit Milestone: Standard tab 

 

Element Description 

Name (*) A description for the milestone, e.g. Conclusion or Release 

Element is a milestone Indicates the type of element (Phase or Milestone). In this case the flag is set 

Group (*) Group to which the milestone belongs. The Group can be a sort criterion or a 
project cost center 

Parent Grouping to which the milestone belongs 
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Location Free text field, in this case, where the activity of the milestone is to take place 

PSP code PSP code = Work Breakdown Structure code. Free text field for identifying 
phases and milestones in large projects 

Date / Time  Day and time when the milestone is to be achieved. When adding a new 
milestone today's date and the current are proposed and can be changed 

Element cannot be moved on 
the timeline 

Prevents the milestone from being moved. If predecessors or successors are 
moved, the milestone does not move but the available buffer time is used up 

Note (*) These fields are mandatory inputs when adding or modifying milestones 

  

The dialog box New Milestone / Edit Milestone: Details tab 

 

Element Description 

Description Multiple-line free text field for activities and instructions concerning the 
milestone. Input here the required work results or internal remarks 

Progress Click on done to set progress to 100% 

Flag Select a flag for the grouping (none,  ,  ,  ). The phase will be color-
highlighted accordingly in the Gantt chart on the Planning Page  
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The dialog box New Milestone / Edit Milestone: Linking tab 

 

Element Description 

Successors (available)  Select a milestone or phase from this list and click on the button ">>". InLoox 
creates the chronological interdependency between the milestone and the 
selected successor 

Successors (selected)  The list contains all successors of the milestone currently being edited. To 
remove a successor click on the button "<<". InLoox deletes the chronological 
interdependency between the milestone and the selected successor 

Note InLoox checks the interdependencies and notifies any need to move the start or 
end of an element 

  

The dialog box New Milestone / Edit Milestone: Resources tab 
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Element Description 

Add Opens the dialog box New Resource  

1. Click on the button "..." to select a contact. 
Select on or more contacts from the list and click on OK  

2. Select the type of Notification. The notification determines when 
and how a contact or resource is to be informed. Select one of: 
(none), Email, Task request, Appointment request, InLoox Task  

3. The State shows whether the resource concerned has already 
completed his/her tasks for this grouping 

Edit Changes the data of the selected resource 

Remove Removes the selected resource from the list 

Workload Opens the dialog box Resource Overview 

Additional costs  Input an amount to include additional costs for your project plan. These include 
machine, material and other costs such as travel expenses. The Amount 
determines the planned time and costs in the Overview Area (column 3: planned 
costs other) on the Budget Page 

 Hint: More information on automatic notification can be found in the chapter on Message Types 
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The dialog box New Milestone / Edit Milestone: Documents tab 

 

Element Description 

Add Opens the dialog box Add Document. 
Select a document Type (file or internet link), enter a Path and click on OK 

Open Calls up the link or opens the file 

Remove Deletes the selected link from the list 

List of documents  Hint: 

• A double-click calls up the link or opens the file 

• It is possible to link files on your local computer or on a server with 
the InLoox project plan. If you are a member of a team, specify the 
server path for the link to which all project team members have 
access 

  

The dialog box New Milestone / Edit Milestone: Custom tab 
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Element Description 

Custom fields For inputting and displaying supplementary data such as billing information, 
technical abbreviations, work location, etc. New fields can be added using 
the dialog box Edit Custom Fields 
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PLANNING PAGE: CREATE GROUPING 

Detailed information on the Planning Page: Described here is the method for creating groupings and structuring planning 
elements 

  

Concise instructions for creating a grouping 

1. Open a project or create a new one 

2. Create two phases one above the other, as shown: 
 

 

3. Flag the lower one and click on the button Group ( ) 
InLoox changes the upper phase to a grouping: 
 

 

  

Notes 

The phase which is to be changed to a grouping must not contain any links or dependencies  
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The time period for the grouping is automatically adjusted to take account of elements at lower levels 
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PLANNING PAGE: DIALOG BOX NEW GROUPING / EDIT GROUPING 

Detailed information on the Planning Page: Described here is the method for creating a new grouping and modifying an 
existing one. 

A grouping defines the structure of the project planning. There is the option of adding notifications to a grouping to 
inform team members, partners and customers. Links to documents, files and internet addresses can also be attached to 
a grouping. 

  

Concise instructions for creating a grouping are available 

  

The dialog box New Grouping / Edit Grouping: Standard tab 

 

Element Description 

Name (*) Description of the grouping, for example Conceptual design 

Grouping Existing grouping to which the current grouping belongs. InLoox supports 
hierarchies of any depth  

PSP code PSP code = Work Breakdown Structure code. Free text field for identifying 
phases and milestones in large projects. 

Note (*) This field is a mandatory input when creating or modifying groupings 
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The dialog box New Grouping / Edit Grouping: Details tab 

 

Element Description 

Description Multiple-line free text  field for activities and instructions concerning the 
grouping. Input here the required work results or internal remarks 

Progress Degree of completion of the grouping in percent (number between 0 and 100). 
InLoox calculates this automatically from the progress of all phases belonging to 
the grouping 

Flag Select a flag for the grouping (none, , , ). The phase will be color-
highlighted accordingly in the Gantt chart on the Planning Page  

  

The dialog box New Grouping / Edit Grouping: Resources tab 
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Element Description 

Add Opens the dialog box New Resource  

1. Click on the button "..." to select a contact. 
Select on or more contacts from the list and click on OK 

2. Select the type of Notification. The notification determines when 
and how a contact or resource is to be informed. Select one of: 
(none), Email, Task request, Appointment request, InLoox Task 

3. The State shows whether the resource concerned has already 
completed his/her tasks for this grouping 

Edit Changes the data of the selected resource 

Remove Removes the selected resource from the list 

 Hint: More information on automatic notification can be found in the chapter on Message Types 

  

The dialog box New Grouping / Edit Grouping: Documents tab 
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Element Description 

Add Opens the dialog box Add Document. 
Select a document Type (file or internet link), enter a Path and click on OK 

Open Calls up the link or opens the file 

Remove Deletes the selected link from the list 

List of documents  Hint: 

• A double-click calls up the link or opens the file 

• It is possible to link files on your local computer or on a server with 
the InLoox project plan. If you are a member of a team, specify the 
server path for the link to which all project team members have 
access 

  

The dialog box New Grouping / Edit Grouping: Custom tab 
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Element Description 

Custom fields For inputting and displaying supplementary data such as billing information, 
technical abbreviations, work location, etc. New fields can be added using 
the dialog box Edit Custom Fields 
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PLANNING PAGE: DIALOG BOX PRINT 

Detailed information on the Planning Page: Described here is the method for printing a Gantt chart with Milestones, 
Phases and Groupings. 

  

Concise instructions for printing the Gantt chart 

1. Open a project 

2. Click on the button Print in the Planning Area (Planning Page)  
The dialog box Print is displayed 

3. Select a printer and set the print parameters 

4. Click on Print 
The dialog box Page Setup is displayed: 
 

 

5. Select the orientation and page order under the Page tab 

6. Select the header and footer lines under the Header/Footer tab 

7. Select the print range, timeframe and scale (Fit to:) under the Sheet tab 

8. Click on OK 
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PLANNING PAGE: DIALOG BOX SAVE TEMPLATE 

Detailed information on the Planning Page: Described here is the method for saving the planning of a project to a new 
template 

  

A brief summary of saving a template 

1. Open a project 

2. Click on the button New >> Save template >> InLoox... in the Planning area on the Planning Page 
The dialog box Save Template is displayed: 
 

 

3. Enter a Name 

4. Click on OK 

  

Notes 

Templates of the following Other formats can also be saved: Microsoft Project (MPP), Microsoft Project 
Exchange (MPX). Use the menu item New >> Save template >> Other format... 

All Phases, milestones and groupings of the current project are saved. InLoox also saves all resources with their 
notification options 

To modify a template, load it to a dummy project. Carry out the required changes and save the template anew. 
Planning templates can be deleted or renamed under the InLoox Toolbar (menu Tools: Edit Planning Templates...) 
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PLANNING PAGE: DIALOG BOX LOAD TEMPLATE 

Detailed information on the Planning Page: Described here is the method for loading a planning template with 
milestones, phases and groupings to a project 

  

 A brief summary of loading a template 

1. Open a project or create a new one 

2. Click on the button New >> Load template >> InLoox... in the Planning area on the Planning Page 
The dialog box Load Template is displayed: 
 

 

3. Select a Template 

4. Select a Start date 

5. Specify whether the resource data of the template should be loaded 
More information on resource data can be found in the chapter on Dialog box Edit Phase 

6. Specify whether completion data should be removed from the template 
In this case no progress information from the planning elements and resources are loaded from the template 

7. Click on OK 

  

Notes 

The start date determines at what point in time the first phase or milestone from the selected template is to be set. 
All other elements are scheduled by InLoox based on this point in time 

It is possible to load more than one template to a given project. It is also possible to load more than copy of a 
template to a project (also known as template duplication) 

Templates of the following Other formats can also be loaded: Microsoft Project (MPP), Microsoft Project 
Exchange (MPX). Use the menu item New >> Load template >> Other format... 
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PLANNING PAGE: DIALOG BOX RESOURCE OVERVIEW 

Detailed information on the Planning Page: The Resource Overview shows the resource workloads in graphical form 

Resources are employees or objects used for work such as rooms, vehicles or machines. InLoox differentiates between 
internal resources (i.e. Exchange Server mailboxes) and external resources (i.e. email and fax contacts). InLoox uses the 
Free/Busy-Schedule of Microsoft Exchange Server for internal resources and integrates the information (busy, tentative 
and out of office) into the workload diagram. The diagram can be created for one project only or across many projects, 
according to the option selected 

  

A brief summary of creating a plan including resource allocation is available 

  

The dialog box Resource Overview 

 

Element Description 

Workload diagram • The view always filters the resources and workloads by the time 
period specified with Begin and End 

• Zoom by holding down the Ctrl key and scrolling with the mouse 
wheel 

• Duration and degree of the workload are shown by the bars in the 
area at upper right:  



Basics 

73 

• yellow bar (workload 1% - 100%) 

• red bar (workload 101% - 149%) 

• dark red bar (workload over 150%)  

• In the example shown the overloading of the resource "Bob Hoppkins" 
results from the occupation in two phases. If appointments are on 
record in the Outlook calendar of an Exchange resource, the resource 
counts as fully loaded (100%) in the given time period. To hide the 
calendar deactivate the option display Exchange calendar 

• Today's date is shown by a vertical red day line 

• shows that an overbooking of a resource has occurred in the 
given time period. The workload for the resource is more than 100% 
at some time. The alert symbol does not indicate the duration or 
degree of the overbooking 

• indicates an external resource. Information from the free/busy 
facility of the Exchange Server cannot be called up for external 
resources 

• A click on the plus sign ( ) beside a resource displays the workload 
details. These include the projects and phases to which the resource 
is assigned and, in the case of internal resources, also the Outlook 
calendar. The details of the resource can be hidden with the minus 
sign ( ). A click on a phase centers the workload overview on it 

• If the Resource overview is called up from within a project, phases 
from other projects are shown in grey 

• Placing the mouse over a bar causes details to be displayed: 

 
The percentage indicates the workload of the resource. The time 
period and duration show the length of the workload 

• A click on a resource displays a graphical overview of the workload 
data within the selected time period. These include the projects and 
phases to which the resource is assigned and, in the case of internal 
resources, also the Exchange calendar 

Legend Each workload is shown in the workload diagram as a colored area. InLoox 
marks these areas as follows: 

• indicates: resource is occupied  (in project phase or Outlook 
calendar) 

• indicates: resource overloaded (total workload over 100 %) 

• an empty field indicates: the resource is free during the 
corresponding time period or no occupation data are available 

Start / End  Specifies the time period for which the resource workload is to be determined 

Note: All resources which are not occupied during the specified time period 
are hidden. Use the button Add resource ( ) to always display resources with 
whom/which you often work, regardless of the dates specified 
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Zoom ( / ) Changes the view of the workload diagram. Possible values: 

• Years 

• Quarters 

• Months 

• Weeks 

• Days 

• Hours 

• Quarter-hours 

• Minutes 

Refresh ( ) Reloads the view. All information is refreshed 

Filter Specifies which resources are to be included in the overview. Possible values:  

• All projects (= no filter)  

• This project only (= filter is current project)  

• This phase only (= filter is current phase) 

Note: Use the button Add resource ( ) to always display resources with 
whom/which you often work, regardless of the dates specified 

Add resource( ) Opens a dialog box for resource selection. Use this button to always display 
resources with whom/which you often work, regardless of the filters specified 

Delete resource ( ) Removes the selected resource from the view. Use this button to always hide 
resources regardless of the filters specified. The is stored for each user and 
therefore does not affect the resource overview of other users  

Note: Click with the right-hand mouse button on the resource list at upper 
left. Select the menu command Display deleted resource(s) to reintroduce all 
resources previously deleted 

Options A click on the button Option opens a menu with the following commands:  

• Display Exchange calendar: Displays or hides the data from the 
Free/Busy-Schedule of an Exchange Server. When activated InLoox 
takes account of the calendar data when calculating the workload 

• Display descriptions: Displays the descriptions of the work packages 
at upper right 

• Include all projects in overview: If this option is active the resource 
overview also includes phases from other projects. This option is only 
available when the resource overview is called up from within a 
project 

Print Prints the resource overview. Clicking on this button causes the dialog box Print 
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to be displayed 

Close Closes the dialog box 

Context menu of the resource 
list  

The following menu commands are available: 

• Reload Overview ( ): Reloads the view. All information is refreshed 

• Add resource ( ), Delete resource ( ) 

• Expand all groups / Collapse all groups: Changes the resource view 
and hides or displays the workload details for all resources 

• Display Exchange calendar 

• Display descriptions 

Notes 
Information from the Free/Busy-Schedule feature of Microsoft Exchange Server 
cannot be called up: 

• at any time for external resources  

• in offline mode for internal resources 
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Activities Page 

ACTIVITY PAGE 

The Activity Page contains all activities performed, work carried out and events recorded for a project. You can link 
activities and documents to improve transparency 

  

Information on the ActivityPage: 

• Details of the page areas: Activities 

• Concise instructions are available: Record activity or document 

• Description of the dialog boxes: New Activity / Edit Activity 
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ACTIVITY PAGE: ACTIVITIES AREA 

Detailed information on the Activity Page: elements, features and descriptions 

The Activities area: 

Element Description 

New Creates a new entry in the list of activities. Permission is required. Clicking on 
the button causes the dialog box New Activity to be displayed 

Edit Changes the selected entry in the list of activities. Permission is required. 
Clicking on the button causes the dialog box Edit Activity to be displayed 

Delete Deletes the selected entry from the list of activities. Permission is required 

Report... Copies the contents of the list of activities into a report. The report templates 
can be customized. Permission is required. Details can be found under 
Customizing Report Templates 

Print... Starts the quick print feature of the list of activities  

List of activities • An entry contains the following data: Description, Flag, Start, End, 
Duration, Group, Phase, Performed by, Modified by, Link indicator 

• Each entry carries a flag (none, , , ) 

• A paper clip ( ) shows that one or more documents are link to the 
activity. A click on the paper clip and then on the button "..." opens a 
menu with the linked documents 

• The total duration of all entries is displayed 

• The list is sorted by date in descending sequence and can be 
grouped and sorted just like an Outlook list 

• A popup menu is displayed on clicking with the right-hand mouse 
button. The following commands are available: New..., Edit..., Delete, 
change the view (Choose fields) and Create reminder for the 
activity in the Outlook calendar 

• A padlock symbol displayed in the list shows that you have no read 
permission. In this case no activities will be displayed 
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ACTIVITY PAGE: DIALOG BOX NEW ACTIVITY / EDIT ACTIVITY 

Detailed information on the Activity Page: Described here is the method for creating a new activity or edit an existing one. 
An activity is a part of a project used by InLoox as documentation and for recording work done and time spent 

  

Concise instructions for Creating an activity are available 

  

The dialog box New Activity / Edit Activity: 

 

Element Description 

Entry of (*) Day and time on which the activity was created. When creating a new activity 
today's date and the current time of day are proposed and can be changed 

Duration (*) Duration of the activity. Enter the time required in the format hh:mm (hours and 
minutes each with two digits) 

Flag Select a flag for the activity (none, , , ) 

Description Multiple-line free text for documenting significant facts about the activity. Typical 
data are Location, names of persons involved, results of meeting or internal 
remarks 

Phase (*) Phase or milestone to which the activity belongs. Phases and milestones can be 
created on the Planning Page 

Group (*) Group to which the activity belongs. The group is a sort criterion or a project cost 
center 
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Performed by (*) Name of the person who has carried out the activity 

Last modified by Name of the person who created the activity or last edited it 

"Custom" page Used to input and display supplementary information such as Billing 
information, technical abbreviations, Document category etc. New fields 
can be added as described under Edit Custom Fields 

Notes (*) These fields are mandatory inputs when creating and editing activities  
Each group has an internal and an external price. The prices and the available 
groups can be customized under InLoox Options  
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Documents Page 

DOCUMENT PAGE  

The Document Page provides a straightforward project document management facility under Outlook. Windows files, 
folders, Outlook elements and Internet links can be filed separately for each project and called up at any time. InLoox 
employs links internally to save storage space and avoid duplicates and is able to access SharePoint portal server 
document libraries. Details can be found in the chapter on Document Management Technology 

  

Information on the Document Page: 

• Details of the page areas: Documents, files & links 

• Brief summaries are available: Saving files and documents, Attachment Management 

• Description of the dialog boxes: New Document / Edit Document, Select Document Folder 

  

 



Basics 

81 

DOCUMENT PAGE: TECHNOLOGY  

Detailed information on the Document Page: The InLoox document storage and management technology is based on 
intelligent links within Microsoft Outlook, Microsoft Windows and Microsoft SharePoint Server. The advantages of this 
method are: 

1. Virtually no additional storage space required, keeping InLoox projects lean 

2. File rights are inherited. If for example you add a file from a protected network folder or SharePoint store to 
the InLoox storage, the file can still only be read and updated by authorized users - at no additional cost 

3. Backup and existing version and document management applications can still be used 

  

Notes: 

• InLoox is able to arrange documents automatically if required. The base folder to be used by InLoox for this 
purpose can be defined under InLoox Options 

• Details of the Document types supported by InLoox  



Basics 

82 

DOCUMENT PAGE: DOCUMENT TYPES  

Detailed information on the Document Page: InLoox supports the following document  types: 

Document Types Examples 

Outlook elements • Emails (Inbox, Outbox, Sent, Archive)  

• Contacts 

• Tasks 

• Journal entries 

• Calendar entries 

• with or without file attachments 
 

Details can be found in the chapter on Attachment Management 

Files all Windows-readable files 

Links, 
Internet links 

• www.inloox.com 

• www.exchange-server.com/inbox/mail-inloox.htm 

• C:\link to Desktop.lnk 

• Z:\ (complete network drive) 

SharePoint elements • compatible with SharePoint Portal Server 2003 and SharePoint 
Server 2007  

• Sites that support document libraries 

• Folders and subfolders 

• File objects 
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DOCUMENT PAGE: DOCUMENT LIST AREA 

Detailed information on the Document Page: elements, features and descriptions. 

  

The Document Area: 

Element Description 

Open Opens the selected document or starts the relevant application, e.g. Adobe 
Acrobat  

Note: Permission is required. Details can be found in the chapter on 
Document Management Technology 

New Creates a new entry in the document list. Permission is required. Clicking on 
this button causes the dialog box New Document to be displayed 

Edit Changes the selected entry in the document list. Permission is required. 
Clicking on this button causes the dialog box Edit Document to be displayed 

Delete Removes the selected document from the list. Permission is required. The 
document itself can also be deleted. If you want to delete the document 
physically answer the security query: "Do you really wish to delete the 
selected document from the project folder? This action cannot be 
reversed" with Yes 

Report...  Copies the contents of the document list into a report. The report templates can 
be customized. Permission is required. Details can be found under Customizing 
Report Templates 

Folder...  Opens the document folder in Windows Explorer or the web browser (in the 
case of a SharePoint document library) 

Print... Starts the quick print feature of the document list 

Document List • An entry contains the following data: filename, size, type, state, note, 
created on, changed on, folder, path. If the element was added to the 
project using the button Add element, the following is also included: 
Outlook sender, Outlook topic, Outlook received on. If the project 
document folder is a SharePoint document library, the following is 
also included: SharePoint author, SharePoint operator, SharePoint 
document library, SharePoint site, SharePoint subfolder 

• The list can be sorted and grouped just like any Outlook list 

• Documents can be added to the list via Drag and Drop. Documents 
are copied to the same time to project folder automatically. If the keys 
Ctrl and Shift are held down during drag and drop, the documents 
are not copied to the project folder, but merely linked from their 
original location  

• The documents can be updated by using the toolbar button Update 
Document List. The documents are updated automatically every 
time a project is opened, provided that the corresponding option has 
been activated in the InLoox Options 

• A click with the right-hand mouse button causes a context menu to 
be displayed. The following commands are available: Open, New..., 
Edit..., Delete, Refresh file list, change the view (Choose Fields) 



Basics 

84 

and Properties of the file concerned 

• A padlock symbol shows that you have no read permission. In this 
case no documents will be displayed 

Folder... button Changes the document folder. The dialog box Select document folder is 
displayed. Please note that with a change of folder the existing documents 
remain where they were 

Delete button Restores the document folder. InLoox selects the document folder anew 
according to the document folder rule as soon as a new document is added to 
the project 

Document folder In new projects no document folder is defined. When documents are added for 
the first time, InLoox will create the document folder according to the 
document folder rule. This can be customized under InLoox Options 
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DOCUMENT PAGE: DIALOG BOX NEW DOCUMENT / EDIT DOCUMENT 

Detailed information on the Document Page: Described here is the method for adding a new document to the list or 
modifying an entry in the document list. A document is a part of a project and is, according to type, an Outlook element 
(e.g. an email), a File (e.g. PDF, Word, Excel or AutoCAD) or an Internet link. Details can be found in the chapter on 
Document Management Technology 

  

 

A brief summary of Storing Files and Documents is available 

  

The dialog box New Document / Edit Document: 

 

Element Description 

Type (*) Select the type of document:  

• File (Office, PDF, ZIP, AutoCAD etc.)  

• Internet link, e.g. www.inloox.com 

Path (*)  Specify here the location of the document. A click on the button "..." opens a 
dialog box for Browsing 

Copy to project folder: Specify here whether the document is to be copied into the project document 
folder. More information can be found in the chapter on Document List 
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Subfolder selection list Select a subfolder into which the document is to be copied 

State Change instructions, e.g. release or completed 

Note Multiple-line text field for notes and comments 

Link to Permits a document to be linked to an activity. The document is then displayed 
in the Activities area on the Activity page with a paper clip ( ) and can also be 
called up from there. A click on the button "..." opens a dialog box for selecting 
an activity 

Note (*) These fields are mandatory inputs when creating or modifying document 
list entries 
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DOCUMENT PAGE: DIALOG BOX SELECT DOCUMENT FOLDER 

Detailed information on the Document Page: Described here is the method for changing the document folder of a project. 
Please note that when changing then folder the existing documents remain where they are. 

  

The dialog box Select document folder: 

 

Element Description 

Document storage type Select a type of document storage:  

• File server or local computer (storage in file system) 

• SharePoint portal server (storage in a SharePoint document library) 

Storage location Specify, according to document storage type: 

• Path if a file server or local computer was selected as document 
storage type. A click on the button "..." opens a dialog box for a 
browsing 

• Site, library and folder (optional) if a SharePoint portal server was 
selected as document storage type. 
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Budget Page 

BUDGET PAGE 

The Budget Page provides an overview of available budgets of the project based on costs, calculations and invoices. New 
budget documents can be created in InLoox and exported to Microsoft Excel, Microsoft Word or as a PDF file. It is 
possible to monitor the state and manage individual assets directly from Outlook. 

  

Information on the Budget Page: 

• Details of the page areas budget list (at left), asset list  (at right), budget overview (at bottom)  

• Brief summaries are available on Creating a budget, Creating an invoice, Project controlling 

• Description of dialog boxes New Budget / Edit Budget, New Asset / Edit Asset  
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BUDGET PAGE: BUDGETS AREA 

Detailed information on the Budget Page: elements, features and descriptions. 

  

The Budgets Area within the Budget Page (at left): 

Element Description 

New Creates a new entry in the list of budgets (at left). Permission is required. 
Clicking on this button causes a menu of available budget types to be displayed 
(expenses, calculations, invoices). Select a budget type. The dialog box New 
Budget is displayed  
Note: The budget type governs the placing of the budget in the Budget 
Overview 

Edit Changes the selected entry in the list of budgets. Permission is required. 
Clicking on this button causes the dialog box  Edit Budget to be displayed 

Delete Deletes the selected entry from the list of budgets. Permission is required 

Report...  Copies the contents of the selected budget to a report. The report templates can 
be customized. Permission is required. Details can be found under Customizing 
report templates 

Print... Starts the quick print feature of the list of budgets, budget assets or the Budget 
Overview  

List of Budgets  • An entry contains the following data: Type (expenses, calculations, 
invoice), Sequence number, Date, State, Name, Amount, Created by, 
Created on, Changed by, Changed by 

• Each entry has a unique number 

• Each entry has a state, which is freely definable. More information 
can be found in the chapter on Edit budget states 

• The Total amount of all Assets included in the budget is displayed. In 
the case of budgets of type Calculations und Expenses, the 
proportion of assets sofar billed by Invoice is also displayed 

• The list is sorted by date in descending order and can be grouped or 
sorted in the same way as an Outlook list 

• The first entry in the list is generated automatically. This budget 
(titled "Activity Costs") contains all activities of the project as assets. It 
cannot be changed manually 

• A popup menu is displayed by clicking with the right-hand mouse 
button. Available commands are New, Edit... and Delete; Create 
invoice (for expenses and calculations only); State, to alter the state 
of the budget and Choose fields to customize the view 

• A padlock symbol displayed in the list indicates that you have no read 
permission. In this case no budgets can be viewed 
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BUDGET PAGE: DIALOG BOX NEW BUDGET / EDIT BUDGET 

Detailed information on the Budget Page: Described here is the method for creating a new budget document or editing an 
existing one. A budget is part pf a project and can refer to expenses, calculations or an invoice, depending on the Type. A 
budget has a state and usually contains assets 

  

Brief summaries of how to create a budget and create an invoice are available 

  

The dialog box New Budget / Edit Budget: 

 

Element Description 

Number A unique budget number, formed from the type and a sequence number. The 
number cannot afterwards be changed and is not re-issued after the budget is 
deleted 

Date (*) Day on which the budget was created. When creating a new budget, today's 
date is always proposed but can be overwritten 

State (*)  Select a state for the activity (open, accepted, rejected). Use open for 
example for offers not followed with an order or unpaid invoices 
If the parameter Standard, is selected, the current state will be applied as 
standard to all new projects from then on 

State is freely definable. More information can be found in the chapter on 
Editing Budget States 

Name Budget name. Any text can be used; the standard option, depending on type, is 
Costs/Calculations/Invoice and is proposed automatically but can be 
changed. Use a unique name to make it easier for you and your customer to 
assign a budget unambiguously outside of InLoox. 

Created by (*)  Name or person creating the budget 
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Copy asset  It is possible to copy assets from one existing budget document to another. This 
is particularly useful for the following:  

• Transfer an asset from a rejected calculation to a new one and 
subsequently edit or delete it 

• Bill assets from a budget of type Costs or Calculation with InLoox 
directly. Please refer to the Brief Summary of Billing 

Concise instruction for Adding Assets are available 

"Custom" Page Used to input and display supplementary information such as Billing 
information, technical abbreviations, Document category etc. New fields 
can be added as described under Edit Custom Fields 

Note (*) These fields are mandatory inputs when creating and editing budgets 
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BUDGET PAGE: ASSET LIST AREA  

Detailed information on the Budget Page: elements, features and descriptions. 

  

The Asset List Area within the Budget Page area (at right): 

Element / Action  Description 

Double-click 
on empty field or symbol   

Creates a new entry in the Asset list (at right). Permission is required.  A click 
on this button causes the dialog box New Asset to be displayed 

Double-click 
on an entry 

Changes the selected entry in the asset list. Permission is required.  A click on 
this button causes the dialog box Edit Asset to be displayed 

Key <DEL> or symbol   Deletes the selected asset from the list. Permission is required 

Symbol  Moves the selected asset towards the top of the list. Permission is required 

Symbol  Moves the selected asset towards the bottom of the list. Permission is required 

List of assets • An entry contains then following data: Sequence number, Description, 
Group, Amount, Quantity, Unit, Unit price, Unit selling price (optional 
for budget types Calculations and Expenses), Billed (optional for 
budget types Calculations and Expenses), Line item number, 
Created by, Created on, Changed by, Changed on, Carried out on 
(with activity costs this is the start date of the activity)  

• Each entry has a unique number 

• Entries in the list  are sorted in descending order of creation and can 

be custom sorted manually (using the buttons and ) and 
grouped the same way as an Outlook list 

• The Total amount of all entries is displayed if the list is grouped by a 
specific column 

• A popup menu is displayed by clicking with the right-hand mouse 
button. Available commands are New, Edit... and Delete; Asset(s) 
billed and Choose fields to customize the view 
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BUDGET PAGE: DIALOG BOX NEW ASSET / EDIT ASSET 

Detailed information on the Budget Page: Described here is the method for creating an asset or editing an existing one. 
Assets are included in a budget. Assets included in a budget document of type Costs or Calculations can be either billed 
or not. 

  

A brief summary on the creation of a budget including assets is available 

  

The dialog box New Asset / Edit Asset: 

 

Element Description  

Group (*)  Select from the list a group to which the asset belongs. The group defines the 
structuring of assets within the system 

Note: The groups can be customized under InLoox Options 

Asset Select the required asset from the list. If such an asset is not on file, it can be 
input manually  

Note: The dialog box Edit Budget can be used to create new asset 
templates or customize existing ones 

Name Short asset name. Can be changed 
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Description (*)  Multiple-line description of the asset. Can be changed 

Provision date Date of carrying out or delivery. With activity costs this is set automatically to the 
start date of the activity 

billed Only for asses from budgets of type Costs or Calculations. This is set 
automatically once the asset (or the entire document) has been billed  
A click on the parameter sets this state manually 

Quantity (*) Input the quantity of the selected unit, e.g. 95 or 2.34. A credit can be recorded 
by inputting a negative figure 

Unit price, 
Unit (*) 

The selected Unit is linked to the unit price. Select a unit if there is more than 
one or change the unit price manually  
All prices are excluding VAT because in InLoox only records net amounts. The 
VAT can be expressed separately in the report templates 

Total (*)  Asset amount ("Price per unit multiplied by quantity") 

"Custom" Page Used to input and display supplementary information such as Billing 
information, technical abbreviations, Document category etc. New fields 
can be added as described under Edit Custom Fields 

Note (*) These fields are mandatory inputs when creating and editing assets 
Each group has an internal and an external price. The prices and the available 
groups can be customized under InLoox Options  
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BUDGET PAGE: OVERVIEW AREA 

Detailed information on the Budget Page: elements, features and descriptions. 

  

The Overview Area gives an ongoing comparison between the amounts in Manage, Planning, and Budget. A list of all 
amounts, cumulated by group, is displayed: 

Element Description 

1st Column 
Group 

One line is generated for each group 

Notes: 

• Amounts on columns 2-10 are cumulated by group 

• The line Amount shows the totals from each column 

• An internal price per hour is recorded for each Group. The internal 
prices per hour and the available groups can be customized under 
InLoox Options 

2nd Column 
Planned costs 
(Resources) 

Costs of all phases from the Planning Page, for which resources were recorded 
with time spent.  
Method: For each phase the time spent of all Resources is multiplied by the 
Group Purchasing Costs. All phase costs are cumulated by group 

3rd Column 
Planned costs 
(other) 

Costs of all phases from the Planning Page, for which Additional Costs were 
recorded. Examples of these are machine or material costs or travel expenses.  
Method: Additional Costs for all phases are cumulated by group 

4th Column 
Planned revenues 

All Calculations from the Budget Page  
Method: Budget documents of type Calculations are totaled and/or cumulated 
by group 

5th Column 
Planned profit 

Variance between planned revenues and planned costs (Planned costs - 
resources) and Planned costs - other)  
Method: 5th Column minus (2nd Column plus 3rd Column) 

6th Column 
Activity costs 

Activity Costs from the Budget Page  
Method: Activity Costs are calculated automatically: Activities from the 
Manage Page multiplied by the Group Purchasing Costs cumulated by group 

7th Column 
Other costs 

Costs from the Budget Page (other than activity costs) 

Method: Budget documents of type Costs are totaled and/or cumulated by 
group 

8th Column 
Revenues 

Invoices from the Budget Page  
Method: Budget documents of type Invoice are totaled and/or cumulated by 
group 

9th Column Difference between revenues and actual costs (Activity costs and Other 
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Profit costs)  
Method: 8th Column minus (6th Column plus 7th Column) 

10th Column 
Profit difference 

Difference between profit and planned profit  
Method: 9th Column minus 5th Column 

State A negative amount in the 10th Column (Debit/Credit) is marked with a red dot 
( ). In this the actual profit is lower than the planned profit. Depending on the 
project objective, this can mean one of the following:  

• Costs exceed revenues 

• Revenues are lower than anticipated 

• Costs are higher than anticipated 

Hint It is possible to display the total costs, revenues, profit and cost overruns in the 
InLoox Project Overview. More information can be found in the chapter on 
Customizing Personalized Views 
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MENU AND TOOLBAR IN THE INLOOX PROJECT 

The InLoox Project contains menus and toolbars. A description of all commands and buttons can be found here. 

  

The Menus: 

Menu Menu item Description 

File New Creates a new project 

  Save Saves the current project 

  Import Reads in data in the following formats: Microsoft Project 
(MPP), Microsoft Project Exchange (MPX). The data is 
displayed on the Project Planning Page  

  Export Writes out data from the Project Planning Page in the 
following formats: Microsoft Project Exchange (MPX), 
Extensible Markup (XML) 

  Close Closes the project window 

Tools Reports Report generator. More information can be found in the 
chapter on Creating and Editing Reports 

  Saved reports List of saved reports. More information can be found in the 
chapter on Saving Reports 

  Resource overview Calls up the Resource Overview 

  Update Document List Updates the document list from the Project Document Page  

  Categories Calls up the dialog box Categories from the Project 
>Manage Page 

? InLoox Help Calls up InLoox online documentation 

  InLoox Online Opens the InLoox website 

  Ideas and suggestions Opens the feedback form 

  Report an error Opens the Support Center 

  About InLoox Opens a window with your InLoox version number 

  

The toolbar: 

Button Description 

Save and close Saves the data from the current project and closes the 
project window 
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Resources Overview Calls up the Resource Overview 

Reports Report generator. More information can be found in the 
chapter on Creating and Editing Reports 

Update Document List Updates the document list from the Project Documents 
Page 
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InLoox Task Overview 
INLOOX TASK OVERVIEW 

Open an Outlook calendar or task list. The InLoox Task Overview can be seen on the right. 

Each entry in this overview shows one task in one project. A typical view: 

  

 

  

The format is as follows: 

• tasks displayed in red are overdue 

• tasks displayed  in black are on time or completed (according to the selected view) 

  

The following views are available: 

Name Description 

My open tasks Personal tasks with state "open" (i.e. "to be carried out") 

My completed and inactive tasks Personal tasks with state "completed" 

Project manager's view (open tasks) Tasks of all members of projects of which you are manager (*) 
with state "open" (i.e. to be carried out") 

Project manager's view (completed and inactive 
tasks) 

Tasks of all members of projects of which you are manager (*) 
with state "completed" 

(*) If you have read permission for all projects (in InLoox Personal Edition this is always the case, in InLoox Workgroup 
or Enterprise Edition you will need a user-based permissions), all tasks are displayed in the project manager's view for 
all tasks. 

  

All open tasks assigned to you are displayed. These tasks are work packages containing planning elements. It is 
possible to create new tasks in the Planning Page, in which, for example, you can assign a resource to a phase and 
inform them via the dialog box InLoox Task. 
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InLoox notifies new tasks to the user concerned and displays all tasks in their personal InLoox task overview. When you 
receive a new task, the dialog box InLoox Task is displayed: 

 

 

1. Select an entry from the list. The planning data are shown:  

• Project name and number 

• Time frame or time 

• Your personal work amount (in hrs) 

2. Click on one of the following:  

• Open details  
Additional information on the task is displayed 

• Open project 
The project concerned is opened 

• Close all 
Closes the dialog box 

3. The task appears immediately in the InLoox task overview. You will be informed automatically of any 
changes. 

  

  

The principal features of the task overview are: 

•  A double click on an entry opens the relevant work package. 
It is possible here to open the project or view the following details:  

• Project name and number 

• Description, Start and End of the work package 

• Detailed description 

• Work amount in hours 
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• State (completed or open) 

• Click with the right-hand mouse button on an entry to open a popup menu with the following commands:  

• Display details and open corresponding project (for description see previous section) 

• Flag task as completed: Concludes the work package and moves it to the view "My completed and 
inactive tasks" or  "Project manager's view (completed and inactive tasks)" 

• Record activity provides convenient access to the facility for time recording for the task 

• Update refreshes the view 

• Display filter permits specific tasks to be included or hidden 

• Select fields shows a list of available columns 
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DISPLAYING AND PROCESSING WORK PACKAGES 

A brief summary of how to transfer work packages to your calendar or task folder: 

  

If you are planned into an InLoox project, the project planner can pass information to you in various ways: 

• by automatic Outlook task or meeting request 

• by automatic email 

• by InLoox task 

  

Option 1: by Outlook task or meeting request (*) 

1. You receive an email, for example with the title "New element ( Strategic Project #2007-0002 ) : Max Smith 
(msm@test.com)". Sender is the project planner. 

2. You see the following planning data:  

• Project name and number 

• Time frame or date 

• Your own effort 

• Location 

• involved resources 

3. You have the following options:  

• agree, whereupon Outlook automatically creates an entry in your task list or calendar. 

• decline 

Outlook reports the response to the project planner. In the case of a task request the project planner is kept 
constantly formed about the progress of and changes to all tasks assigned to you. 

  

Option 2: by email (*) 

1. You receive an email, for example with the title "New element ( Strategic Project #2007-0002 ) : Max Smith 
(msm@test.com)". Sender is the project planner. 

2. You see the planning data:  

• Project name and number 

• Time frame or date 

• Your own effort 

• Location 

• involved resources 

3. You have the following options: 

• accept and create an entry in your calendar or task list manually. 
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• decline and reply in free form via your email software. 

  

Option 3: by InLoox task (*) 

1. Outlook displays the dialog box InLoox task: 

 

2. Click on an entry in the list. You see the planning data:  

• Project name and number 

• Time frame or date 

• Your own effort (in hours) 

3. Click on one of the following:  

• Open details 
Further information on the task is displayed 

• Open project  
The project is opened 

• Close all 
Closes the dialog box 

4. You see the open InLoox tasks in the InLoox Task Overview. You are informed automatically of any 
changes. 

  

(*) The type of communication is selected by the project planner. Users without InLoox can only be informed via task 
request, meeting request or email. The project planner can also decide to withhold information from a resource. 

  

Continue to Storing files and documents 
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Options 
INLOOX OPTIONS 
This chapter describes the changes to the basic parameters and the set-up of permissions in the InLoox software. To find 
out more about the customizing options of InLoox, please refer to the chapter on Detailed Information: Configuration 

  

The administrator opens the InLoox Options as follows: 

1. Click on the menu command Tools in the InLoox Toolbar 

2. Click on Options 

  

The InLoox Options contain seven tab pages: 

1. Number defines the structure of the project number 

2. States contains the available status values for all InLoox projects 

3. Groups defines the groups for planning elements, activities and budgets 

4. Permissions supports the restriction of user access to the database 

5. Working Times permits the setting up of standard working times for the Planning Page 

6. Documents defines the standard paths and subfolders for the Document Page 

7. Document Folders defines the folder structure of the document folders 
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Number Page 
INLOOX OPTIONS: NUMBER 

The options page Number defines the format of the project number. There is a wide variety of customizing options. The 
format of the project number takes effect on the Manage Page. 

Please note the possible effects when changing the project number format. These are described in this chapter. 

  

 

  

Detailed description of Number page: 

  

Project Number: 

• It is possible to use a prefix (leading character string), a sequence number and a suffix (trailing character 
string). 

• At least a prefix and a sequence number are required. 

• The prefix and suffix can be combined with the sequence number 

  

Prefix and suffix are defined as follows: 
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Mode Data type and significance 

Any text Any character string of any length, which can be changed  

Fix text Any character string of any length, which cannot be changed, e.g. the 
word Project  

Regular expression Input a format and an example. Please note the Format Rules When a 
project is created InLoox checks whether the project number used is of 
the format defined here. If not, a message is displayed asking the user to 
correct the project number. 

  

Examples of common formats: 

Example Configuration 

Prefix:  
Rule: ^Project \d{4}-$ 

Standard value: Project 2008- or Project 2009- 

Sequence number: Number of digits: 3 

Four-digit year combined with 
sequence number 
(e.g. "Project 2008-008")  
components: 

• "Project 2008-" (fixed prefix 
with year) 

• "Sequence number" 
(maximum 3 digits with 
leading zeroes) 

Suffix: none 

Prefix: none 

Sequence number: Number of digits: 5 

Sequence number with country code 
components: 

• "Sequence number" 
(maximum 5 digits with 
leading zeroes) 

• Country code (-DE, -AT, -FR, 
...) 

Suffix:  
Rule: ^-\w{2}$ 

Standard value: -DE 

Prefix: none 

Sequence number: Number of digits : 6 

Simple sequence number 

• "Sequence number" 
(maximum 6 digits with 
leading zeroes) Suffix: none 

Prefix: any text 

Sequence number: none 

Free format 

Suffix: none 

  

Effects of changing the number format: 
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• New projects are created automatically with numbers in the new format. 

• Existing projects retain their old numbers. 

• A sequence number, once used, cannot be used again. 
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NUMBER FORMAT RULES 

The options page Number defines the format rules for project numbers. Please note the possible effects when changing 
settings. These are described in the chapter on InLoox Options: Number Page. 

  

The following options are available: 

Character Data type and significance 

. Any single character 

\d{COUNT} Any numeric (0-9) with COUNT digits. COUNT stands for any positive 
integer, e.g. 5 

\w{COUNT} Any character string (A-Z, a-z, 0-9, underscore "_") with ANZAHL 
characters. ANZAHL stands for any positive integer, e.g. 5 

\D{COUNT} Any character string (A-Z, a-z, special characters, umlauts, spaces) with 
COUNT characters. Numerics not allowed 

\W Single special character. (A-Z, a-z) or numeric (0-9) not allowed 

STRING STRING stands for a fixed character string specified by the user, e.g. 
Project, Department_A, PID 

^STRING$ Expressions placed between ^ and $ must not be empty and must be of 
the defined length. The only permissible input in this example is STRING. 
Without ^ and $, STRING1234 or an empty text is also a valid input. 

  

Sample formats: 

Format Examples 

.._\d{4} right: Ab_1234, ?!_0000  
wrong: 12-1234, ab-abcd 

SAMPLE... right: SAMPLE1234, SAMPLEABCD, SAMPLEab12, SAMPLE  
wrong: SAPMLE1234, 1234SAMPLE 

\w{2}-\d{2} right: ab-12, AB-12, 01-12, a1-99  
wrong: 12-ab, öö-12, ??-12 

\W{2}SEPERATOR\D{2} right: !!SEPERATOR12, 12SEPERATOR12, abSEPERATOR!?  
wrong: !!TRENNab, 12SEPERATORab, abSEPERATOR12 
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INLOOX OPTIONS: STATES 
The options page States defines the different stages of development and completion a project can be in. A wide range of 
statuses can be defined coupled with a percentage to show the state of progress of the project. The project status is 
available for use on the Manage Page of every InLoox project. 

Please note the possible effects when changing and deleting project statuses. These are described in this chapter. 

  

 

  

Detailed description of the Status page: 

1. New: create a new project status  

• Input a Name and degree of Progress (in %) 

• The progress is a percentage figure, i.e. an integer between 0 and 100 

2. Edit: changes the selected status 

3. Delete: removes the selected status 

4. Up: moves the selected status towards the top of the list 

5. Down: moves the selected status towards the bottom of the list 

6. Project States list: contains the name and progress of each state. The sequence of this list corresponds to 
the sequence displayed in the projects. Double click on an entry which is to be changed. 

  



Options 

111 

Effects of changing or deleting Project States: 

• Adding a new state has no effect on existing projects. 

• Changing the sequence of states has no effect on existing projects. 

• Changes to the state (e.g. Name, Progress in %) take immediate effect in all relevant projects. 

• Deleting a state causes all projects using it to remain without state until the user makes a manual correction. 
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INLOOX OPTIONS: GROUPS 
The options page Groups defines the groups which can be used in each InLoox project on the Planning, Activities and 
Budget pages. The groups help structure the data more meaningfully allow ongoing automatic comparison between 
activities, planning and budgets. They can also carry a currency code. 

Please note the possible effects when changing settings. These are described in this chapter. 

Purchase and selling prices are used on the Budget Page, for example to prepare activities recorded on the Activity 
Page for billing. 

  

 

  

Detailed description of the Groups page: 

1. New: creates a new group 

2.   

• Specify a Name and a Purchase and Selling price. 

• The currency can be defined in the Currency area 

3. Edit: changes the selected group 

4. Delete: removes the selected group 

5. Up: moves the selected group towards the top of the list 
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6. Down: moves the selected group towards the bottom of the list 

7. Group List: the sequence of this list corresponds to the sequence displayed in the projects. Double click on 
an entry which is to be changed 

8. Currency: systemwide definition of the currency Symbol, e.g. €, $, CHF or £ 

9. Digits: systemwide definition of the number of decimal places (for non-integral amounts)  

  

Effects of changing or deleting Groups: 

• Adding and renaming groups has no effect on existing projects 

• When group prices are changed the old amounts at first remain unchanged in all projects. 
The amounts are updates when the relevant planning element, activity or budget asset is next processed. 

• Deletion of groups has a permanent effect, namely that  

• the group and associated amounts are no longer displayed in the budget overview. 

• for all planning elements, activities and budget assets using the deleted groups must be assigned a 
new group when next edited . 

  

Effect of changing a currency symbol: 

• The currency is not automatically redenominated. If, for example, € is replaced by $, InLoox does not 
recalculate the amounts, but simply changes the currency symbol as if the rate of exchange were 1:1. 
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Permissions Page 
INLOOX OPTIONS: PERMISSIONS 

The options page Permissions is used to restrict the views and features available to specific users under InLoox 
Workgroup and Enterprise Edition. 

Note: InLoox is delivered without permissions. Thus every user can see and change all permissions. This is a security 
risk. 

  

 

  

Permissions are either role-based or user-based: 

Permission Mode Remarks 

User-based permissions • Permissions based on Windows user accounts. Active 
directory accounts (in domain mode) and local Windows 
user accounts (in workgroup mode) are supported. 

• Apply across all projects and to the entire database 

• Note: InLoox does not support Windows groups at this time 

Role-based permissions • Users aquire permissions through membership of a role in the 
project. Project members are all persons who are listed in the 
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project as "In Charge" 

• Possible roles: Project manager, Team member, Customer, 
Partner, Other 

• Microsoft Exchange Server is required 

• Note: Persons are identified by their Windows Security 
Identifier, or SID, and their X400 address, or Exchange 
address. Persons with the same X400 address have the 
same role-based permissions under InLoox. If this is not so 
desired, please deactivate the role-based permissions entirely 
by removing all permissions for all roles. 

Important note: InLoox combines role-based and user-based permissions. The 
permission records of both modes are added. The example below 
illustrates a common configuration  

• The role "team" may "read projects " and "read budgets". 
All other roles are ignored for the sake of clarity.  

• The user account "John Smith" is authorized to "edit projects 
" and "edit budgets" (A List of InLoox Permissions can be 
found here.)  

• "John Smith" is part of the "team" in the project "Product 
Development" 

• There are three other projects in which "John Smith " is not 
involved and therefore does not have the role "team"  

 
In result, these permissions apply to John Smith: 

• He may read and edit the project "Product Development". He 
may also read and edit budgets in this project. John Smith has 
these permissions in all projects in which he is in the team 
role. 

• "John Smith" cannot see any projects in which he is not a team 
member. He does not have the permission to "read projects", 
which is a prerequisite for all other permissions. Thus John 
Smith has no permissions for any other projects. 

The following applies to all other team members involved in the project 
"Product Development": 

• They may read the project "Product Development" and read 
but not edit budgets. They do not have the permission record of 
the account "John Smith" 

• Persons who are team members in other projects than 
"Product Development" can see, in contrast to John Smith, a 
number of projects but may not edit any of them. 

InLoox permissions are extremely flexible and allow a wide variety of 
scenarios to be covered without high administration effort. If you have 
questions on the assignment of permissions, we will be pleased to help. 

  

Detailed description of the user-based Permissions area: 
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1. New: creates a new user permission. 
The dialog box Permissions is displayed.  

• Click on the button "..." 

• Select an account in the dialog box Select user. Either Active Directory Accounts or Local 
Windows Accounts can be selected. 

• To select an Active Directory Account click on the button Paths. In the dialog box Path, select 
in the node Entire Network 

• Input the required user name into the field: Input the object name to be used 

• Click on Check name. A user name that has been recognized by Windows is shown underlined 

• Click on Advanced... if you need to search for a user name. 

• Click on OK 

• Select the Permissions for the user. A List of InLoox Permissions can be found here. 

• Click on OK 

2. Edit: changes the selected user permission 

3. Delete: removes the selected user permission 

  

Detailed description of the Role-based Permissions area: 

Note: Role-based permissions are only active when at least one user-based administrator permission exists. 

1. Edit: changes the selected role-based permission 
The dialog box Permissions is displayed.  

• Select the Permissions for the role. A List of InLoox Permissions can be found here. 

• Click on OK 
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LIST OF INLOOX PERMISSIONS 

The following permissions apply under InLoox Workgroup and Enterprise Edition. Users or roles can be assigned 
permission for the actions listed. 

  

Description Permission Restriction or Prerequisite 

Create projects User has the right to create new projects Only available with user-based 
permissions 

Read projects • Project visible in the InLoox Project Overview 

• Project can be opened 

• Project can be exported if the "right to use 
existing reports" is awarded 

none 

 Read "Plan" Right to read all planning elements of a project (see 
Planning Page) 

Prerequisite: Read projects 

 Read "Activities"  Right to read all activities of a project (see Activity 
Page) 

Prerequisite: Read projects 

 Read "Document" Right to open and read all documents of a project (see 
Document Page) 

Prerequisite: Read projects 

 Read "Budget" Right to read all budgets, budget assets and the budget 
overview of a project (see Budget 
 Page) 

Prerequisite: Read projects 

Edit projects Project can be changed. This right is a prerequisite for 
all actions which allow to modify data. 

Prerequisite: Read projects 

 Edit "Manage" Right to change project master data on Manage Page 
(except project contacts) 

Prerequisite: Edit projects 

 Edit project 
contacts 

Project contacts can be added, changed or deleted. It is 
thus possible for the user to control the roles of persons 
in a project (see Manage Page In charge Area) 

Prerequisites:  

• Edit projects 

• Edit "Manage"  

 Lock projects  Project can be locked for other users (see "Mode" 
feature on the Manage Page). User without permission 
may not edit locked projects and cannot remove the 
lock 

Prerequisites:  

• Edit projects 

• Edit "Manage"  

 Edit "Planning" Allows adding, changing and deletion of all planning 
elements of a project (see Planning Page) 

Prerequisite: Edit projects 
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 Edit "Activities"  Allows adding, changing and deletion of all activities of 
a project (see Activity Page) 

Prerequisite: Edit projects 

 Edit "Document"  Allows adding, changing and deletion of all documents 
in the document list of a project (see Document Page) 

Prerequisite: Edit projects 

 Edit "Budget"  Allows adding, changing and deletion of all budgets and 
budget assets of a project (see Budget Page) 

Prerequisite: Edit projects 

Delete projects Project can be deleted none 

Use existing reports All reports can be used. The InLoox report generator 
filters from the report all data that the user has no right 
to see (e.g. if no right to read budgets has been 
granted, no budget data will be included in the exported 
reports.) 

none 

Create and edit 
report templates 

Allows the creation, changing and deletion of report 
templates (see menu command Edit Report Templates) 

only available for user-based 
permissions 

Administrator Controls access to master data maintenance and 
administrator functions. These include the following 
menu commands in the InLoox Toolbar:  

• Edit planning templates (right to rename 
and delete InLoox planning templates) 

• Edit budget assets (right to create, change 
and delete InLoox budget assets) 

• Edit budget state (right to create, change 
and delete InLoox budget states) 

• Edit notifications (right to change 
Notification templates) 

• Edit categories (right to create, change and 
delete InLoox Categories) 

• Edit custom fields (right to create, change 
and delete Custom fields) 

• Remove project locks (right to remove Data 
record locks) 

• Project-recycling bin (right to restore or 
permanently remove deleted projects) 

• Import data from Version 4.x (right to 
migrate data from earlier InLoox versions) 

• Licenses (right to add and delete InLoox 
License codes) 

• Options (right to change the InLoox Options. 
Incorporates the right to change permissions) 

only available for user-based 
permissions 
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INLOOX OPTIONS: WORKING TIMES 
The options page Working Times permits the setting of a system wide work calendar. This is the basis for the billing of 
work hours and costs on the Planning Page. It is possible to define one calendar for all resources. Overtime is not taken 
into account in the planning, which is based on the company's standard working day. This prevents the recording and 
controlling of resources from becoming too complex. Overtime can be recorded at any time on the Manage Page. 

  

 

  

Detailed description of the Working Times area: 

1. Edit: changes the working times on the selected week day.  
The dialog box Edit Working Times is displayed. 

2.   

• Specify whether the day concerned is a working day. Non-working days are not included in the 
calculation.  
This determines which days are to be taken into account in the cost calculation on the Planning 
page. 

• Input Work starts and Work ends for the day 

• Click on OK 

  

Detailed description of the Working Day area: 
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1. The working day contains "X" hours: 
Defines the number of hours in a working day. This parameter helps the user in inputting time periods for 
Phases and workloads for resources 

  

Note on billing of working time and costs: 

• If working times are changed or working days are activated or deactivated, the internal costs of a project are 
only then changed when the relevant element is opened and the project saved.  

• The billing of internal costs on the Planning Page only takes account of the number of work hours of posted 
resources in the planning phases. 

• The values specified here define the standard start and end for new planning elements. The use of working 
times facilitates the input of phases and milestones. 
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INLOOX OPTIONS: DOCUMENTS 
The options page Documents defines the rules for the InLoox file archiving feature. There are several customizing 
options. The format of the project number affects the Document Page. It is possible to update the contents of the project 
folder automatically.  

Please note the possible effects when changing settings. These are described in this chapter. 

  

 

  

Detailed description of the options page Documents: 

1. Automatically update document list on project startup: Documents are read anew when the project is 
loaded. This option slows down the opening of a project but ensures automatically that the Documents 
Page always show up-to-date information. 

2. File Server 

1. Base path: UNC resource, e.g. \\server1\projects or C:\Projects\ 

2. Rule: Structure for individual projects. The following criteria can be combined as desired: 

• <PROJECT_NAME> (Project name on the Manage Page, "Project Area") 

• <PROJECT_NUMBER> (Project number on the Manage Page, "Project Area") 

• <COMPANY_NAME> (Customer name on the Manage Page, "Project Area") 
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The Standard parameter <COMPANY_NAME>\<PROJECT_NUMBER> 
<PROJECT_NAME> points automatically to the following folder structure: 
<BASEPATH>\Customer1\2008-001 Project 1 
<BASEPATH>\Customer1\2008-002 Project 2 
<BASEPATH>\Customer2\2008-003 Project 1 

3. SharePoint Server site  

1. Base path: Path to a SharePoint server site, e.g. http://companyweb/ or http://www.my-
sharepoint.com/site_int/ 

2. Document library rule: Structure for creating SharePoint document libraries. A fixed text 
may be input (which causes all projects to use the same library) or a rule (see file server rule, 
above). Creating a separate SharePoint document library for each project has the 
advantage that the data access permissions can also be defined separately. 

3. Subfolder rule (optional): Path name within a SharePoint document library. If no text is 
input the master folder of the document library is assumed. If only one SharePoint document 
library is to be used, it is useful to apply a rule (see File Server, above), since other wise the 
documents from all projects would be copied to the same folder. 

  

Effects of changing Storage type, Basepath or Rules: 

• If no projects are yet on file, changing these parameters has no effect. 

• New Projects or projects for which no document folders exist are managed automatically according to the 
changed parameters. 

• Existing projects are managed with the existing document folder until the user changes this manually. 
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INLOOX OPTIONS: DOCUMENT FOLDERS 
The options page Document Folders specifies subfolders created automatically when the InLoox file archiving facility is 
used. InLoox allows subfolders to be created automatically in each document folder of a project. These subfolders are 
created new as soon as a user selects a new project folder on the Document Page. As many subfolders as required may 
be created automatically in a hierarchy structure of any depth.  

Please note the possible effects when changing settings. These are described in this chapter. 

  

 

  

Detailed description of the Folder Structure area: 

1. New: creates a new subfolder  

• Input for example Basics\Plans. InLoox creates in each project document folder a folder named 
Basics, which contains a subfolder named Plans. 

• Click on OK 

2. Edit: changes the selected subfolder 

3. Delete: removes the selected subfolder 

  

Effects of changing Base path or Rules: 



Options 

124 

• Existing subfolders are not deleted or renamed when the subfolder configuration is changed. 

• In existing projects, new structures only become effective when new documents are added. 
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Detailed information 
Installation 
DETAILED INFORMATION: INSTALLATION 

Please note that Outlook must already be installed and fully operational before InLoox is installed. The installation usually 
takes no longer than five minutes per client. The server installation (only required for InLoox Workgroup and Enterprise 
Edition) can be performed out from the client. 

  

Step-by-step instructions for the installation can be found in the Download area of the Support Center: 

• for InLoox Personal 

• for InLoox Workgroup 

• for InLoox Enterprise 

  

The download area contains an MSI package for deployment via software distribution to multiple clients. 

In case of problems, please contact our Installation Support. 
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DETAILED INFORMATION: INSTALLATION: SUPPORT 

Outlook is a complex software product. Difficulties in connection with the installation of InLoox are not common but are too 
complex and too new to have been described in the Help file. Please note that we can unfortunately only deal with 
problems arising from the installation of InLoox and not with general Outlook problems. Please also note that we 
are in the CET time zone (GMT+1). 

  

IQ medialab GmbH 

Internet: www.inloox.com/support/ 

Email: support@inloox.com 

Phone: +49 (89) 323 919 22 
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Configuration 
DETAILED INFORMATION: CONFIGURATION 

This chapter describes the customizing and configuration options of InLoox. 

  

Data Storage and Management: 

• InLoox is a database-oriented software product integrated with Outlook and uses SQL (Standard Query 
Language) for its data management. More information on this topic can be found in the chapter on Data 
Storage. 

• The chapter on deleting Project Locks describes how data locks in the InLoox database can be removed. 

• The Project Recycle Bin permits the restoration of projects deleted by users 

• The chapter Data Backup explains how to use your existing backup systems to secure your InLoox data 
resources. 

• The chapter Offline Availability explains how individual workstations can be configured in InLoox Workgroup to 
allow operation of InLoox when disconnected from the network. 

  

Master Data Maintenance: 

• Changing base parameters and the setting up of simple permissions are described in the chapter on InLoox 
Options 

• InLoox permits the export of projects, activities, plans, documents and budgets in many formats. The creation, 
contents and scope of the export templates can be changed. See the chapter on Customizing Report 
Templates 

• Create individual InLoox Budget Assets within Outlook. It is possible to create new assets and edit and delete 
existing ones. InLoox Budget Assets are accessible for all users of the Budget Page when creating new 
documents such as Expenses, Calculations and Invoices. It is also possible to customize the InLoox Budget 
States 

• The chapter on editing categories explains how to change the master category list systemwide. 

• InLoox Planning Templates permit the efficient management of standard project plans. The list of planning 
templates can be edited or deleted. 

• The base parameters for task requests, emails and calendar entries generated by InLoox can be defined and 
edited under Edit Notifications 

• The data model of InLoox can be expanded as required. A how-to on Custom Fields modification describes 
how personalized text fields can be added and deleted. 

  

Data transfer and migration from earlier versions:  

• The topic Importing Data from Version 4.x covers the transfer and migration of existing InLoox folders. 

  

Error Handling:  

• The chapter on Error Handling deals with common problems and proposes solutions. 
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• It is possible that the program will issue an exception error. More information can be found in the chapter on 
Program Exceptions  

  

Expanding and modifying the InLoox software: 

• It is possible to change the display, colors and columns of the InLoox Project Overview and transact simple 
workflows. More information can be found in the chapter on Generating Personalized Views. 

• All screen texts and messages can be customized by the InLoox administrator. More information can be found 
in the chapter on Customizing the Language Files 

• It is possible to add licences to your InLoox installation and manage existing ones. More in formation can be 
found in the chapter on Licence Management 
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Data Storage and Management 

DETAILED INFORMATION: CONFIGURATION: DATA STORAGE  

There are essential differences between the current version of InLoox and earlier generations of the product. 

As a consequence of providing an effective permission system and improving response times, InLoox has been 
redesigned to support data storage in SQL databases (SQL = "Standard Query Language"). 

  

The following systems are used by the various InLoox editions: 

InLoox edition Data storage  

Personal via Microsoft SQL Server Compact Edition. Data is stored in a file which 
normally carries the extension .SDF (SQL Server Compact Edition 
Database File). Filename is InLoox.sdf. The file is located in the InLoox 
installation folder 

Workgroup and Enterprise Database management systems supported for networked operation are:  

• Microsoft SQL Server (all versions and editions of SQL Server 
2005 and 2008) 

• Oracle (versions 10g, 9i, 8i, 8.0, including "Personal", "Express" 
and "x64" editions) 

• MySQL (versions 4.1 and 5.0) 
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DETAILED INFORMATION: CONFIGURATION: DATA BACKUP 

Existing backup systems can be used for all InLoox data. The backup cycle, i.e. the frequency of backups, is determined 
by the number of InLoox users and the need to fall back on data as current as possible (e.g. a maximum of one week old) 
in an emergency. As a basic rule daily backup of all data is recommended if you are working with InLoox every day. 

  

For a one-off backup there is the menu command Backup database contents under Tools in the InLoox Toolbar. 

Important notice: A manual backup is not substitute for a regular data backup and is only for the transfer and 
migration of database contents. 

  

A regular data backup is carried out as follows: 

InLoox edition Procedure 

Personal  It is sufficient to make regular copies of the InLoox files on CD-ROM or tape. 
The date file, which normally has the extension .SDF (SQL Server Compact 
Edition Database File), must not be open in any program. The standard 
name of the file is InLoox.sdf. The file is held in the InLoox installation 
folder. 

Workgroup and Enterprise Save the entire InLoox database on the server which carries it. Any software 
that supports the backup while in operation of databases (scheme and data) 
for the database management system you are using may be used. 
Unfortunately it takes very much effort to backup offline copies (database 
replications) located on the user's computers. We recommend to 
synchronize workstations with the database server at frequent intervals; this 
strategy reduces the risk of losing changes which were made offline 

Important notice: Documents stored in InLoox must be backed up separately. InLoox only saves links to these 
objects, a backup of the InLoox database is not sufficient to back up the documents as well. The backup strategy and 
software depend on the storage location of the documents (files on the local computer, the server or the SharePoint 
document library), the number of users and the data volumes. 
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DETAILED INFORMATION: CONFIGURATION: CLEANING UP PROJECT LOCKS 

InLoox applies to projects being worked on a so-called record lock feature. Under certain circumstances this lock can 
remain in place, for example when a VPN user unexpectedly got disconnected from the network. To clean up all record 
locks in the current InLoox folder, proceed as follows: 

Only clean up the project locks after all users have saved and closed their projects. 

  

A brief instruction on cleaning up locks 

1. Click on the menu command Clean Up Locks under Tools in the InLoox Toolbar  

2. Confirm the safety query with Yes. 
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DETAILED INFORMATION: CONFIGURATION: PROJECT RECYCLE BIN 

Projects that are deleted in the InLoox Project Overview land first of all in the project recycle bin. This ensures that in 
networked operation only users with administrator permission are allowed to delete projects permanently. The recovery 
option improves data protection and allows to simply restore deleted projects. 

  

A brief instruction on the project recovery: 

1. Click on the menu point Tools >> Recycle Projects in the InLoox Toolbar 
The dialog box Project Recycler is displayed. 
 

 

2. Select a project and click on Restore 
InLoox restores the project. 

3. Click on Close 

  

Note 

When a project is deleted from the recycler, all data are permanently lost. 
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DETAILED INFORMATION: CONFIGURATION: OFFLINE AVAILABILITY 

Users of InLoox Workgroup and Enterprise work on a database server. It is possible however to configure individual 
workstations to operate InLoox separately from the network. When reconnecting with the company network, an automatic 
synchronization is carried out. 

Important notice: Not all database systems support offline availability or replication. InLoox offers the data structures 
that are needed for synchronization and replication but uses the synchronization features of the database system. In 
certain circumstances it may necessary to change the database system or related software to take advantage of offline 
availability. Check the documentation of your database system regarding offline availability and replication. 

  

Step-by-step instructions for the configuration of InLoox for offline operation can be found in the Download area of the 
Support Center 

If you have problems please refer to our Installation Support. 
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Migrating from earlier Versions 

DETAILED INFORMATION: CONFIGURATION: IMPORTING DATA FROM VERSION 4.x  

Note: It is not necessary for the migration of data from InLoox V4 that that product be installed. Parallel operation of 
Versions 4 and 5 is possible. 

IMPORTANT: Certain field lengths had to be curtailed in Version 5. Field contents from Version 4 are automatically 
truncated and a corresponding message issued when data migration is complete. 

  

The administrator procedure for transferring project data from version 4 is as follows: 

1. Save all current data resources of both Version 4 and Version 5 

2. Start Outlook 

3. Ensure that the InLoox folder of Version 4 is visible and accessible with all subfolders(see chapter on 
Permissions in InLoox 4 Help) 

4. Ensure that the current Version 5 is installed on your system and you are connected to the required target 
database 

5. Select in the Toolbar of InLoox 5 the item Import data from Version 4.x (English)... under the Menu Tools 

6. You will be asked to enter the path of the InLoox folder of Version 4. Select the button "..." 

7. Click on Next 

8. If the correct folder was selected the number of projects to be imported will be shown 

9. Click on Start. The data will be transferred to the new InLoox 5 folder. During this process you may be 
called upon to assign certain contacts which could not be resolved automatically by Outlook 

10. When data transfer is completed click on Next. The next window shows a summary of the imported data 

11. Click on Close 
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Master Data 

DETAILED INFORMATION: CONFIGURATION: INLOOX PLANNING TEMPLATES 

Planning templates are used to speed the creation of new project plans and can be called in all InLoox Projects on the 
Planning Page. Templates contain predefined milestones, phases and grouping, plus resource data. 

  

A brief instruction in renaming and deleting planning templates 

1. Click on the menu point Edit Planning Templates... under the menu Tools in the InLoox Toolbar  
The dialog box Planning templates is displayed: 
 

 

2. Click on Rename 
The dialog box Rename Planning Template is displayed. 

3. Specify a New name for the template. 

4. Click on Delete to remove a template permanently. 

5. Click on OK 

  

  

Hints for the creation of InLoox planning templates: 

• Create templates directly from an InLoox project on the Planning Page 
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• Templates can be used to generate entire projects or specific sections of a project. 

• Templates can be exported or imported as files received from other users. Further planning templates can be 
found in the Download area of the Support Center 
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DETAILED INFORMATION: CONFIGURATION: EDIT INLOOX BUDGET ASSETS 

The budget asset list contains the assets which can be called up by the users in all InLoox Projects on the Budget Page 
for the creation of new expenses, calculations and invoices. The list of assets can be expanded, edited or deleted as 
required. 

  

A brief summary of the creation of assets 

1. Click on the menu point Edit Assets... in the menu Tools in the InLoox Toolbar  
The dialog box Budget Assets is displayed: 
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2. Click on New 
The dialog box New Asset is displayed: 
 

 

3. Specify the Asset Name, Description, Quantity (Standard is 1.0) 

4. Click on New in the Pricing area. 
The dialog box New Unit is displayed. 

5. Create at least one unit: 

• Name, e.g. Day, Cubic meter, Flat rate 

• Purchase price 

• Selling price 

6. Select at least one Group 

7. Click on OK 

8. Click on Save 

  

  

Hints for changing InLoox budget assets: 

• The name of each asset should be short and unambiguous. 

• The description can include wildcard characters, e.g. ...size is x units... 



Detailed information 

139 

DETAILED INFORMATION: CONFIGURATION: EDIT BUDGET STATES 

It is possible in the dialog box New Budget / Edit Budget under the budget page of a project to select a budget State. 
Predefined values of the budget state can be modified as follows: 

  

Brief instruction 

1. Click on the menu point Edit Budget States... in the menu Tools under the InLoox Toolbar  

2. Carry out the desired changes (New, Edit, Delete) 

3. Click on Save 

  

Effects of modifying or deleting a budget state: 

• The renaming of a state takes immediate effect in all relevant projects. 

• On the deletion of a state the relevant budgets have no state until a new state is selected manually by the user 
and the budget saved. 
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DETAILED INFORMATION: CONFIGURATION: EDIT CATEGORIES 

InLoox uses for its projects its own list of categories, which is separate from that of Outlook. When working networked with 
InLoox Workgroup or Enterprise Edition this list provides two significant advantages over the normal Outlook categories 
list: 

• The category list is constant across all workstations. This saves manual reconciliation effort between individual 
workstations.  

• The list can only be maintained by the InLoox administrator, which ensures that only standard categories are 
available. 

  

Brief instruction 

1. Click on the menu point Edit Categories... under the menu Tools in the InLoox Toolbar  

2. Carry out the required changes (New, Edit, Delete) 

3. Click on Save 

  

Effects of editing or deleting a category: 

• The renaming of a category takes immediate effect in all relevant projects. 

• The deletion of a category takes immediate effect in all relevant projects. 
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Customizing Notifications 

DETAILED INFORMATION: CONFIGURATION: EDIT NOTIFICATIONS 

Messages are for the communication of project plans and are sent to those resources of an InLoox project whom the 
project planner wishes should be informed automatically. 

It is possible to define notifications if various kinds for each milestone, phase and grouping of a project using the Planning 
Page. Resources can receive information via email, task request or InLoox reminder. The message templates contain 
predefined text elements which can be changed or deleted. 

  

A brief instruction in changing texts for InLoox messages 

1. Click on the menu point Edit Notifications... under the menu Tools in the InLoox Toolbar  
The dialog box Notifications is displayed: 
 

 

2. Select an entry. e.g. Phase - Resource added 
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3. Click on Design. 
The InLoox Notification Designer is displayed: 
 

 

4. To change the text of the message: 

• Change the text by double-clicking directly on it, e.g. Yours faithfully, Muster Ltd 

5. Click on File > Save 

6. Click on File > Close 

7. Click on Save 

  

Hints on changing messages 

• A description of how to use the InLoox Notification Designer can be found in the 
chapter on Detailed Information: Reporting: The Designer 

• A description of the message types  can be found in the chapter on Detailed 
information: Configuration: Edit Notifications: Message Types 

• More about the significance and contents of the Fields (wild cards) can be found in 
the chapter on Detailed Information: Configuration: Edit Notifications: Fields 
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DETAILED INFORMATION: CONFIGURATION: EDIT NOTIFICATIONS: MESSAGE TYPES 

Messages are for the communication of project plans. Resources can receive information via email, task request or 
meeting request. 

There are specific templates for the various types of planning elements and events which can be personalized.  

  

The following message types are available: 

Message name Application 

Phase - Modified  If a phase is changed using the dialog box New Phase / Edit Phase or 
directly or indirectly within the project plan, InLoox generates this message. 

Phase - Resource added  If a resource is added to a phase using the dialog box New Phase / Edit 
Phase, InLoox generates this message. 

Phase - Resource removed  If a resource is removed from a phase using the dialog box New Phase / 
Edit Phase, InLoox generates this message. 

Phase - Deleted  If a phase is deleted from the project plan on the Planning Page, InLoox 
generates this message. 

Milestone - Modified  If a milestone is changed using the dialog box New Milestone / Edit 
Milestone or directly or indirectly within the project plan on the Planning 
Page, InLoox generates this message. 

Milestone - Resource added  If a resource is added to a milestone using the dialog box New Milestone / 
Edit Milestone, InLoox generates this message. 

Milestone - Resource removed  If a resource is removed from a milestone using the dialog box New 
Milestone / Edit Milestone, InLoox generates this message. 

Milestone - Deleted  If a milestone is deleted from the project plan on the Planning Page, InLoox 
generates this message. 

Grouping - Modified  If a grouping is changed using the dialog box New Grouping / Edit 
Grouping or directly or indirectly within the project plan on the Planning 
Page, InLoox generates this message. 

Grouping - Resource added  If a resource is added to a grouping using the dialog box New Grouping / 
Edit Grouping, InLoox generates this message. 

Grouping - Resource removed  If a resource is removed from a grouping using the dialog box New 
grouping / Edit Grouping, InLoox generates this message. 

Grouping - Deleted  If a grouping is deleted from the project plan on the Planning Page, InLoox 
generates this message. 
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DETAILED INFORMATION: CONFIGURATION: EDIT NOTIFICATIONS: FIELDS 

Messages are for the communication of project plans. The various Message Types are based on separate templates 
which the user can furnish with the necessary fields. A Field is a wild card for information from a project. Fields can be 
added to or deleted from a message template. 

  

The following fields are available in the messages: 

Field name  Description  Contents 

PlannerName Name of planner The name of the project planner, as stored in 
Outlook, e.g. Max Planner 

ResourceName Name of resource The name of the resource or recipient of the 
message, as stored in Outlook, e.g. Tom 
Masterresource 

ResourceList Resources List of all resources involved in a planning element, 
including email address, e.g. 

Joe Maddison (joe.maddison@company.com) 
Jou-Ling Xi (jlx@mailaddress.com) 

GroupName Group Group to which the planning element belongs. The 
group is a sort criterion or a project cost center.  

Note: An internal price per hour is in file for each 
group. The internal prices and the available groups 
an be customized under InLoox Options 

Description Description Multiple-line description of the planning element 

Flag Flag Flag for the planning element (none, green, yellow, 
red) 

Location Location Free text field. States where the phase is to be 
carried out. 

Progress % completed Degree of completion of a planning element in 
percent. Numeric value between 0 and 100 

WorkAmount Amount of work Amount of work done by the recipient resource for 
the planning element 

ProjectStart Project start Start date of the project 

StartDate Start planning element Start date of the planning element 

EndDate End planning element End date of the planning element 

PSPCode PSP code PSP-Code = Work Breakdown Structure code. Free 
text field for identification of phases and milestones in 
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large projects 

ProjectNumber Project number Unique number identifying the project. The format of 
this number can be customized under InLoox 
Options 

ProjectName Project name Concise, freely definable description of the project. 
The project name can be used for more than one 
project. 

ProjectEnd Project end  End date of the project 

ProjectCategory Project category Category to which the project belongs 

ProjectCompany Project company Free text field for the name of the customer in the 
project 

ProjectPriority Project priority  Priority of the project 

ProjectState Project status Text naming the status of the project 

ProjectNote Project Note  Multiple-line free text for the concise recording and 
communication of the significant aspects of the 
project. The project note is input in Notes Area of the 
Manage Page. 

IsProjectEndDateFixed Fixed deadline project Specifies whether the project has a fixed completion 
deadline. 
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DETAILED INFORMATION: CONFIGURATION: EDIT CUSTOM FIELDS 

Custom fields permit you to expand the data model of InLoox to suit your own requirements. New fields can be created for 
the entire project or for one aspect of it: planning, activities, documents, budgets or assets. Field names are freely 
definable. InLoox supports text format only in custom fields. 

  

Brief summary 

1. Click on Edit Custom Fields... under Tools in the InLoox Toolbar 
The dialog box Custom fields is displayed: 
 

 

2. Click on the button New 
The dialog box New Custom Field is displayed: 
 

 

3. Input a Name for the new field 

4. Select the intended Location of the field (i.e. which list) 
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5. Click on OK 

  

Notes 

When a custom field is deleted all contents of it in all projects are permanently lost. 

• Custom fields at project level are available on the Manage Page 

• Custom fields for the list of planning elements are available in the dialog boxes 
New Phase / Edit Phase, New Milestone / Edit Milestone, New Grouping / Edit 
Grouping 

• Custom fields for the list of activities are available in the dialog box New Activity / 
Edit Activity 

• Custom fields for the list of documents are available in the dialog box New 
Document / Edit Document 

• Custom fields for the list of budgets are available in the dialog box New Budget / 
Edit Budget 

• Custom fields for the list of assets are available in the dialog box New Asset / Edit 
Asset 
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Customizing Report Templates 

DETAILED INFORMATION: CUSTOMIZE REPORT TEMPLATES 

It is possible for any user with the relevant permission to export any project via the InLoox Toolbar. 

A user requires read access to the project data to be exported plus permission for use of report templates. More 
information on this topic can be found in the chapter on Permissions. 

  

A brief summary of maintenance of report templates 

1. Click on Edit Report Templates... under Reports in the InLoox Toolbar  
The dialog box Report List is displayed: 
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2. Select a template and click on Edit 
The dialog box Report is displayed: 
 

 

3. Change the name as required and select project pages in which the template is to be used as the standard 
template 

4. Click on OK 

5. Click on Design in the dialog box Reports  
The dialog box InLoox Report Designer is displayed: 
 

 



Detailed information 

150 

6. The following gives an example of how to add an additional data column. In Report Structure click on Table: 
Projects.Activities under the Table: Projects (this is sorted numerically in the upper frame). 
The dialog box Table Contents is displayed: 
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7. Click on the symbol Insert column 
The dialog box Edit Table is displayed: 
 

 
 
Select for example the field Modified by in the tree structure under Fields >> Projects >> Activities and 
click on Insert and then on OK 

8. Click on the tab Header and then on the symbol   Insert column 

9. Enter into the lower test field the text (including quotation marks): "Modified by" 

10. Click on OK 

11. Click again on OK 

12. Click on File >> Save 

13. Click on File  >> Close 

14. Click on Save 

15. The template is now available systemwide in its modified form. 

  

Notes 

Details of the various standard templates can be found in the chapter on Detailed Information: 
Configuration: Types of Report Templates 

A detailed instructions on the use of the InLoox Report Designer can be found in the chapter on 
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Detailed Information: Reporting: The Designer 

Report templates can be exported or imported as files from other users. Further report 
templates can be found in Download Area of the Support Center 
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DETAILED INFORMATION: CONFIGURATION: TYPES OF REPORT TEMPLATES 

The following templates are included with InLoox as standard: 

  

Predefined template types: 

Report template name Usage in InLoox 

Activity List For exporting activities from the Activity page across all projects in the 
InLoox Project Overview 

Planning Overview For exporting planning elements from the Planning page across all 
projects in the InLoox Project Overview 

Document List For exporting documents from the Document page  

Expenses / Calculations / Invoices For exporting budgets of type Expenses / Calculations / Invoices from 
the Budget page across all projects in the InLoox Project Overview 

Budget Overview For exporting data from the Budget page across all projects in the InLoox 
Project Overview 

Letter Correspondence concerning the project 

Meeting Meeting organization document 

Memo Memorandum 

Project Completion Correspondence at end of project 

Project Kickoff Correspondence at start of project 

Project Status Outlook email with current project status 

Turnover List For exporting turnover lists from selected projects in the InLoox Project 
Overview via the InLoox Toolbar 
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The InLoox Report Designer 
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Introduction 

 

Introduction 
With the InLoox Designer, you can create or edit output forms which are used to present information taken either from a 
database or other data source. 

The designer, print preview and export dialog are generally opened from within an application with a menu item (e.g. 
Configuration > Print > Labels or Output > Mail Merge > Labels). 

 
See also: 

General 

Help Functions 
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 General 
The InLoox Designer considers output forms to be "projects". In a project, you will find all actual layout information, as 
well as the layout details including page size and orientation, fonts, colors, frames, circles, lines, pictures etc. if relevant to 
the project. 

The InLoox Designer recognizes three types of projects - lists, labels, and cards (often complex label projects). 

The individual elements of a project are called "objects". In this manner, a label project can, for example, consist of an 
object for the sender line, the address area, and the logo. 

These objects contain the information required for printing such as the actual contents, fonts, alignments, word wrapping, 
colors, etc. 

The InLoox Designer provides different types of objects which can be freely placed and changed in size on your 
workspace. Depending on its type, an object can display information or have various different properties. 

 
Texts: These objects can contain fixed text as well as the variable content of 
individual records. You can define the fonts, object orientation, and alignment of 
the contents. 

 
Rectangles: These objects are rectangular frames for which layout options 
such as frame width, colors, filling pattern and shading can be defined. 

 
Circles and Ellipses: Define Circles and Ellipses. Layout options such as 
frame width, colors and filling pattern can be defined. 

 
Lines: With this object type you can define lines with layout options such as line 
width and color. 

 
Picture Files: These objects allow you to integrate graphics into projects. 
These can be either fixed graphics (ex. a company logo) or variable graphics (i.e. 
different for each record). 

 
Barcodes: These objects allow you to display fixed text or variable contents as 
barcodes. You can define characteristics such as the type of barcode, color, text, 
and orientation. 

 
Tables (Lists): These objects allow you to display fixed text and variable 
contents from various records. You can define layout characteristics such as 
appearance, fonts, column widths and alignments, word wraps, footers, etc. 
Tables appear in list projects only. 

 
Formatted Texts: With this object type you can change the format within a 
line. 

 
Form Controls: Permits input and changes within the Preview. 

 
Charts: With this object you can create diagrams. 

 

  

Crosstab (Pivot Table): With this object you can insert a crosstab object and 
analyze and display different kinds of data in several dimensions. 

 
HTML Texts: With this object you can display the contents of web sites and 
other HTML formatted text. (see Chapter "5.3. Text Objects"). 
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OLE Containers: Serves as a container for various OLE-Server-Documents. In 
this way, you can integrate documents created with Word, Excel, Visio or 
MapPoint into your project. See Chapter "5.13. Insert OLE-Server Documents" for 
more details. 

 
Form Templates: These graphic objects can only be inserted by using 
Objects > Insert > Form Template. They are placed, as templates, in the 
background of the workspace and are used for the exact placement of objects. 
These templates are helpful in the design of complex forms. The form templates 
are exceptional in that they are not printed later. 

  

You normally position the required objects in the workspace with your mouse, and then define the corresponding contents 
and layout properties. Alternatively, you can just drag a variable from the variable list per drag & drop, and place it on your 
workspace. 

In order to edit an existing object you need to select it. Just click into the required object and the object will be selected. A 
selected object can be identified by its raised frame. When a new object is created, it is automatically "selected" and can 
be edited or changed immediately. The property dialog of an object can be activated with a double-click. Please be aware 
that the selection tool needs to be activated. See chapter  Object Bar. 

The following subchapters provide you with a summary of the methods and procedures to be used for the creation and 
editing of projects. The following is a typical sequence of steps in this procedure: 

▪     Define the page layout 

▪     Set preferences and options (only necessary once) 

▪     Insert objects 

▪     Edit objects 

▪     Save the project 
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Help Functions 

 

 Help Functions 
 
See also: 

Context sensitive help 

Online Help 

Tooltips for dialog controls 
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 Context sensitive help 
A context sensitive online help with comprehensive information about all the functions is available to you. You can open 
this directly with the "?" > Context sensitive menu. Alternatively, you can call up the help you need regarding a command 
or a dialog by pressing F1 where you need it. In dialog windows, there is also a help button at the bottom left corner. The 
online help regarding the relevant subject is opened with this. This context sensitive help is available for almost all 
commands and dialogs. 
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 Online Help 
Another way of finding information is to open the online help through "?" > Contents and then to use the search function to 
find the required topic. 
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 Tooltips for dialog controls 
Many dialogs and buttons have tooltips. These are small help texts, which automatically appear when you keep the cursor 
still over a dialog element. 
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General Methods and Procedures 

 

 General Methods and Procedures 
This manual is divided into three sections. The first section is an introduction to the InLoox Designer and the functions 
which are available to you. 

The second section describes in turn the commands which are available via the menu. 

In the appendix you will find a description of the functions which allow you to manipulate strings and numbers. 

But, to start, let's take a look at the layout and the individual tools. 

 
See also: 

The Designer Interface 

Exiting the Designer 

Variables, Formulas and Expressions 

Working with Functions 

Operators 

Working with Sum Variables 

Working with User Variables 

Using Filters 
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The Designer Interface 

 

 The Designer Interface 

 

  

 
See also: 

Dockable and Floating Tool Windows and Toolbars 

Object Bar 

Toolbar 

Context menu 

Status Bar 

Workspace 

Variable List 

Layers Window 

Objects Window 

Table Structure 

Preview 

Properties Window 

Using the Keyboard 
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Drag & Drop 
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Dockable and Floating Tool Windows and Toolbars 

 

 Dockable and Floating Tool Windows and Toolbars 
 
See also: 

Tool Windows 

Toolbars 
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Tool Windows 
You can freely define the way space is partitioned in the InLoox Designer. The windows with the most importance for the 
design of your layouts are the "tool windows". Tool windows allow themselves to be either integrated into the Designer 
window or opened as independent dialogs that stand as single windows on the desktop. The workspace assumes a 
special function, it is the only window that is constantly visible and is attached to the Designer window. The other tool 
windows, for example the Property List or the Object List, allow themselves to be docked to any part of the workspace. 

   

Multiple tool windows can be docked together and, by using the tab strips, brought to the foreground. 

 

To do this, select the tool window to be moved by depressing and holding the left mouse button in the title bar. You can 
now drag the tool window to any desired position. A rectangular frame will be presented which shows the position and 
size at which the tool window will be placed. If you drag it into the title bar of a previously docked tool window, it will be 
placed behind the window(s) at this position. If it is dragged into the upper portion of a previously docked window, then the 
position will be shared and the newly docked window will be in the upper portion. If you drag it into the lower portion of a 
docked window then the position will be shared and the new window will be in the lower portion. The same is true for the 
left and right portions of the (docked) tool windows. 

  

If you place a tool window in a different position, it will not be docked but will be a movable "floating" window. 
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The workspace has the behavior of a previously docked window, with the differences that it cannot be selected and 
moved and other windows cannot be docked behind it. 

Tip: When a tool window is dragged away from its position, it can be returned to that position but there will be no 
partitioning. To repartition, the window must first be placed in another position and then returned to share the space with 
its "colleague". 

  

To set the size relationships of the docked windows, you can place them on the borders of their neighbors and adjust the 
size using the mouse. The position will then be partitioned anew. This functions in both the horizontal and vertical 
directions. 
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Toolbars 
Both of the Designer's toolbars can be docked onto the four edges of the Designer window or presented as freely 
movable (floating) windows. Click with the mouse either in the narrow area at the left or top of the appropriate toolbar, or 
in the title bar of the toolbar if it is presented as an independent window. 

Tool windows and toolbars can be turned on/off by using the command View > Windows >... . 

Tip: Preferences, such as window position, size, display, etc. will be globally saved for every application InLoox is 
integrated into. They are then valid for all InLoox projects of the same type (lists, labels or file cards). 
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 Object Bar 
Some of the tools available in the Designer can be accessed via the button bar. With a mere button click you are offered a 
direct short-cut option. 

These buttons are self-explanatory: if you remain on the button for a short time without pressing a mouse key, a tool tip 
appears. This bar can be placed/removed by choosing View > Windows >Toolbar 'Objects'. 
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 Toolbar 
In the same manner, menu items can also be directly selected via the toolbar (as a shortcut). Just click on the button you 
require. 
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 Context menu 
The most important commands that are related to an object can be activated via a context menu. The title bar contains the 
object's name and type. 

    

 By clicking with the right mouse button in the margins, a small context menu opens which can be used for the quick 
opening of the Object List dialog. 
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 Status Bar 

 

The status bar is divided into three sections: 

▪     the left area indicates the current mouse position in millimeters or inches from the upper left workspace corner. 

▪     the middle area indicates the current mode of operation. (for example, select, draw rectangle, etc.) 

▪     the right area shows the name or type, relative appearance level, as well as the size of a selected object. 

▪     the margin between the object's upper left corner in relation to the same corner of the workspace 

▪     the margin between the object's lower right corner in relation to the same corner of the workspace 
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Workspace 

 

 Workspace 
The workspace is the area in which objects can be changed and defined. The shape and size of the workspace depends 
on the default values of the paper size and alignment (see: Project > Page Setup). 

 

The entity of all objects on the workspace and its corresponding layout are called a project. InLoox distinguishes between 
list projects (list/table creation), card and label projects (label creation). 

 
See also: 

View Modes 

Options in the view mode 
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Rulers and Scale 
The rulers form a frame around the workspace. The position of the mouse is displayed on the rulers with the use of 
markers. You can always see the coordinates of the mouse, which are additionally displayed in the Status Bar. 

The rulers can be turned on/off with the menu item View > Windows > Rulers. 

To ease the entry of data and objects within the workspace, guides can be used in a project. Depress the right mouse 
button while on one of the rulers, drag into the workspace and let go. The new guide then has the same alignment as the 
ruler. All guides allow themselves to be relocated, and a snap function assists you in the exact placement of objects. The 
objects are not permanently attached to the guides; the guides only provide assistance in the placement. 

 

The guide options are defined with a context menu. You can set the "catch range" for each guide in pixel, and the objects 
will automatically be pulled to the guide when they enter the set catch range. 

You can make the guides non-relocatable so that you do not accidentally move them within the workspace. The snap 
function is turned off when you depress the Ctrl-key while placing objects. 
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 Variable List 
The Variable List displays all variables which are available in the current project; for list type projects, all available fields 
are additionally displayed. 

Fields, variables, and internal InLoox variables are distinguished in the hierarchical list. Fields contain the data that 
changes from line to line in a table object, while variables usually only change from page to page. 

If you wish to assign variables or fields to existing objects, you can simply drag the variable from the list and drop it on the 
respective object. InLoox does the pasting for you (drag & drop). 

If you drag a variable to a free area in the project workspace, a new text object is automatically generated. 
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 Layers Window 
The Layer Window shows the various layers or levels of a project. This window can be repositioned on the workspace at 
your will. 

You can improve the overview in complex projects by assigning objects to an individual layer. You can switch layers on 
and off at any time by using the Layers Window. You can give these layers their own appearance conditions. For 
example, one layer may only be valid for the first page of a multipage project, and the second layer for the remaining 
pages. 

More detailed information on working with layers can be found in Chapter  Working with Layers. 
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  Objects Window 

 

Another tool window is the hierarchical Objects List. All objects in the project are displayed with a small rectangle and its 
name in the sequence that they will be printed. The name can be edited by clicking on the current name. The most 
important commands for the objects are contained in the context menu or in the workspace. Objects that are in a hidden 
layer have parentheses around the rectangle in front of their names. Locked objects are identified by a small X. 

The sequence of the objects can be changed by pulling an object with the mouse into another position in the hierarchical 
list. If the Shift-key is depressed, the object will be attached to the object at that position, changing the hierarchy of the 
objects. 

Tip: The special dependence of the objects upon one another, which is very important for printing, is displayed 
hierarchically. Further, detailed information is contained in Chapter  . 
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 Table Structure 

 

The fifth window is the hierarchical table structure, which is only available in some project types. All tables and their 
respective sub-tables of a table object are displayed with their table name, sort order and relation information in the order 
in which they will be printed. The most important commands for the various tables are available through context menus in 
the workspace, and a toolbar. 

Using the buttons in the tool window, you can 

▪     Attach a new table or sub-table 

▪     Delete, cut, copy and paste tables 

▪     Change the order of the tables 
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 Preview 
The Preview Window is available for you in order to check the layout of your workspace. Click in the window to change 
between full size and normal window size. The size of the Preview Window can be changed by dragging the frame. These 
settings are stored globally for the project type, and are therefore valid for all InLoox projects of the same type. You can 
select an area to enlarge by dragging a rectangle. The zoom modes in this preview are independent of the zoom mode in 
the workspace. Alternatively, you can change the zoom modes by using the buttons in the toolbar. 
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  Properties Window 

 

The properties of the individual objects are displayed in this tool window, the Properties Window. The properties are 
sorted, using the appropriate method, by category. Each category has properties that can be combined into groups. 
Categories and property groups can be, to improve view, opened and closed. It is also possible to abstain from the use of 
the categories, and display all property groups alphabetically instead. 

 
The sorting method is set using this button. You can sort either by "category" or 
"alphabetically". 

A good example for a property is the position and size of an object. This can be defined in the "Layout" section of the 
Properties Window or in the workspace. The position of an object is defined by the properties of the x- and y- coordinates 
of the upper left corner, the object width and object height. You can define the size of an object in the Properties Window 
if you do not wish to do so by using the mouse 

To edit a property, click in the value column. When standard values are used, the input of the new value is accomplished 
using a combo box. 

An additional dialog is available for some property groups that eases the input of the property. You can open this dialog by 

either selecting the property group and depressing ENTER or clicking on the button . 

It is also possible, for almost all properties, to enter the value as a formula. To do this, click during the input of the value 

on the combo box entry "Formula". For values that can be entered directly, click on the button   and a formula dialog 
will open. You will find a detailed description of this function in Chapter  Variables, Formulas and Expressions. 

Below the property list, a short description of the selected property is displayed. This function can be turned on/off by 

using the   button. 
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Using the Keyboard 

 

  Using the Keyboard 
The most important functions of the InLoox Designer can be activated by using the keyboard. Here are a few of the most 
important key combinations: 

 
See also: 

Tool Window 

Properties 
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Tool Window 
A key combination exists for every tool window. The window will be activated, or if it is docked behind another window, it 
will be brought to the foreground. 

Tool Window Shortcut 

Workspace CTRL+1 

Variable List CTRL+2 

Layers CTRL+3 

Objects CTRL+4 

Preview CTRL+5 

Properties CTRL+6 

Table Structure CTRL+7 
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Properties 
You can also work with key combinations within the property Lists. 

Function Shortcut 

Change to next property or header Cursor down 

Change to previous property or header Cursor up 

Open category + 

Close category - 

Open all property groups of a category or sub-groups of a 
group 

* 

Edit property Tab 

End editing Shift + Tab 

Open combo box Ctrl + F4 (in Edit mode) 

ENTER Depends on value: open 
content dialog, invert 
Yes/No, open combo box 
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Drag & Drop 
The InLoox Designer is equipped with a broad range of interesting drag & drop functions, simplifying the project design 
process. It is possible (see above) to add new contents to existing objects by drag & drop, or create new objects in a free 
area of the project workspace. This system was also integrated into many dialogs: you may add new contents to the 
property dialogs of text- and table objects or move existing contents easily with the mouse. 
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 Exiting the Designer 

Select File > Exit to end the InLoox Designer session. If your layout definition has been modified since you last 
saved, you'll be prompted to save the file. 
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Variables, Formulas and Expressions 

 

 Variables, Formulas and Expressions 

Information can be inserted into your project in two ways, by entering "fixed text" or using "fields" and 
"variables". 

Information can be inserted directly into the project as "fixed text", e.g. a sender line on an address label or a column 
heading in a list. Fixed text is printed exactly the way you enter it into the project. 

Information coming e.g. from a database is inserted into the projects as "variables" or "fields". Fields are the 
information in a table that changes from line to line, and variables the information that only changes from page to page. In 
this manner you can, for example, select the variable TELEPHONE for the contents of a list column. The various different 
telephone numbers of the database records will then be printed in this column. Variables take the place of information 
from a database, they're placeholders. 

With these two types of information attractive projects can be designed which are sufficient for many purposes. The 
InLoox Designer, however, offers much more. By using formulas and expressions the information contained in variables 
and fixed text can be linked and even edited. To help you with this there are "formulas" (for calculations with numbers) 
and "expressions" (for the combination of text and numeric values and for logical conditions). In formulas and 
expressions you can insert fixed text and variables in "functions" and link them via "operators". 

In the case of projects for printing address labels you can, for example, add the text "PO Box" automatically for a PO Box 
number saved in a variable POBOX by an expression. In this case (formula "PO Box " + POBOX) you wouldn't just have 
the bare PO Box number on the label but "PO Box 11 11 11". 

Or, imagine you have the net prices of articles in a variable PRICE, but you actually wanted the gross prices incl. VAT 
(sales tax) to be printed. Here you can use a formula which calculates and adds the VAT onto the net price. Of course it is 
the gross price which is then printed. 

 
See also: 

The Elements of an Expression 

Insert variables 

Insert fixed text 
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The Elements of an Expression 

 

 The Elements of an Expression 
Fixed text, variables, formulas, functions, links etc. - all fall under the general name "elements of expressions". They can 
all be inserted and combined via the same dialog. This dialog contains an assistant who supports you in selecting the 
correct syntax, provides explanations, and help. 

 

 
See also: 

Input Enhancements of the Formula Wizard 

Expression Modes 

Register Cards 

The Expression Field 
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Input Enhancements of the Formula Wizard 
The formula wizard supports you with various input enhancements that can be (de)activated under Options > 
Formula Wizard: 

 

▪     Show Function Syntax: if this option is selected, a tool tip appears in the formula assistant that describes the selected 
function, lists the necessary parameters and displays the result types. 

▪     Autocomplete for Functions: if this option is activated, after entering 2 characters, all available functions that begin 
with those 2 characters will be shown and can be selected.  This expedites the entry of the function. 

▪     Autocomplete for Parameters: the assistant recommends values based upon the available variables and fields. 

▪     Syntax Coloring: functions, parameters and operators are displayed in different colors. This will improve the 
transparency in complex formulas. 

▪     Automatic Type Conversion: if this option is activated, variables and fields will be automatically converted at the time 
of entry of the expression so the type of data conforms to expectations. 
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Expression Modes 
Please note that there are two possible modes for expressions: 

On one hand there is the normal expression mode, where variables and functions can be used without brackets or 
chevrons. Fixed text must be framed by quotation marks. Variables may be combined with the "+"-Operator. 

 On the other hand there is the extended mode, where fixed text may be stated as is without quotation marks. 
Variables are framed by "<" and ">" and functions are framed by chevrons "«" and "»". The chevrons can be inserted by 
clicking the button. The combining of variables with the "+" operator is not necessary. This mode is easier to use. 
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Register Cards 
The dialog consists of a row of cards, each containing different editing elements. 

Card contains the elements 

Variables 
and 
Functions 

the variables and functions available for this object type 

Function a list of the functions available 

 + -*/ a list of the available link operators 

Text a dialog for the entry of fixed text 

Cond() a special dialog for the definition of IF-THEN-ELSE conditions 

Date$() a list of the available date formats 

Fstr$() a list of the available number formats 

Tab the setting possibilities for tabs (only available in text objects) 

  

On each of these cards you will find an "Insert" button with which you can insert the selected element into the 
expression field. You can also perform this by double-clicking or using drag & drop. 

There are special rules for the syntax and linking of various individual elements of an expression (variables, text, 
functions, etc.). For this reason you should always insert the various elements into the expression field via the relevant 
card of this dialog. In order to insert variables you should use the "Variables and Functions" card, to enter text the 
"Text" card, etc. 

Experienced users may wish to enter the expression directly into the expression field or to edit the expression (e.g. place 
brackets). 
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The Expression Field 
The expression in the expression field is constantly checked during its "creation" for correct syntax. Any syntax errors are 
displayed in the info field beneath the input field, along with a hint as to the cause of the error. As long as the expression 
is incomplete the check routinely displays at least one syntax error. Once the expression is complete, however, and an 
error is still displayed, then the expression really does contain an error which you should correct. 

 

To simplify more complex expressions, you may divide them into multiple lines. This does not affect the result. 

The three buttons next to the input field are used to 

▪     Mark the brackets belonging to the formula expression. 

▪     Select the whole expression framed by a pair of brackets. 

▪     Undo the last step. 
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Insert variables 
The variables are placeholders which will later be filled from the application when configuring projects. The value type 
"String" (Text), "Number", "Date", "Boolean" (logical values), "Drawing", "RTF" and "Barcode" is important as soon as you 
want to use variables as parameters in functions, because usually only certain value types can be used as parameters. 
You can, for example, only multiply a numeric value with a numeric value and not with a picture. 

The "Variables and Functions" card contains a list of the variables which are available for the current object, 
including the data type in the form of an icon in front of the variable and the available functions. 

Double-click (or use drag & drop) on the variable you'd like to transfer to the editing line. 

 

The required variable is then transferred to the editing line with the correct syntax. 

To include further variables in your expression just repeat the steps described above. If spaces should be between the 
individual variables, for example to separate FIRSTNAME and LASTNAME, then don't forget to enter these spaces in the 
editing line also: 

FIRSTNAME + " " + LASTNAME 

You may also insert variables by dragging the required variable to the object on the workspace where it should be 
inserted. The variable is then added automatically to the object as a new line. 
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Insert fixed text 

 

Insert fixed text 
Another very important element in expressions is fixed text, for example as prefix for variables like 

"Phone Number " + PHONE 

which will print: 

Phone Number 1-555-123-456 

The card "Text" offers an easy way to insert text automatically, set tabs and set line breaks. 

 

Enter the text and click on the "Insert" button to insert the text into the expression below. The text will be inserted 
automatically, depending upon the requirements, either in quotation marks (for function expressions) or without (for text 
expressions). For this reason you should always enter text using the "Text" card. 

In this example, the fixed text "Name: " was entered using the "Text" card, and then the variable Customer.Firstname 
and Customer.Lastname using the "Variables and Functions" card. The text "Name:" will be printed first followed by 
the appropriate Firstname and Lastname from the database. 

Please note that spaces, for example separators between variables or between variables and text, are considered to be 
fixed text. 

 
See also: 

Inserting Linefeed 

Inserting Tabs 
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Inserting Linefeed 

 To insert a linefeed, click the button "Linefeed". The linefeed is represented by a special character. 

Linefeed are only active for those objects (a line in a text object or a column in a table) for which line breaks are set. In 
this way, words that do not fit into the line/column will be broken into the next line and all following text will be moved 
down. Please note that if the text doesn't consist of a number of words, but of a long word it will not be wrapped, but 
clipped. 

The value for "Line Wrap" in the "Layout" category of the properties for the text object must be set to "True" for the 
appropriate paragraph. 

For tables, the value for "Line Wrap" in the "Layout" category of the properties must be set to "True" for the appropriate 
column. 
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Inserting Tabs 

 Tabs are only available in text objects, thus the button will not appear in fields of table columns. 

Only one tab can be inserted for each line. Its position and alignment can be adjusted using the card "Tab". For more 
information please refer to Chapter  Inserting Text Objects. 
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Working with Functions 

 

 Working with Functions 
The built-in functions offer flexibility in defining expressions. Functions allow you to change the representation of fixed or 
variable text or numbers, recalculate and modify values and to set a display format for these. 

You'll find a list of available functions and their parameters on the card "Variables & Functions." A detailed 
description of all functions and parameters can be found in the Appendix. 

The functions are displayed in the selected order. You may select to sort them by 

▪     function group (e.g. "Numerical Functions", ...) 

▪     type of return value (e.g. "Numerical Value",...) or 

▪     type of the first parameter (e.g. "String",...) 

 

In this example, the user clicked the "Insert" button for the "dow$()" function which returns the day of the week of the 
date that is passed in the parameter of the function, ex. "Thursday". 

The function is inserted in the correct syntax (with chevrons, etc.) into the function expression field. Also inserted are 
place holders for the parameters which the function expects/allows. You'll be asked to replace the place holder with a 
valid value. It is recommended to set all values for the parameters of your function before you continue with the definition 
of the expression. 

You can also use functions for some parameters. For example: 

dow$(Today())) 

This will print the current day. 

To insert a variable and a function simultaneously, drag the required variable on the required function folder (e.g. 
"Numerical Functions"). The folder will be opened automatically and you can select the desired function. If you drop the 
variable on a function, this function will be inserted into the editing line with the selected variable as first parameter. 
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See also: 

Function Syntax 

Value Types 

Examples for the Use of Functions 

Insert logical condition 

Formatting Numbers, Dates and Currencies 

  



Detailed information 

198 

 

 Function Syntax 
The functions all use the same syntax, and look quite like those of the programming language BASIC: 

Result = Function(Arguments) 

Only the functions and arguments are entered. Upper or lower-case has no meaning in the function name, but is very 
important for the arguments, especially when using variables as arguments. 

InLoox evaluates the expression and replaces the Function(Arguments) with the "return value". 

This means, when you enter a 

Function(Argument) 

the 

Return value 

is generated. 

Definitions: 

Element Description 

Function() The name of the function in its correct syntax. The parentheses for the 
arguments are a part of the function name. Even if the function contains 
no arguments, the parentheses are required. 

Arguments Values used in the expression to calculate the return value. The 
arguments are entered in the parentheses without spaces. A function can 
have no, one, or multiple arguments. Often, functions require arguments 
of a specific value type (see below). It is important that the argument has 
the required value type. 

Return value The value InLoox calculates from the function and the arguments. The 
value type that is returned is dependent upon the value type of the 
function and argument. 
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 Value Types 

Type Meaning 

BOOLEAN Logical values TRUE or FALSE. If the condition is met, the value is 
TRUE, otherwise FALSE. 

String Any combination of letters and numbers. If this is used as fixed text, it 
must be in single or double quotation marks so that they can be 
distinguished from variables. 

Date A number representing the date using a Julian calendar. 

NUMBER A string that consists of the digits 0-9, the decimal point and the minus (-) 
sign. Other characters are not allowed. Strings of this type need not be 
enclosed in quotation marks (""). 

Barcode A string used as barcode text. 

PICTURE A supported graphic format. 

RTF A formatted text 
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Examples for the Use of Functions 

 

 Examples for the Use of Functions 
The available functions are listed in the "Function" dialog page of the formula wizard along with a short description of their 
parameters and usage. Also displayed is the type of argument(s) (parameters) that is/are expected by the function. If no 
arguments are displayed for a function, then no arguments, except the empty parentheses, are expected. Otherwise, the 
function expects exactly the same number of arguments that are displayed. Arguments that are displayed in brackets ([]) 
are optional. 

The argument type "ALL" means that the argument can be of any type, SAME means that this argument must be of the 
same type as the ALL parameter. 

 
See also: 

The function "FStr$(NUMBER, STRING)" 

The function "LastPage()" 

The function "Left$(STRING, NUMBER)" 
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The function "FStr$(NUMBER, STRING)" 
"FStr$(NUMBER, STRING)" formats a numeric argument (NUMBER) using the format string (STRING). It returns a string 
with the formatted number. 

The format string can contain the following characters: 

Format Meaning 

* number or '*'-Prefix 

$ number or '$'-Prefix 

- number or sign (when numerical argument negative) 

 + number or sign 

( number or '('-Prefix (when numerical argument negative) 

) ')'-Postfix (when numerical argument negative) 

# number or space 

& number or '0' 

. decimal point 

, 1000-comma or space 

The 'or' part will be taken when the number is too small to fill the position of that format character. 

A prefix is a character which is written in front of the number. The formula FStr$(1, "***") has "**1" as result. In case of 
FStr$(100, "***"), the result would be "100". A postfix is put behind the number. 

As an example, assume you want to format the number of software products you're selling and that number would be in 
the variable QUANTITY. 

Fstr$(QUANTITY, "#####&") 

formats the number to 6 significant digits. Every place except the smallest can be blank if the number is too small. 

Value Result 

0 "  0" 

1 "  1" 

255 " 255" 

Imagine that you have the price of that software in PRICE and you need it with two decimals (rounded): 

Fstr$(PRICE, "#####&.##") 

Value Result 

999.55 " 999.55" 

1100 " 1100.00" 

1099.5 " 1099.50" 

You want the total price? No problem: 
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Fstr$(QUANTITY*PRICE, "$$,$$$,$$&.##") 

We use the '$' here to show this feature: 

Value Result 

2*999.55 " $1,999.10" 

1100 " $1,100.00" 

100*1099.5 " $109,950.00" 

Some additional examples: 

Formula Result 

FStr$(3.142, "#.###") "3.142" 

FStr$(3.142, ".######") "*******" (overflow!) 

FStr$(3.142, "(&.###)") " 3.142 " 

FStr$(3.142, "(&.###)") "(3.142)" 

FStr$(3.142, "+++&.###") " +3.142" 

FStr$(3.142, "---&.###") " 3.142" 

FStr$(-3.142, "---&.###") " -3.142" 

FStr$(3.142, "&&&.&&&") "003.142" 

FStr$(3.142, "***.***") "**3.142" 

FStr$(3.142, "$$$.$$$") " $3.142" 

FStr$(5003.1, "#,###.&&") "5,003.10" 

FStr$(3.142, "##&.***") " 3.142" 
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The function "LastPage()" 
"LastPage()" returns TRUE if the current page is the last or FALSE if it is not. LastPage() has no arguments, still the 
parentheses have to be written to declare it as function usage. 

As example we assume you want to have a 'sum' line at the bottom of a page which displays the current subtotal or total: 

If(LastPage(),"Subtotal: ","Total: ")+ FStr$(SUM,"$$$$$$$&.##") 

Note that objects using LastPage() in their appearance condition have to be linked to the table object. 
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The function "Left$(STRING, NUMBER)" 
The function "Left$(STRING, NUMBER)" returns the first NUMBER of characters of the STRING. 

Formula Result 

Left$("combit", 2) "co" 

Left$("combit", 10) "combit" 
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Insert logical condition 
Another special function is the "Cond()" function. It represents an "IF - THEN - ELSE" condition: if the result of the 
expression in the first parameter is true, then the result of the second parameter will be returned, otherwise the result of 
the third parameter is used. 

Let us assume that your data base contains both house and post office box numbers, and that you would like to print 
address labels using this data. Naturally, only the street address or the post office box number should be printed, but not 
both. You decide to use primarily the post office box number and only to use the street address when the post office box 
number is not available. With the help of an IF-THEN-ELSE condition, this will be no problem: 

 

Enter the condition to be evaluated, or a Boolean variable, into the condition field. Enter the "true" part into the second 
line, and the "false" part into the third. Note that the "Edit" button starts an additional assistant to help you edit the 
appropriate part. In our example, we used the function Empty() to evaluate if the POBOX field is empty. When you press 
"Insert", the parts will be wrapped into the "Cond(...)" function and inserted into the expression line below. 

In the field "True", enter the expression to be used if the entered condition is TRUE. If nothing should be done, enter two 
consecutive quotation marks (""). 

In our example, the condition is true if the POBOX field is empty, and in this case the STREET should be printed. 

In the field "FALSE", enter the expression to be used if the entered condition is FALSE. If nothing should be done, enter 
two consecutive quotation marks (""). 

In our example, the condition is false if the POBOX field is not empty, and in this case the POBOX should be printed. 

You can insert the established conditions into the expression field by using the "Insert" button. They can be stand-alone 
expressions or part of another expression. 
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Formatting Numbers, Dates and Currencies 

 

 Formatting Numbers, Dates and Currencies 
 
See also: 

Formatting Dates with Date$() 

Formatting Numbers with FStr$() 

Formatting with the format editor 
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Formatting Dates with Date$() 
Using the dialog with the card "Date$()" you can get assistance for date formatting. You can have full-text formatting for 
day and month values, 2- or 4-letter representation of the year and so on. 

 

To the left is the format string, to the right the result with a date example: 

As default, the function Today() is selected as date parameter which will display the current date. Of course you can 
replace it with any date value you like: 

Date$(Today() + 7, "%d.%m.%y") 

This would display the date one week from today. 

In the above example, the date function "Today()" has been formatted so that the result is displayed with the month and 
the day as a two digit number, and the year as a four digit number. More detailed information on the use of the Date$() 
function can be found in the appendix. 
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Formatting Numbers with FStr$() 
Using the card "FStr$()" you can define the format in which a number shall be presented. In this way number of digits, 
decimals, leading signs etc. can be defined. 

 

In this example, the price will be displayed with 6 digits including 2 decimals. If the number just before the decimal point is 
0, only one '0' will be displayed. 

Additional information about the function "FStr$()" can be found in Chapter  Examples for the Use of Functions. 
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Formatting with the format editor 
The format editor is an alternative to formatting with the functions Date$() and FStr$() in the formula dialog. This property 
can be found, for example, in text, crosstab and table fields. Note that the formatting will affect the expression's result. If 
you only wish to format certain parts of an expression (e.g. for text and numbers within one expression) use the functions 
Date$() and FStr$() in the formula dialog. 

With the format editor you can set the format for numbers, currency, date, time, percentage and angle. By default, the 
system settings are used. 
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Operators 

 

Operators 

The card "+ - * /" displays a list of all available operators. These can be used to make calculations, combine variables 
and/or fixed text, as well as to perform logical comparisons. 

The available operators can be categorized, in order of increasing priority, into logical operators (AND, OR, NOT), 
arithmetic operators (+, -, *, /, %) and relations (<, <=, =, >, >=, <>,!=). 

The usual editing rules apply: logical operators will be calculated before arithmetical operators, which will in turn be 
calculated before relations. 

There are three columns on the dialog page. The first describes the operator, the second is the syntax and the third the 
type(s) of value(s) it can be applied to. 

The operator "+" has particular importance, because it can not only be used for addition (Value types "Number" and 
"Date"), but also for the concatenation of text (Value type "String") or fixed text. 

 

Many operations can be performed in an expression. Operators, functions, parentheses - all in one formula. Thus it can 
be important to use parentheses to change the order of evaluation. 

The order of priorities is 

Priority Operators 

1 Parentheses () 

2 Functions 

3 Logical operator NOT 

4 Logical operators AND, OR, XOR 

5 Arithmetical operator modulo (%) 
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6 Arithmetical operators (*, /) 

7 Arithmetical operators ( + , -) 

8 Relational operators (<, < = , = , > = , >, <>, ! = ) 

Operators combine two values to make a result, except for the negation operator NOT, which just takes one value. 
Operators are used to calculate (mathematical operators), compare (relational operators) or combine (logical operators). 

 
See also: 

Relational Operators 

Arithmetic Operators 

Logical Operators 
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 Relational Operators 
Relational operators consist of two values of the same data type that are compared, effectively, for whether the selected 
relational operator applies to both values or not. The result (return value) is the boolean value true if the relation applies 
and false if it does not. 

Operator Meaning Data Types Result Types 

>  Greater than STRING, NUMBER, 
DATE, RTF 

BOOLEAN 

> = Greater than 
or equal 

STRING, NUMBER, 
DATE, RTF 

BOOLEAN 

<  Less than STRING, NUMBER, 
DATE, RTF 

BOOLEAN 

< = Less than or 
equal 

STRING, NUMBER, 
DATE, RTF 

BOOLEAN 

 = Equal STRING, NUMBER, 
DATE, RTF, 
BOOLEAN 

BOOLEAN 

 = = Equal STRING, NUMBER, 
DATE, RTF, 
BOOLEAN 

BOOLEAN 

<>  Not equal STRING, NUMBER, 
DATE, RTF, 
BOOLEAN 

BOOLEAN 

! = Not equal STRING, NUMBER, 
DATE, RTF, 
BOOLEAN 

BOOLEAN 
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 Arithmetic Operators 
Please note that for arithmetic operators the normal calculation hierarchy applies. First the "Modulo" operator is evaluated, 
then the "*" and "/" calculations followed by the "+" and "-" calculations. If you want a different calculation sequence, you 
must use brackets. The innermost brackets are calculated first. 

Operator Meaning Data Types Result Types 

% Modulo NUMBER NUMBER 

+ Add STRING, NUMBER, 
DATE 

STRING, NUMBER, 
DATE 

- Subtract NUMBER, DATE NUMBER, DATE 

* Multiply NUMBER NUMBER 

/ Divide NUMBER NUMBER 

  

An example for the use of arithmetic operators is the expression 

PRICENETTO+(PRICENETTO*0.16) 

With this, the value of the PRICENETTO field would have 16% of the content of PRICENETTO added to it. 
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 Logical Operators 
The result (return value) of a logical expression is always a boolean value: true if the expression is true and otherwise 
false. Please note that for logical operators a calculation hierarchy similar to that for arithmetic operators applies. First the 
negations are evaluated, then the logical AND and lastly the logical OR. If you desire a different calculation sequence, you 
must use brackets. The innermost brackets are evaluated first. 

Operator Meaning Data Types Result Types 

NOT or 
.NOT. 

Not BOOLEAN BOOLEAN 

AND or 
.AND. 

Logical AND BOOLEAN BOOLEAN 

OR or .OR. Logical OR BOOLEAN BOOLEAN 

XOR or 
.XOR. 

Logical exclusive-OR BOOLEAN BOOLEAN 

  

An example for the use of logical operators is the expression 

ZIP>=70000 AND ZIP<=80000 

With this, all records whose contents in the ZIP field are greater than or equal to 70000 and smaller than or equal to 
80000 are selected. 
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Working with Sum Variables 

 

Working with Sum Variables 
Hint: sum variables are an alternative way of creating sums and counters. We recommend using the functions Sum() and 
Count() respectively. Further information can be found under Sum() and Count() in the chapter  List of Available 
Functions. Statistical analysis can be done directly using the aggregate functions Sum, Avg, Min, Max, Variance, 
StdDeviation and Count. 

Sum variables can be used to build sums/totals over the records, for example the sum of the column PRICE in a table. 

It is possible to optionally add all records on a particular page (page totals) or for the whole project (totals). 

 
See also: 

Defining Sum Variables 

Defining a Counter 
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 Defining Sum Variables 
Sums of this type can be used for all numeric values, i.e. for numeric variables or for expressions which result in a 
numeric value. The following logic applies for these sum variables: 

@SumXX = @SumXX + <numeric expression> 

"@SumXX" is the sum variable in which the result of the addition is saved, "<numeric expression>" stands for the variable 
or the expression which forms the basis of the addition. 

For each record which has been printed, InLoox calculates the value from "<numeric expression>" and adds it to the 
"@SumXX". 

 

To use sum variables of this kind ("@SumXX") in projects they must be assign the required numeric expressions. This is 
done with the command Project > Sum Variables. 

Click the "Insert a new variable" button to create a new sum variable first and give a descriptive name. When 
working with projects from older InLoox versions, 50 variables "@sum01"..."@sum50" are already predefined. To assign 
an expression to the new sum variable, click the "Edit..." button. This opens the assistant for defining expressions. 

The easiest way is to simply select a numeric variable, e.g. PRICE. The formula for the result would be: 

@SumXX = @SumXX +  <PRICE> 

ex. the sum of all previously printed prices is saved in the sum variable "@SumXX". 

On the other hand you can also build sums via complex expressions, as long as the result is only a numeric value. 
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Defining a Counter 

 

 Defining a Counter 
With sum variables you can easily define the counter which is actualized for each printed record. 

In the simplest case, a counter is increased for each record. 

@SumXX = @SumXX + 1 

 
See also: 

Page Totals and Other Totals 

Using Sum Variables 
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Page Totals and Other Totals 
The option "page totals" lets you select whether the sum variables are reset at the beginning of each page or just once 
at the beginning of the document. 
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Using Sum Variables 
Once you've defined a sum variable, you can use it in the objects of your project. 

To do this, open the Contents dialog of the appropriate object and then open the dialog for the definition of expressions. 
(See Chapter  Variables, Formulas and Expressions). In the card "Variables and Functions", you will also find the Sum 
Variables @SumXX listed. You can use these variables in your expression just like any other variables. 
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 Working with User Variables 
To avoid having to re-enter formulas  that are required often, it is possible to store them in user variables. These are 
effectively formula building blocks. User variables are labeled with @<Name> (e.g. @User01). These are defined in 
Project > User Variables. 
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Using Filters 

 

 Using Filters 
You can use filter conditions to select the data you'd like to print. You can assign such conditions to single objects or 
layers (so that they are printed or not) as well as to data records. 

Filter conditions are logical expressions and the result determines whether the object or record will be printed. If the result 
of the logical expression is TRUE, the record is used (or the object is printed). If the result of the logical expression is 
FALSE, the record or object will not be printed. 

 
See also: 

Record Filters 

Project Specific Filters for Records 

Layer Specific Filters for Objects 

Object Specific Filters for Objects 

Define Filters 
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 Record Filters 
If you wish to print a telephone list, for example, you can ensure through the use of filters that only those records that 
have contents in the Telephone Number field appear in your list. 

Record filters are available for all types of projects. They are most commonly used in list projects. These filters can be 
globally defined for a complete project or individually for single variables. 
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 Project Specific Filters for Records 
Project specific filters always apply to the complete project. They apply to all objects and variables, whether individual 
filters have been assigned or not. 

To assign a project specific filter, use the command Project > Filter, which will open a dialog for the definition of filter 
conditions. This is similar to the dialog described in Chapter  Variables, Formulas and Expressions. 
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 Layer Specific Filters for Objects 
All objects assigned to a layer can have a common, layer specific appearance condition assigned. This is accomplished 
by using the command Project > Layer Definitions or the context menu in the Layer Window. 

Select the level, in the Layer Window, to which you wish to assign layer specific appearance conditions. Enter the desired 
condition directly into the field "Condition", or open the dialog for the definition of layer conditions (see Chapter 
 Variables, Formulas and Expressions). 
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 Object Specific Filters for Objects 
Appearance conditions can also be assigned to individual objects. The individual appearance conditions will be applied in 
addition to the display conditions, if conditions have been defined, of the layer to which the object is assigned. This means 
that both conditions for the object will be linked with a logical "AND". 
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 Define Filters 
To define object specific filters, enter the desired condition in the property "Appearance Condition" in the Property List. 
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Projects 

 

 Projects 
 
See also: 

Creating or Opening a Project 

Saving projects 

Defining Page Setup 

Default Values and Options 

Including Projects 

Printing Projects 
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Creating or Opening a Project 

 

 Creating or Opening a Project 
Use the File menu commands to open existing projects in the InLoox Designer or create new ones. 

 
See also: 

Create a new project 

The Project Wizard 

Opening an Existing Project 

Project Import 

Project Types 

Project Properties 
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 Create a new project 

 To start a new project, select File > New. If your current project has unsaved changes, you will be asked whether 
you would like to save them. InLoox then automatically opens the default project for the type of project you require. 

Normally this is merely an empty workspace with a certain paper size and alignment. In the case of label projects you can 
also pre-determine a certain label format (size and the layout of individual labels on the page). 

If you select "New project assistant" in the Options > Workspace dialog, you will be guided through the process of 
creating a new project by the project wizard (see below). 

Tip: A default project is a standard empty "copy" to aid in the creation of projects. It is however possible for you to 
change the default project to your own requirements and save it as a file called "default". The next time you use the 
command File > New your own - changed - default project will be opened. 

  



Detailed information 

230 

 

 The Project Wizard 
The project wizard will help you create new projects. In label / card projects you will be first lead through the layout 
options. Afterwards you can select a page title and a matrix of text objects. In list projects you can set the layout options 
as well as: 

▪     page numbering 

▪     page title (first page only or all pages) 

▪     zebra pattern for the table 

▪     create a summary 

▪     select the data for the table object 
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 Opening an Existing Project 

 To open an existing project select File > Open. If your current project has unsaved changes, you will be asked 
whether you would like to save them. 

A dialog will open in which you can select the file to be opened. 

 

If a description has been given to a project (see File > Save As) the description will be displayed underneath the sketch 
field. In the "sketch" field you can see a sketch of each selected project, making it easier for you to find the project you are 
looking for. (The sketch is only shown if the corresponding option is set, see: Options > Compatibility > Sketch in 
File Dialog). 

 

The Designer will issue a short warning if you select a project that was designed with an older version. Please note that 
projects designed with the new Designer will not be readable or editable with an older version. We advise you to make 
backups of your project files before editing them with the new Designer. Please check your layout after conversion 
carefully, as slight changes may occur. 
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 Project Import 

With the command File > Import you can insert all objects from another project into the current project. 
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 Project Types 
The InLoox Designer is capable of different kinds of projects: labels, lists and cards. Please note that it is not possible to 
switch between the different project types in one Designer session. The Designer has to be closed and reopened in the 
new mode for this purpose. 

It is however possible to design multiple projects of the same type in a single session. Simply open or create the projects 
in the order you want to design them. You may not open multiple projects at one time, but you can copy objects from one 
project to another using the clipboard. 
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Project Properties 

 

 Project Properties 
The properties window of the project is displayed when no objects are selected in the workspace. 

 
See also: 

Project description 

Minimum page count 

Fax and mail variables 
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Project description 
In the "Project Description" field you can enter a description of the project. This description is then displayed in the dialog 
File > Open and makes it easier to find the desired project. Alternatively, this description can also be displayed in the 
File > Save As... dialog. 
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Minimum page count 
In the "Minimum page count" field you can set that a certain number of pages must be printed. 
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Fax and mail variables 
You can send InLoox documents directly as a fax with the Windows 2000 / XP fax machine. The corresponding printer 
driver is set up automatically (in Windows 2000 /XP) when you have a fax-capable modem installed on your computer. 
When sending a fax, additional information is needed to be able to address the fax, i.e. at least the fax number must be 
present as information in the document. These fax variables are defined directly in the properties window of the project. 
The properties window is displayed when no objects are selected in the workspace. 

You can also send InLoox documents directly by eMail. The required eMail variables are also defined in the properties 
window of the project. The eMail settings (SMTP, MAPI, XMAPI) are changed in the control panel under "combit Mail 
Settings". 

  



Detailed information 

238 

 

 Saving projects 
Projects can be saved using any file name that is allowed by your operating system. It is recommended however to use 
the default file extension for each project type. 

To save a project, select File > Save. When you want to save new projects using File > Save, the File > Save As 
dialog will be displayed and you can select a name for your project. 

To save an existing project under a different name or path, selectFile > Save As. A dialog will open in which you can 
enter a name for the project, the device and the directory in which the project will be saved. 

In addition to the file name, you can give a short description of the file which will be shown in the file-open dialog to help 
you to easily distinguish your projects. 
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Defining Page Setup 

 

 Defining Page Setup 

 Before you start to place objects in a project, please select your layout. With the command Project > Page 
Setup you can define properties such as printer selection, paper size and orientation. The layout options available 
depend on the type of project you are currently working with. 

 
See also: 

Printer Selection 

Export Media 

Templates and Page Layout for Labels 
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Printer Selection 

 

 Printer Selection 
 
See also: 

Selecting Printer and Paper Format 

Force Page Format(s), if possible 

Use physical paper size and not only the printable area 
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Selecting Printer and Paper Format 
Click the "Select" button to define the paper size and orientation and select the printer for the project. 

You can also either open a predefined label format, or freely create your own. The paper orientation is saved with the 
project and does not change the Windows default printer settings. 

If the project consists of only one page or requires one printer specification for all pages select "Printer page 
independent". 

For projects with more than one page it can be useful to select a different printer specification or different printer. If you 
check the "Printer page dependent" option, you can select different printers (-options) for the first and the following 
pages. In this way you can use corporate letter-head paper for the first page and normal paper for the following pages. 
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Force Page Format(s), if possible 
If no printer definition file exists and this option is set, the paper format selected during design will be forced during print 
out. Prerequisite is that the respective format or a "user defined" format is supported by the printer. If not, the next size up 
will be selected. 
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Use physical paper size and not only the printable area 
If this option is set the whole physical page is available as workspace, including non-printable margins. Some label page 
layouts require this, as the first label starts right at the top left edge instead of at a specific distance. The unprintable 
margins are shown shaded in the full-page preview. 

This means that objects can also be placed in the margins which will be cut off during the print. If objects are placed on 
page edges you still should take notice of the unprintable area. 
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 Export Media 
Depending on the application, different export possibilities of InLoox are listed. You can configure the output into different 
export formats by the corresponding option dialogs. 

 Select the format in the list and click on the options button 

 You can select a target format as default for the later print 
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Templates and Page Layout for Labels 

 

 Templates and Page Layout for Labels 
A previously or manually defined label format can be loaded in the page layout for labels. 

 
See also: 

Using Pre-Defined Label Formats 

Defining Your Own Label Formats 

Defining Print Order 
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Using Pre-Defined Label Formats 
You can select from a range of pre-defined label formats in the "Templates" register in the page setup for labels. Now 
you won't have to figure out the size of a particular label and how many labels are on one page. 
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Defining Your Own Label Formats 

 

Defining Your Own Label Formats 

It is also possible to define your own label layout if the one you require is not available. Use the following values: 

 

  



Detailed information 

248 

 

Setting the Offset 

The offset provides the horizontal and/or vertical distance of the top left-hand label to the edge of the workspace 
(depending on the "physical page size switch, this is relative to the paper edge or the printable area edge). 

The top left corner of the workspace always begins on the screen display with the coordinate 0/0, independent of the 
selected page size and offset. The effects of the offset can however be seen in the full-page preview or when you print. 
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Setting the Size 

This provides the size (horizontal = width / vertical = height) of the label in inch or mm. 
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Setting the Distance 

This option defines the distance from one label to the next (the space between two labels). For labels with only one 
column, only the vertical distance needs to be entered. 
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Setting the Number 

This option defines the number of labels per page. (horizontal value = number of columns per page, vertical value = 
numbers of lines per page) 

You can check the layout by selecting Options > Preview > Page Preview. 
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Defining Print Order 
In addition to the printer and paper format, in a label project you can also define the print order of the labels on a label 
sheet. Labels are normally printed in lines from top left to bottom right. With partly used sheets of labels you may have 
already used the first line of labels, for example, which could cause the sheet to lose its stability at the top. Some printers 
have problems taking such sheets and react with a paper jam. 

Here you have the option of printing sheets of labels from the bottom up. In this way the top line of labels will be printed 
last and the sheet remains stable, even when the critical area on the sheet is reached. 
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Default Values and Options 

 

 Default Values and Options 
Before you start to insert individual objects belonging to a project on your workspace, and set their properties, you need to 
define the default values you require with the command Project > Options. In this way you'll save time and effort 
later. 

Each option in this dialog is explained by a tool tip. 

 
See also: 

Options for the Project 

Options for Objects 

Options for the Preview 

Options for the Workspace 

Compatibility Options 

Options for the Formula Wizard 
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Options for the Project 

 

 Options for the Project 
The options set in the "Project" card are only valid for your current project. 

 
See also: 

Defining Alignment Grid 

Precision 

Exporting to PDF 
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Defining Alignment Grid 
Specify whether a grid net should be placed in the background of the workspace or not. You can set the distances 
between the grid lines. The option "horizontal - vertical - synchronized" enables the same grid spacing in both 
directions. 

With the option "Snap to Grid" you ensure that objects are not freely inserted or moved on the workspace but only 
along the (sometimes invisible) grid lines. 
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Precision 
Here you can define the default number of decimal places for numeric values, which will be used as long as they aren't 
printed with format specifiers (ex. FStr$). 
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Exporting to PDF 
Here you can set the maximum directory depth of group headers, which are turned into PDF bookmarks when exporting 
to PDF. 
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Options for Objects 

 

 Options for Objects 
Default values set on the card "Objects" are valid for all new objects, until they are changed. 

With the card "Objects" you can make various settings for objects. Newly created objects have these default values at 
the start. You can change these values later for each object. We recommend defining these values to a suitable level 
when beginning a new project so that the manual changes are later kept to a minimum. 

The default values are only valid for the current project. 

 
See also: 

Object Font 

Color Preferences 
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Object Font 
In the "Object Font" group you can define the font for each newly inserted object, using the "Select" button. With the 
button "default" in the object properties the font can be adjusted to a predefined system font. The settings also affect all 
objects which were not changed manually to a non default font. 
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Color Preferences 
The category "Color Preferences" allows you to set options for the appearance of objects. 

With the combo boxes "Border" and "Filling" you can set different colors for different objects. 
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Options for the Preview 

 

 Options for the Preview 
On the "Preview" card you can define global settings for the preview. 

 
See also: 

Setting Colors for the Preview 

View of Label/Card Projects 
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Setting Colors for the Preview 
In the "Colors" group you can define the color for the background of the preview window using the combo box 
"Background". With the combo box "Border" you can select the color of the simulated paper border in the preview. 

  



Detailed information 

263 

View of Label/Card Projects 

 

View of Label/Card Projects 

Here you can select if the preview should contain only one label or the complete page (only available for label or card 
projects). 
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Optimized View 

Using the options from the "View Optimization" group you can reduce different preview details, which enables a 
faster preview. 
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Options for the Workspace 

 

 Options for the Workspace 
The workspace can also be adjusted to your needs in various ways. 

 
See also: 

Displaying Objects 

Settings for Usability 

Changing Column Widths Using the Cursor 
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Displaying Objects 
In the "Text in Objects" group you can define whether the text contained in objects should be displayed or not on the 
workspace. The "WYSIWYG"-option displays the selected fonts and formats the way they are printed. 
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Settings for Usability 
The "Usability" options allow you to define various default values for handling the InLoox Designer. 

▪     Check the option "Object Info" to get a tooltip with the object name. 

▪     Check the option "New Project Wizard" to receive assistance when creating new projects. 

▪     If the option "Fast update" is checked objects will be painted faster. On some systems light flickering may occur. 
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Changing Column Widths Using the Cursor 
The width of a field or an entire column can be controlled precisely by adjusting the "width" property. You can also control 
the width directly with your cursor in the workspace by selecting the table object and moving the right hand border line of a 
column. This will affect all table columns, whose separators lie within a +/-2mm interval of the cursor. 

▪     The adjustment will affect only the line on which the cursor is positioned if CTRL is held down. 

▪     The line will snap to a separator mark if it is within a 10 pixel interval of it. By holding SHIFT, this function is turned off. 

▪     With the option "Column width modification modifies next column", it is possible to change the width of the column 
while also changing the width of the next. 

▪     To change the widths of columns that are currently invisible, deactivate the "Edit only visible cells" option. 

  



Detailed information 

269 

Compatibility Options 

 

 Compatibility Options 
Here you can set various options which concern the compatibility with other components and previous versions of InLoox. 

 

 
See also: 

Clipboard Format is Text 

Sketch within File Dialog 

Selection mode after object insertion 
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Clipboard Format is Text 
This option defines the format in which objects will be copied to the clipboard in the InLoox Designer. This option only 
takes effect when pasting Designer objects into other applications. 

When the option is set, the internal definition of the object can be inserted via the clipboard into other programs. 

When the option is not set, InLoox uses its own clipboard format. 
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Sketch within File Dialog 
This option defines whether a sketch of the currently selected project is shown in the file selection dialog. When the option 
is set, a sketch will be created each time you save the project. 

Some very old graphic card drivers unfortunately have problems in the support of this function. In this case it is helpful to 
switch off the option. 
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Selection mode after object insertion 
▪     Set the "Selection mode after object insertion" option in order to switch to the selection mode automatically after 
inserting an object. This prevents you, for example, from inserting multiple objects accidentally. 
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 Options for the Formula Wizard 
The Formula Wizard offers many ways of simplifying the creation of formulas and functions. For further details regarding 
working with formulas, look at  Variables, Formulas and Expressions. In this interface, you can deactivate the functions if 
desired. See Input Enhancements of the Formula Wizard for specific details on the options. 
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 Including Projects 
When often using similar projects, it is practical not to design repeating elements over and over again, but to include other 
existing projects in your current projects. This way e.g. a letter head can easily be included. In addition, changes just need 
to be edited in one place, if e.g. the design needs to be adapted. A change of address has to be made only in one single 
project instead of different projects. 

Using Project > Include you can include existing projects in current projects. 

The objects of these included projects will be visible, but are locked against editing. Also included are sum and user 
variables of the original project. Please notice not to generate duplicate identifiers when designing, e.g. including an 
existing project that is using a sum variable which is already used within the current project. The sequence in which the 
projects are included can be defined here as well. 
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Printing Projects 

 

 Printing Projects 

 InLoox offers two ways of printing: using the test print in the designer which uses some sample data values, and the 
final print with the "real" data, initiated by the application. 

 
See also: 

Print Sample from the Designer 

Printing to Real Data Preview 
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Print Sample from the Designer 

 

 Print Sample from the Designer 

 Using File > Print Sample you can generate a sample printout of your current project. You can use this sample 
to check the layout of your project. 

Fixed text appears as in the final print, but variables are substituted by sample data which is constant throughout the 
sample. Printing real data can not be done from the Designer. 

 
See also: 

Printing layers 

Print Sample with Frames 

Print Sample without Frames 

Print Sample 1st Page 

Print Sample Following Page 

Print Last Page 
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Printing layers 
With the option "Only Visible Layers" on the "Preview" card in the options dialog, which is opened with Project > 
Options, you define the way layers are printed in the sample print. When this option is not activated, all layers will be 
printed during the sample print. When this option is activated, only the layers visible in the Designer will be printed. The 
sample print is identical to the project in the Preview Window. 

Various options are available for the test print depending upon the type of project being created. 
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Print Sample with Frames 

 By selecting the command File > Print Sample > Print Sample with Frames, your labels will be printed 
on plain paper with a frame, which represents the borders of the labels. 

These frames do not appear when printing real data. 

By using these frames, you can determine if your labels have been printed in the correct size and position. 
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Print Sample without Frames 

 By selecting the command File > Print Sample > Print Sample without Frames, a page of your project 
will be printed, without frames, in the way that it was defined with the exception that the variables have been replaced with 
sample data. 

Print Sample in List Projects 

The command File > Print Sample offers you the options Print Sample 1st Page and Print Sample 
Following Page for your list project. 

With multipage projects, you can define the first page, which may have a special title or header, the following pages 
(which are between the first and last pages), and the last page. These three parts of a multipage project can be sample 
printed separately. 
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Print Sample 1st Page 

 To print the first page of your list project, select the menu commandFile > Print Sample > Print Sample 
1st Page. This will generate a sample print of the first page only. 
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Print Sample Following Page 

 To print the following page of your list project, select the menu command    File > Print Sample > Print 
Sample Following Page. This will print the second page of your project. 
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Print Last Page 
Depending upon the number of records to be printed in your list project, the first, or one of the following pages, can be the 
last page. Objects can be defined for the last page, for example a closing text, by using the appearance condition 
"Lastpage()". These objects will appear on the last page only, in addition to objects that are normally assigned to the 
page. 

When you use one of the commands for a sample print, a dialog will appear in which you will be asked if the objects with 
the appearance condition "Lastpage()" should be printed. If you answer the question with "YES" all objects with the 
condition "Lastpage()" will be printed. If you answer with no, these objects will not be printed. 

This distinction is irrelevant if no objects have been created with the appearance condition "Lastpage()". 

Please note that the condition "Lastpage()" is only reasonable for use with linked objects. Detailed information about 
linking of objects can be found in Chapter  . 
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 Printing to Real Data Preview 
In addition to the Sample Print using sample data, InLoox offers a real data preview. But in contrast to the sample print, 
this can't be used in the InLoox Designer, but in the application. Refer to your application's manual for hints on how to 
open the preview print. 

All print jobs can be viewed prior to printing in a preview window on the monitor. In this way, you can review the layout of 
your project without wasting paper. The output to the monitor takes place as it will during the actual printing. After 
reviewing the layout, you can start printing directly from the preview without again having to use the print command. 

 

The dialog shown on the left will be presented which allows you to select the destination printer and - in case of label 
projects - the starting label. 

 In the category "Export Media" you can, by using the "Change..." button select a different printer or 
different printer options than the defaults defined in your project in the Designer. This setting can be either one time 
(option "Save Options Permanently" not selected), or permanently saved to your project as the default (option 
"Save Options Permanently" selected). Depending on your application, various formats are available in "Direct 
to". 

In the category "Options", you can enter the number of copies, the starting page number and the page range to be 
printed. 

 For label projects, you can additionally select the position of the first label on the first page. This is 
useful when printing on pages where labels have already been used. 
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The dialog shows the layout of the label page. Click on the label you want to use first during printout, taking into account 
the print order noted below.  You can print not only from the upper left to the lower right, but you can reverse this order or 
print by columns. Printing will start from the label that you chose. 

The entire print data can be viewed and printed in a preview window. The non-printable margins will be shaded. On the 
left side of the Preview window, you will find the individual pages of your project in reduced size as "thumbnails". This 
allows a very fast, direct navigation through the document. When you click on a thumbnail, the appropriate page will be 
displayed in the preview. The number of copies set in the printing options window is ignored in the preview and only 
becomes relevant when printing begins. 
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The preview window contains a toolbar that you can use to utilize the various functions of the preview. 

The toolbar can, as with the InLoox Designer, be docked to all four sides of the work space or left floating as an individual 
window. 

The arrow buttons allow you to change to the next/previous page or jump to the beginning/end of the document. 

The magnifiers, as well as the 1:1 tool, represent various zoom levels that can be used to see fine details in the 
document. Alternatively, you can use the mouse to select an area to zoom by drawing a rectangle. 

Using the button "Print Current Page", you can individually print the currently displayed page from the preview. If you 
right click on this button, a Printer Assignment dialog window is opened. 

Using the button "Print All Pages" will send all pages directly from the preview window to the printer. The file will be 
printed exactly as shown in the preview. The Printer Assignment dialog can also be opened using the right mouse button. 

Use the button "Send To" to send the current preview file (*.LL) e.g. through your MAPI-Mail-Client to an email recipient. 
In order to view the preview, the recipient must use the InLoox Viewer, which is often included with the application. The 
InLoox Viewer can also be used to print the preview file. 

Using the button "Save As" you can save the current preview file with the *.LL file extension. 

The preview file can be saved in different formats, as e.g. data exchange format PDF. Depending on the chosen format, 
further corresponding properties are possibly available. Please notice that saving in another format does not guarantee 
that all information is copied. 
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Using the "Exit Preview" button, you will leave the preview window and return to your application. The displayed print 
preview will not be printed, but discarded. Any changes will be lost unless previously saved with "Save As". 
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Objects 

 

 Objects 
This menu contains various functions for the editing of objects. A description of the properties that all objects have in 
common can be found in Chapter  Common Object Properties. 

When inserting objects, always proceed in the following way: 

▪     Create an object as described in  Inserting Objects. The object will be selected automatically. 

▪     Edit the properties of the object with the appropriate tool window and "Properties". 

▪     Hit ENTER in the work space or choose Contents from the Objects menu in the context menu or the properties list. A 
window appears in which you can define the internal setup of the objects. 

 
See also: 

Inserting Objects 

Editing Objects 

Working with Layers 

Object List 

Interlinking objects 

Common Object Properties 

Report Structure 

Inserting Text Objects 

Inserting Lines 

Inserting Rectangles 

Inserting Ellipses 

Inserting Picture Objects 

Inserting Barcode Objects 

Inserting Table objects 

Inserting Formatted Text 

Inserting Chart Objects 

Inserting a Crosstab 

Inserting Form Controls 

Inserting HTML formatted text 

Inserting OLE-Server Documents 

Inserting Form Templates 
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 Inserting Objects 
Objects usually have a rectangular shape and are surrounded by a frame in which their size and position can be changed. 
This frame indicates the area which the object occupies in the workspace and consequently the maximal scope that the 
contents of an object can have. Objects may, however, overlap slightly or fully whereby the overlapped object may 
sometimes be concealed completely. 

Objects may be inserted in the project workspace in different ways: using the menu Object > Insert, the toolbar, 
shortcut keys or per drag & drop function of the variable list. Text objects are inserted most comfortably and efficiently per 
drag & drop from the variable list. Simply select the desired variable and drag it to a free area in the project workspace. 
The easiest way to insert all other objects is via the toolbar. 

▪     Select the desired object type. The mouse pointer will change to a crosshair. 

▪     Place the crosshair on the point at which a corner of the object should be placed. It is best to use the left upper corner 
of the planned object. Depress the left mouse button and pull - while keeping the mouse button depressed - to the 
opposite corner of the planned object. If you started in the upper left corner, pull the crosshair to the lower right corner of 
the planned object. A dashed frame will appear which represents the size that the object will assume upon release of the 
left mouse button. 

▪     Release the mouse button when the object (dashed frame) has the desired size. 
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Editing Objects 

 

 Editing Objects 

 
Select the object that you would like to edit. The object will be marked with a selection 
frame.  You can now: 

▪     change the size of the object 

▪     reposition the object 

▪     define the exact position of the object on the workspace via the position dialog in 1/10 increments of the current unit. 

▪     edit the contents (properties) of the object. These contents are different according to the type of object selected (text, 
picture, table, etc.). You can find a detailed description of the properties of objects in the subchapters of Chapter  Objects 

▪     define appearance conditions for the object. With an appearance condition you define the condition(s) that must be 
met for the object to be printed. In this way you can allow a logo to appear on the first page of a project only and not on 
the following pages 

▪     name the object. Using the name you can easily find the object you are looking for 

▪     assign the object to a (display)-layer or copy it to a layer. Multipage and/or complex projects become clearer if objects 
which belong together are put on a mutual layer. So, in a multipage project all objects which belong to one page can be 
put on a common layer. You only need to switch the visibility of this layer when you want to edit it 

▪     copy the object. If you want to place several, similar objects with the same distance on the workspace then you can 
use the function Create Multiple Copies. 

▪     If you have selected more than one object you can combine the selected objects into a group (grouping), align them or 
adapt their size. 

These editing possibilities will now be described individually in detail. 

 
See also: 

Selecting Objects 

Arrange 

Alignment 

Moving and Sizing Objects 

Grouping Objects 
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Selecting Objects 

 

 Selecting Objects 

 You must be in the selection mode before you can select an object. The currently active mode is displayed in the 
middle area of the info bar. 

To select an object in the selection mode just click into the object you wish to select. If you click into the object with the 
right mouse button, the object will be selected and a context menu will be simultaneously displayed. An object can also be 
selected by dragging a frame around the object by using the left mouse button. Release the mouse button when the 
desired object is completely enclosed with the frame. All objects within the frame will be automatically selected. 

 
See also: 

Selecting Multiple Objects 

Selection Mode 
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Selecting Multiple Objects 
▪     to select multiple objects press the shift-key and click with the left mouse button into the objects you wish to select. 

▪     drag a frame completely surrounding the objects you wish to select. All objects that are completely enclosed by the 
frame will be selected. 
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Selection Mode 
When the command Objects > Select is selected, a sub-menu opens with which you can select from various select 
modes. 

▪     Use the command Objects > Select > Select All or the shortcut Ctrl+a to select all objects in the workspace. 

▪     Use the command Objects > Select> Invert Selection or the shortcut Ctrl+y to invert the selection. All selected objects 
become unselected and all unselected objects become selected. This is valid only for objects on visible layers. 

▪     The order in which the objects were created is important for the command Objects > Select > Next Object. This 
command, or the plus key on the numeric keypad, selects the object that is next in the object list (that is, the object 
created later) than the currently selected one. 

▪     This command has the opposite effect to Objects > Select > Next Object. 

  



Detailed information 

293 

Arrange 

 

 Arrange 
Objects on the workspace may overlap or completely cover each other. You can imagine that each of your objects will be 
printed on a transparency. When you place your objects on the workspace, place these transparencies in the proper order 
on top of each other. Each object is now in its own plane. 

 

You can look at the order using the object list (Objects > Object List). 

Using Objects > Arrange, you can rearrange the planes of the selected objects so that they have the order you 
require. 

Please note that these "planes" (just a term in this case) have nothing to do with the layers. Objects that have been edited 
using Objects > Arrange will not have their layer assignment changed. 

Select the object that you would like to arrange on the workspace, and select one of the following options. 
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To Front 
All selected objects are moved on top of the stack of sheets, that is, they have priority over the objects lying deeper. Use 
the command Objects > Arrange > To Front to bring the selected object to the top of the stack, or use the shortcut 
CTRL+POS1. 
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To Back 
Puts the selected objects to the bottom of the stack of sheets. Use the command Objects > Arrange > To Back 
place the selected object at the bottom of the stack, or use the shortcut CTRL+END. 
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One Forward 
Using the command Objects > Arrange > One Forward or the shortcut CTRL+PAGEUP, the selected objects will 
be moved one position up in the stack of sheets. 
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One Backward 
Using the command Objects > Arrange > One Backward or the shortcut CTRL+PAGEDOWN, the selected 
objects will be moved one position down in the stack of sheets. 
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Alignment 

 

 Alignment 
Using the command Objects > Arrange > Alignment you can align multiple objects in relation to each other. A 
minimum of two objects must be selected to use this command. 

 

Each direction (horizontal and vertical) has 6 alignment methods. Select the ones you like, even horizontal and vertical 
simultaneously. If the objects should not change in one direction, leave the method of this direction to "Unchanged". 
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Left / Right / Top / Bottom 
The functions reposition the selected objects at the corresponding border of the selection rectangle. They will not change 
in size. 
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Centered 
The objects will be placed at the center of the selection rectangle. They will not change in size. 
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Size Fit 
The objects will be resized to fill the selection rectangle in the corresponding direction (horizontal or vertical). Thus they 
will all get the same width or height. 
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Equal Shape Distance 
The selected objects will be repositioned so that the distances between their frames are constant. If the objects are equal 
in size, this is the same as Equal Center Distance. 
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Equal Center Distance 
The selected objects will be repositioned so that the distances between their centers are constant. 
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Unchanged 
Select this if you do not wish to make any changes in the corresponding direction. 
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Moving and Sizing Objects 

 

 Moving and Sizing Objects 
You can reposition any selected object or change its size. While in editing mode, these steps can be undone with the 
menu command Edit > Undo. This can also be accomplished by using the shortcut CTRL+Z or ALT+BACKSPACE. 

If multiple objects are selected these can be changed simultaneously, as with a single object. 

 
See also: 

Changing Size 

Repositioning an Object 

Changing Size and Position via Dialog 

Repositioning and Changing Size via the Keyboard 
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Changing Size 
▪     Select the desired object. 

▪     When the mouse pointer is placed over the frame, it changes into a bi-directional arrow. The size can be changed by 
depressing the left mouse button and pulling in one of the displayed directions. To simultaneously change the objects size 
in both the horizontal and vertical, the mouse pointer must be placed in one of the corners of the object frame. 

▪     While dragging the mouse pointer, a frame is created, which reflects the new size of the object. 

▪     Release the mouse button when the object has reached the required size. 
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Repositioning an Object 
▪     Select the object you require. 

▪     Click into the object to reposition it. If the mouse pointer is positioned over the selection frame, a four directional arrow 
will be displayed. 

▪     Release the mouse button when the object has reached the position you require. 
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Changing Size and Position via Dialog 

 

You can change the size and/or position of an object in the Property List. Please note that changing an entry will cause 
the automatic recalculation of all other related values. 

 

If you double-click on the subcategory "Position" in the Property List a position and size dialog opens. Using this dialog, 
the defining of the size and position of an object using the keyboard is simplified. 
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Repositioning and Changing Size via the Keyboard 
In addition to the mouse and position dialog, objects can also be repositioned on the workspace via the keyboard. 

▪     Select the object you wish to reposition. 

▪     Use the cursor-keys to move the object in the direction you require. Press the key once and the object moves 1/10 
millimeter, if the shift-Key is also held, the object is moved by 1 millimeter. 

▪     Use the ctrl and cursor keys for fine adaptation of the object's size 

▪     Use the shift, ctrl and cursor keys for a quick adaptation of the object's size. 
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 Grouping Objects 
Multiple objects belonging together can be combined into a group in order to be treated like a single object. Please note 
that an object can only be a member of one group. It is therefore not possible to combine groups into a larger group. 

To combine two or more objects use the following procedure: 

▪     Select the objects you require. 

▪     Select the command Group from the Objects menu or from the context menu. 

▪     To undo a grouping select the command Ungroup from the Objects menu. 
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Working with Layers 

 

 Working with Layers 
These layers are especially helpful with complex or larger projects. For larger projects, it is suggested to relate the objects 
on each page (first page, following pages, last page) to their own layer. Because you can fade these layers in or out as 
required, every page of your project can be handled separately. Otherwise the objects of different pages would be 
overlapping and would make the treatment of single objects more difficult. 

Selected objects can also be given appearance conditions in the layers window. 

It can also be helpful for complex projects to relate objects with the same appearance condition to one layer. Even the 
most complex forms can be created without losing control of your project. 

 
See also: 

Defining Layers 

Assigning Layers 

Copying into Layers 

Switching Layers On/Off 
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Defining Layers 

 

 Defining Layers 

 

Layers can be defined using the command Project > Layer Definitions or by using the command Layer 
Definitions in the context menu of Layers tool window. The defined layers apply to the current project. 

 
See also: 

Inserting, Deleting and Editing Layers 

Appearance Conditions for Layers 
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Inserting, Deleting and Editing Layers 
In the layers window of the InLoox Designer at least one layer is defined which is called "Basic". When new projects are 
created, the layers "Basic", "First Page" and "Following Pages" are automatically defined. 

- By using the "New" button you can define further layers. 

Each new layer is initially presented with the name "Layer". You should enter a name for the new layer in the "Name" 
field that is easily identifiable. By using the Option"Layer is visible in current view" you can define whether the 
new layer is visible in the workspace or not. 

To easily distinguish between the various layers on your workspace we recommend that you give the various layers 
different colors. All objects on one layer are then displayed in that color. The color has, of course, no effect on the actual 
print. 

- To remove a layer that is no longer required select the corresponding layer and press the "Delete" button. 

If the layer you wish to delete contains objects, they are automatically moved to the basic layer. In this manner you cannot 
lose any objects by deleting layers. 
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Appearance Conditions for Layers 
You can define appearance conditions for each layer that define under which conditions the layer should be printed. 
These appearance conditions correspond to all objects of a particular layer. 

Appearance conditions for single objects are given via the command Objects > Appearance Condition. 

The appearance condition for a layer can be entered directly in the field "Condition", as long as you are familiar with the 
syntax. With the "Edit" button, however, it is possible for you to open the formula wizard, in which you can combine 
variables, text, and functions with any expressions. Further information can be found in Chapter 2.8 "Variables, Formulas, 
and Expressions". 

Typical appearance conditions for layers are those that allow objects of a layer to appear only on certain pages. 

Condition Description 

no condition The objects on this layer always appear 

Page()=1 The objects on this layer appear only on the first page. 

Page()>1 The objects on this layer appear on all except the first page. 

Additionally, logical expressions can be used as appearance conditions. 

The function LastPage() can only be correctly analyzed when it is used within the footer of a table object or in objects that 
are linked to a table. Within the data line the result of LastPage() is always "False". 
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 Assigning Layers 
The currently selected objects can be assigned to the different layers on the workspace. 

Select the objects which you wish to assign to a particular layer, and then select the command Assign to Layer from 
the Objects menu or the context menu. A list with the defined layers will appear. Select the desired layer. 

 

Double-click on the required layer to assign the selected objects to it. Alternatively, you can also click on the required 
layer and then confirm the dialog with "OK". 

The assigned objects automatically appear in the color of the corresponding layer on the workspace. This however only 
applies to the appearance on the workspace. 
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 Copying into Layers 
The Designer allows you not only to assign objects to layers but also to copy existing objects into layers. 

The original object stays on its layer. A copy of the object is made on the target layer. 

To copy one or more selected objects into a certain appearance layer, select the command Copy to Layer from the 
Objects menu or from the context menu. This is practical, for example, when you wish to use many similar objects in 
various layers. 
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 Switching Layers On/Off 

 

The only objects that are displayed on the workspace are those that are assigned to layers that are turned "on". 

You can turn layers on and off by double-clicking on the corresponding layer in the layers window or by clicking directly on 
the checkbox corresponding to the layer. 

Depending on which option you have set on the card "Preview" (in the Options dialog via the option "Only Visible 
Layers"), either only those layers which are turned on will be displayed in the preview window, or all layers. 
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 Object List 
By using the command Objects > Object List or the shortcut NUM* (key * in the number pad) a dialog with a list of all 
available objects is opened. This dialog contains the Object List, the appropriate to window, and features added 
functionality. 
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Interlinking objects 

 

 Interlinking objects 
By interlinking objects, you can set that some objects are printed after other objects and that they superpose when they 
overlap ("sequential interlinking") or that some objects adjust in size and position responding to changes in other objects 
("spatial interlinking"). 

There are three types of interlinking: 

▪     Sequential 

▪     Individual Size and Position Adaption 

▪     At End, Keep Size 

When interlinking the objects there is a hierarchy: the parent object and the  attached (interlinked) object. 

Select Objects > Object List to create a interlink. With the button "Link with...", you can interlink other objects to the 
object selected in the object list. A list of objects available to be linked will appear. Select the object that you wish to attach 
to the object selected in the object list. The tree structure visualizes the interlinks. To attach several objects to an object, 
repeat the steps described above. 

As soon as an interlinked object in the object list is selected - e.g. by clicking it with the mouse - various types of interlink 
are made available in the "Interlink" field, which will be described more closely hereafter. 

 

 
See also: 

Detaching Interlinks 

Individual Interlinking (Size and Position Adaption) 

The "At End, Keep Size" Interlink 

The "sequential" interlink 

Examples for Individual Interlinks 
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Advanced Interlinking 
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 Detaching Interlinks 

If you have selected an interlinked object in the object list, the button "Detach Link" is available. Click "Detach 
Link" to break an existing link. The linked object will be displayed as an regular object in the object list. 
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Individual Interlinking (Size and Position Adaption) 

 

 Individual Interlinking (Size and Position Adaption) 
Both types of interlinking are relating to the used space of the parent object, i.e. the linked object will be subordinated to 
the parent object spatially, which means it will be subordinated in position and size. This automatically creates a 
sequential link too. 

If the parent object changes in size or position , e.g. because the variables contained within it take up less space than is 
available, the interlinked objects will automatically adjust to these changes. 

Spatial interlinks are only effective if the size and position of the parent object change when the variables are replaced by 
the respective field contents. The objects can shrink, but not enlarge. Manual changes in the size and position of the 
parent object in the workspace have no effect on the interlinked objects. 

Spatial interlinks are marked with a square symbol in the object list. For clarity, the type of interlink selected is displayed 
on the "Interlink Type" tab. 

Example Invoice Print: An invoice generally consists of a table that shows the individual invoice line items on any 
number of pages. The first page should of course differ from the others because it also has a letterhead. Create an 
invisible frame on the base layer, which starts where the invoice table is to start on the following page and ends where the 
invoice table is to start on the first page. Assign the display property "Page()=1" to the rectangle. The table is also created 
on the base layer. This starts below the rectangle object. Now link the table with the rectangle (parent object) and set the 
link types "Position Adaption: Vertical Relative to End" and "Size Adaption: Vertical Inverse Proportional". 

  

 

The interlink type is selected under the "Vertical Interlink" and "Horizontal Interlink" tabs. 

 
See also: 

Vertical Interlinking 

Horizontal Interlinking 

Position adaption 

Size adaption 
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Vertical Interlinking 
The interlinked object adjusts in its position or height depending on the vertical position or size changes of the parent 
object. Which corner of the parent object is applicable for the position adaption of the linked object, depends on the option 
selected ("relative to Begin", "relative to End" or "to End" for the position, "proportional" or "inverse" for the size). If the 
parent object moves vertically, the interlinked object will move by the same distance in the same direction. 
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Horizontal Interlinking 
The interlinked object adjusts in its position or width depending on the horizontal position or size changes of the parent 
object. Which corner of the parent object is applicable for the position adaption of the linked object, depends on the option 
selected ("relative to Begin", "relative to End" or "to End" for the position, "proportional" or "inverse" for the size). If the 
parent object moves horizontally, the interlinked object will move by the same distance in the same direction. 

If both options "horizontal" and "vertical" are on, the linked object will adjust to both types of change of position of the 
parent object. 

In any case, two completely different types of interlinking are available to you: 
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Position adaption 
This adaption depends on the position of the parent object. If the parent object changes its position, the position of the 
linked object changes in the same way (depending on the additional options). 

▪     Option "relative to Begin": The child object moves like the top left corner of the parent object. 

▪     Option "relative to End": The child object moves like the bottom right corner of the parent object. 

▪     Option "To End": The top edge of the child object starts at the end of the parent object, independent of its original 
position. This creates an implicit size change on the first page on which the child page is printed. 
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Size adaption 
This is similar to the position adaption, but as the name suggests, this interlink depends on the size of the parent object, 
i.e. when the parent object changes in size, the interlinked object will also change its size (also dependent on the 
additional options). 

▪     Option "proportional": The size of the child object changes in the same way as the parent object. If it becomes 1cm 
shorter, the child object also becomes 1cm shorter. 

▪     Option "inverse": The size of the child object changes inversely proportional to the size of the parent object. This is an 
especially useful option: if the parent object becomes 1cm shorter, the child object becomes 1cm longer. 
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 The "At End, Keep Size" Interlink 
This type of interlinking is similar to the position adaption, but here the available space of the parent object is taken into 
consideration and the size of the linked object remains fixed. If you want to output a chart object after a table and know 
exactly what the chart object should look like, then you place it directly behind the table and link it "At End, Keep Size" 
with the table. Regardless of where the table ends, the chart object will always be output in its chosen size after the table. 
If there isn't enough space behind the table on the last page, then the chart object is printed on the next page to leave its 
size unchanged. 

In this way, you can place several objects beneath each other (such as diagrams, pictures, etc.); the base object of the 
interlink is the first object in the interlink hierarchy with activated page break. 

The linked object must overlap the parent object in the designer. It is important that the parent object is larger than the 
linked object in every situation, since the linked object always tries to take up the space that is left over from the original 
size of the parent object. If, in our example, the chart takes up more vertical space than the table, InLoox will make a page 
break after the table and try to print the chart on the next page, but still within the original area of the table. The chart will 
still not fit, and another page break will be triggered, which leads to a neverending loop when printing. 
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 The "sequential" interlink 
Sequential interlinks are useful when the linked object can only be filled with information once the parent object has been 
printed. 

Example 1: You are writing text and want to have the number of letters and words written on every page counted. The 
linked object only knows this when the text (text object) has been printed. The sum can then be printed at the end of the 
page. 

  

Example 2: You want a final text to be printed after a table, and give it the display condition "LastPage()". Because it is 
only certain what size it is after the table has been output, the final text can therefore only be printed once the table is 
finished. For this, you must sequentially link the table with the final text and the final text will then only print after the table. 

  

Sequential interlinking is the default for linking objects. It is denoted with an hourglass symbol in the object list. 

When the sequential interlink is selected, none of the options for position and size adaption are available in the interlink 
field. 

How and when to use the various interlinks is described in the following pages with examples. 
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 Examples for Individual Interlinks 

Example interlink "Size Adaption: Horizontal Proportional": The linked object (rectangle) changes its size 
proportionally (in the same way) to changes in the parent object (text object). If the parent object becomes larger, the 
linked object will become larger by the same factor. 

  

 

  

 

  

 

  

  

  

  

  

Example interlink "Size Adaption: Horizontal Inverse": The linked object (rectangle) changes inversely (in 
the opposite direction) to the parent object (text object). If the parent object becomes larger, the linked object becomes 
smaller. 
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Example interlink " Size Adaption: Vertical Proportional": The linked object (rectangle) changes 
proportionally (in the same way) to the parent object (text object) in size. If the parent object gets a new row, the linked 
object becomes larger by the same dimension. 
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Example interlink " Size Adaption: Vertical Inverse": The linked object (dark rectangle), behaves inversely 
(in the opposite direction) to the parent object (text object), i.e. if the parent object gets a new row, the linked object will 
become smaller by the same dimension. 

  

 

  

 

  

 

  

Example interlink "Position Adaption: Horizontal, Relative to Begin": The linked object (rectangle) 
changes in position depending on the top left corner of the parent object (text object). You can see that the linked object 
(rectangle) adjusts to the position of the parent object (text object). Because both objects are linked together "relative to 
begin", they behave in the opposite way to the "relative to end" interlink. Here, the parent object has been turned by 180° 
compared with "relative to end". 
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Example interlink "Position Adaption: Horizontal Relative to End": The linked object (rectangle) 
changes in position depending on the bottom right corner of the parent object (text object). 
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Example interlink "Position Adaption: Horizontal To End": The linked object (rectangle) changes its 
position depending on the parent object (text object). This brings about a change in size because the top edge of the 
linked object changes depending on the parent object, but the linked object does not change position. Therefore the linked 
object becomes smaller. The two linked objects must overlap (in the example, the text object is in the foreground), or this 
type of interlink has no effect. 

  

 

  

 

  

 

Example interlink "Position Adaption: Vertical Relative to Begin": The linked object (rectangle) changes 
its position depending on the top left corner of the parent object (text object). With this link, it behaves exactly opposed to 
the "vertical relative to end" interlink: The parent object moves its position upwards because of the setting "Bottom aligned 
= True" in the designer and the linked object follows this position adaption from bottom to top. 
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Example interlink "Position Adaption: Vertical Relative to End": The linked object (rectangle) changes its 
position depending on the top left corner of the parent object (text object). If the text object moves down a row, the dark 
rectangle moves downward proportionally too. 
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Example interlink "Position Adaption: Vertical To End": The linked object (rectangle) changes its position 
depending on the parent object (text object). This causes a change in size, since the top edge of the linked object will be 
changed because of the parent object but the position of the linked object does not change. The parent object moves 
down and the linked object only changes its position in that it shrinks. The linked object must overlap (in the example, the 
text is in the foreground), otherwise this type of interlink has no effect. 
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Advanced Interlinking 

 

 Advanced Interlinking 
 
See also: 

The object list 

Objects with word wrap 

LastPage() 

  



Detailed information 

337 

 

The object list 
The object list creates an implicit print order of the objects, so it automatically creates a sequential interlink. Unlinked 
objects are printed first, followed by any objects that are linked in any way. This means sequential interlinking is only 
necessary in very specific cases, e.g. when an unlinked object is to be printed after the linked objects. 
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Objects with word wrap 
InLoox objects on the base layer are normally printed on every page of a multi-page document. There are 4 exceptions to 
this: tables, text, formatted text and HTML. 

These objects can cause a page break and are then printed over several pages. (The OLE container is not one of these, 
even though it can contain multi-page documents. Only the first page of the document is ever printed.) 

Report Container / Table: is strictly only printed once per project. 

Text, formatted text, HTML: These can be printed on several pages or on every page of the project. The selection is made 
with the object property "Page Break". 
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LastPage() 
InLoox works through its print data sequentially. The application passes one "Data row" after the other and it is unknown 
during printing how much more data is still to come. 

Therefore, it is difficult to find out if the last print page has been reached. The function LastPage() can for this reason only 
return "True" in very particular circumstances: 

▪     in the footer of a table 

▪     with an object linked with a table, as long as a page break has not occurred while printing the attached objects. 

  



Detailed information 

340 

Common Object Properties 

 

 Common Object Properties 
Most properties can be defined using the Property list or additional dialogs. The properties for every object are different, 
but there are a series of characteristics that all object have in common, for example size, position, name and appearance 
conditions. The properties are described here once, and are not listed in the following chapters. The properties for 
individual objects are described in detail in the relevant subchapter of this Chapter. 

When a fixed list of values are available for a property, a button  will be available in the second column of the list. This 
button opens the list of predefined values for the property. 

 
See also: 

Locked 

Name 

Appearance Condition 

Pagewrap Before Object Output 

Position 

Frame / Background 

Colors 

Pattern 

Filled / Background 

Formatting 

Font 

"Contents" of Objects 
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 Locked 

 

Protects an object from being selected accidentally by a mouse click. This property is only relevant for the design and has 
no effect upon the print. If an object is locked it can no longer be selected in the workspace and will be marked with a 
small red icon in the Object List. 

Tip: A locked object can, still, be selected in the Object List for editing. 

Since "Locked" is only relevant for the design phase of a project, there is no possibility to define the value of this 
property using formulas. 

Property Description Value Description 

Locked Protects the object from accidental selection in 
the workspace through a mouse click 

True 

False 

Locked 

Unlocked 
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 Name 
When you insert a new object onto the workspace, an object description appears in the right segment of the status bar. 
The description is made up of the object's type and coordinates. This is the default name for the object. 

If, however, you have a large number of similar objects in your project, these descriptions can quickly become confusing. 
For this reason, you can give the object a meaningful name using the tool windowObjects or the object's Property List. 
In the Property List, click once on the current name to change it. 

Alternatively, you can change the object's name by using the command Objects > Object List or in the Property field. 

Property Description Value Description 

Name Object Name Name   

The object name is - unlike most properties - a fixed string, thus needing no quotation marks for a fixed text. If you have 
activated the option Options > Workspace > Object Info, the object name will be displayed in the tool tip, when 
the mouse is over the object. 
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 Appearance Condition 
An appearance condition can be set for every object, which defines under which conditions the object will be printed. 
These appearance conditions are listed in the Property List under the category "Layout". You will find guidance for the 
definition of these conditions in Chapter  Variables, Formulas and Expressions". 

Property Description Value Description 

Appearance 
Condition 

Appearance condition for printing. The object 
will not be printed in the result is "False". 

True  
False 

  

Formula 

Display 

Do not display 

Formula 
dialog 
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 Pagewrap Before Object Output 
Every object may initiate a page wrap prior to being printed; this means that the object will be printed on a new page. 

Property Description Value Description 

Pagewrap 
Before 

If the condition returns "True", a page wrap will 
be initiated before printing the object. 

True  
False 

Formula 

Break 

No break 

Formula 
dialog 
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 Position 

The property group "Position" of an object defines the x- and y- coordinates of its upper left corner, the object width and 
the object height. 

Property Description Value Description 

Position Position and size of the object. All data is 
entered in the units used on the workspace  Position 

dialog 

Left Horizontal offset of the upper left corner of the 
object relative to the upper left corner of the 
workspace 

Number 

Formula 

  

Formula 
dialog 

Top Vertical offset of the upper left corner of the 
object with the upper left corner of the 
workspace 

Number 

Formula 

  

Formula 
dialog 

Width Object width Number 

Formula 

  

Formula 
dialog 

Height Object height Number 

Formula 

  

Formula 
dialog 
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 Frame / Background 
The property group "Frame" defines the frame properties and the content's distances from the frames. It is available for 
many objects and sub-objects (e.g. table columns). 

Property Description Value Description 

Frame 

  

Frame properties and offset can be defined in a 
dialog:  Frame Dialog 

Default 
(in sub-
objects) 

When true, the default frame is used, which is 
defined in the object's base properties. 

True 

False 

Formula 

Use default 

Use custom 

Formula 
Dialog 

Layout Describes the type of line draw order being used 
with frames with more than one line on it's sides. 

0 

1 

2 

Formula 

Surrounding 

Horiz. Priority 

Vert. Priority 

Formula 
Dialog 

left/top 
right/bottom 

Settings for the individual frame lines.     

Distance Distance between the contents and frame. Number 

Formula 

  

Formula 
Dialog 

Line Visibility of the frame line. True 

False 

Formula 

Line 

No Line 

Formula 
Dialog 

Color Choice of the line color (see  Colors)     

Line Type Choice of the line type. Choice 
of pre-
defined 
lines 
(20) 

Formula 

Choice of pre-
defined lines 
(20) 

Formula 
Dialog 

Width Line Width Number 

Formula 

  

Formula 
Dialog 
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 Colors 
Colors are always defined in the Property List in the same way. 

Property Description Value Description 

 Choice of predefined 
colors and the 
Formula dialog 

  

Color The color can be selected from either the list of 
predefined colors or by using a formula. 

 (1) The color consists of a Hue, Saturation and 
Lightness portion and is selected using the 
HSL function. 

(2) The color consists of a red, green and blue 
portion and is selected using the RGB function. 
Each color portion can assume a value 
between 0 and 255. 0 denotes no portion of 
this color, 255 denotes full color saturation. The 
three portions are mixed additively, with RGB 
(0, 0, 0) denoting black, RGB (255,255,255) 
white. 

(3) A color dialog is also available. 

 

  

  

  

Color dialog 
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 Pattern 
With the pattern property you can define the texture of a color. This property is available with the background colors of 
table rows and drawn objects and is shown in combination with the color property. 

Property Description Value Description 

Pattern Choose a pattern from many predefined 
patterns. A value is always defining a 
pattern. 

This property is only analyzed if "Filled" is 
set to "True". 

Number 

Formula 

Predefined 
sample  
formula dialog 
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 Filled / Background 
With the property Filled a color gradient can be set for the object fill. This property can be found, for example, for the 
crosstab background, table background, ellipse and rectangle. 

Property Description Value Description 

Filled / 
Background 

Select the type of gradient and set its color, 
end color and mid-color. 

The property color, end color, mid-color is 
only used when "Filled" or "Background" are 
set to a value [2...5]. 

  

0 

1 

2 

3 

4 

5 

Formula 

transparent 

Pattern/block 
color 

horiz. 
gradient 

vert. gradient 

horiz. two-
part gradient 

vert. two-part 
gradient 

Formula 
Editor 
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 Formatting 
The format editor is an alternative to formatting with the functions Date$() and FStr$() in the formula dialog. With the 
format editor you can set the format for numbers, currency, date, time, percentage and angle. By default, the system 
settings are used. 

This property can be found, for example, in text, crosstab and table fields. 

Note that the formatting will affect the expression's result. If you only wish to format certain parts of an expression (e.g. for 
text and numbers within one expression) use the functions Date$() and FStr$() in the formula dialog. 

 

  



Detailed information 

352 

 

 

 Font 

The font properties can be defined in a dialog. If Default is set to True, the default font is used. You can define the 
default font by selecting the command Project > Options. Default values set on the card "Objects" are valid for all 
new objects, until they are changed. In the "Object Font" group you can define the font for each newly inserted object, 
using the "Select" button. With the button "default" in the object properties the font can be adjusted to a predefined 
system font. The settings also affect all objects which were not changed manually to a non default font. 

Property Description Value Description 

Font The font properties can be defined in a 
dialog. If Default is set to True, the default 
font is used. 

  

 
Font dialog 

Default The default font is used instead of the one 
set 

True 

False 

Formula 

Default font 

No 

Formula 
dialog 

Name Selection of font. All installed fonts are 
displayed. 

List 

Formula 

Font 

Formula 
dialog 

Character 
set 

Sets the country version of the character 
set. All available character sets are 
displayed. 

Number 

  

Character 
set 

  

Size Size of the font in points. Shows a list of the 
available sizes of the selected font. 

Number 

Formula 

Default size 

Formula 
dialog 

Width Sets the width of the font 0 means standard 
width, otherwise the average character 
width will be used. 

Number 

Formula 

Width 

Formula 
dialog 

Bold Turns on or off the text setting "Bold" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Italic Turns on or off the text setting "Italic" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Underline Turns on or off the text setting "Underlined" True 

False 

Yes 

No 

Formula 
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Formula dialog 

Strikeout Turns on or off the text setting "Strikeout" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Color Font color   Color dialog 

Selection of 
predefined 
colors 

 

  



Detailed information 

354 

 

 "Contents" of Objects 

 Objects that contain sub-objects, for example a text field that contains multiple paragraphs, can have additional 
properties defined that may not appear in the Property List window. 

To edit the contents of these objects, select the object and use the command Contents in the Objects menu or in the 
Context menu, or by using the properties button in the content property of the Property List. Often, you can also 
double-click on the object. These commands can not be used if a Contents dialog is not available for the selected object. 

If available, a dialog window will open that may have a different appearance depending on the type of object. 

You will find further information about the Contents dialogs for individual objects in the following Chapters. 
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Report Structure 

 

 Report Structure 
Multiple (sub)tables in the table object are only available when they are being used by an application that defines 
appropriate relationships. 

A table object can contain various sub-tables. This means it is possible to define (sub)reports with almost any inter-table 
relationship. 

 

 
See also: 

Characteristics of Elements 

Working with Report Structure 
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 Characteristics of Elements 
The base properties of objects will change when using multi tables. Some settings (e.g. "Locked") are only available with 
base objects. Others (e.g. "Fixed Size") are only available in sub tables. To view the properties of sub tables, select the 
table in the tool window "Table Structure". In addition to the table object properties, some other settings become available 
when using multi tables. 

Property Description Value Description 

Separators To easier align (sub)tables and columns 
accurately, you can show separator tick 
marks to the ruler. 

True 

False 

Yes 

No 

  

 

Distance 
before 

Vertical distance from the previous table 

(does not apply when the table is at the 
beginning of a page). 

Number 

Formula 

  

Formula 
dialog 

Sorting The order in which the table is presented. 
All available sorting choices are displayed 
in a list. 

List of 
available 
sorting 
options. 

  

Pagewrap 
before 

When the value "true" is returned, a page 
break will be initiated before the sub table 
is printed. 

True 

False 

Formula 

Wrap 

None 

Formula 
dialog 
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Working with Report Structure 

 

 Working with Report Structure 
Further tables and sub-tables and the desired hierarchical structure can be defined in the tool window "Table Structure". 
Here you can see the layout of the entire project, e.g. on the highest level is the shipper, below this is the order, and on 
the lowest level the items of the order. 

 

This can be continued as required. You can insert further tables, crosstabs and charts to fulfill almost any requirement. 
The table description is composed of the table name [relation name, sort name]. The most important commands for the 
various tables are available through context menus in the workspace, and a toolbar. 

Using the buttons in the tool window, you can 

▪     Attach a new table 

▪     Attach a new sub table 

▪     Delete, cut, copy and paste tables 

▪     Change the sequence of the sub tables of the same hierarchical level 

  

 
See also: 

Inserting multi-table objects 

Attaching (sub)tables 

Example for relationally linked tables 

Headers and Footers in sub tables 
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Inserting multi-table objects 
If there is more than one table available to use in your project, the options will be presented in a window when you try to 
create a table object. Simply choose the table type you wish to create. 

 

When defining the table rows you will be assisted by the field selection assistant, in which only the fields of the selected 
table and its parent tables are available. It is possible to apply changes to multiple columns in one step. Further 
information regarding the field selection assistant and the definition of table contents can be found in  Define Column 
Contents. The representation of the fields in the variables window is automatically hierarchical, i.e. all fields of a database 
table can be found in its own subfolder. 

  



Detailed information 

359 

 

Attaching (sub)tables 
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Example for relationally linked tables 
You wish to create a list of all customers in which the orders of the customers and all ordered items are visible. In this 
situation, there are two 1:n relationships to consider: 

1 customer has n orders 

1 order has n items 
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Headers and Footers in sub tables 
When a table is wrapped to the next page, the headers of the currently active table and the outermost table are printed 
again. To prevent the headers from being reprinted on the next page, use the function FirstHeaderThisTable() as 
appearance condition. 

The same functionality exists with footers. Use the function LastFooterThisTable() as the appearance condition. When 
using this, the footer will only be printed on the last table page if the table is wrapped to the next page. 
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Inserting Text Objects 

 

 Inserting Text Objects 

Text objects are used to place text in the workspace. In addition to fixed text, you can also use place holders 
(variables) such as page number, date, company name, etc. that are made available by your application. These variables 
are then replaced during printing by their assigned contents. 

Text objects can be inserted into your project using the command Objects > Insert > Text or the shortcut CTRL+T. 

 
See also: 

Properties 

Text Contents 

Editing Paragraphs 

The Card "Tab" 

Paragraph Properties 
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 Properties 

Property Description Value Description 

(Contents) Opens the Contents dialog 
 

Opens dialog 

Bottom 
Aligned 

Alignment at the bottom of and within the 
object frame. If this option is activated the 
object's text will be aligned on the lower edge, 
if not, on the upper edge. Requirement is that 
the paragraphs are not larger than the object. If 
so, the text will be clipped. This option is useful 
e.g. when text of an unknown length is to be 
placed at the bottom of a page. 

True 

False 

  

Formula 

  

Bottom 
Aligned 

Top 
Aligned 

Opens 
Formula 
dialog 

Rotation Rotates the object counter-clockwise. Please 
note that only TrueType fonts can be rotated. 

0 

1 

2 

3 

Formula 

0° 

90° 

180° 

270° 

Formula 
dialog 

Background This option allows text objects to be assigned a 
background color. 

When the value is "True", a background color 
can be selected using the "Color" option. 

True 

False 

Formula 

With 
background 
color 

without 
background 
color 

Formula 
dialog 

Frame Through this option it is possible to provide the 
text object with a frame. 

When the value is "True", frame properties can 
be defined by the options color, width and 
distance. 

True 

False 

Formula 

with frame 

no frame 

Formula 
dialog 

Page break Defines if the object can initiate a page break. 

If the property is activated contents that 
exceed the size of the object will automatically 
appear on the next page. This is useful for text 
objects that occupy multiple pages. With 
labels, the next label will not be started until all 
objects with this option have been printed on 
the current label. It is possible that this option 
cannot be used if page break is not supported 
by your application. 

If the expression's result is FALSE, the text will 
be reprinted on every page. 

True 

False 

Formula 

Page break 

No Page 
break 

Formula 
dialog 
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 Text Contents 
A text object can contain many paragraphs that may have totally different display properties. These paragraphs and their 
properties are the contents of a text object. 

The paragraphs can be individually edited in the Paragraph Properties dialog. 
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Editing Paragraphs 

 

 Editing Paragraphs 
Text objects are paragraph oriented, this means that each paragraph can be individually edited and formatted. By 
selecting multiple paragraphs, you can edit their properties simultaneously. 

 

With these buttons you can: 

▪     insert a paragraph 

▪     edit the selected paragraph(s) 

▪     delete the selected paragraph(s) 

▪     copy the paragraph to the clipboard and then delete 

▪     copy the paragraph to the clipboard 

▪     insert paragraphs/text from the clipboard 

▪     move paragraphs up 

▪     move paragraphs down 

You can also insert new paragraphs using drag & drop from the variable list. 

Such an expression can contain fixed text, a variable, a function or any combination of these elements. 

 
See also: 

WYSIWYG 

Edit Paragraph 
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WYSIWYG 
If the option "WYSIWYG" is selected, the fonts for the individual lines will be displayed in the dialog as you have 
formatted them. If the option is not selected, then a standard font will be used and special formatting such as size or color 
will not be displayed in the paragraph list. 
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Edit Paragraph 
A paragraph can be edited by clicking on the appropriate button or by double-clicking with the mouse on a paragraph in 
the paragraph list 

This opens the Formula Editor that has an additional card "Tab" (see below). After you have defined the expression for 
the line, you can accept the line into your text object with the button "OK". You then automatically return to the dialog 
"Text Properties". 
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The Card "Tab" 

 

 The Card "Tab" 
When a text contains a tab, e.g. by inserting it in the "Text" card, the "Tab" card specifies the tab alignment options. You 
can set both the alignment and position of the tabulator. 

 
See also: 

Tabulator Alignment 

Tabulator Position 

  



Detailed information 

369 

 

Tabulator Alignment 
A tabulator causes the preceding text to run, to a maximum, to the tab stop. If the option "Line Wrap" in the Paragraph 
Properties is selected, the text will be wrapped into the next line, if necessary. Otherwise, the text will be cut. 

The text after the tabulator will be wrapped, dependent on the type of tab stop, if the paragraph property "Line Wrap" is 
selected: 

▪     Left justified: the text is left justified in the area between the tabulator and the right edge of the object. 

▪     Right justified: the text is right justified in the area between the tabulator and the right edge of the object. 

▪     Decimal: the number after the tabulator will be aligned on the decimal tabulator. (Note: Text or numbers in front of a 
decimal tabulator will not be wrapped!). 
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Tabulator Position 
The tabulator's position within the selected object is given in the current unit. A positive value signifies that the position is 
calculated from the left edge of the text object. A negative value defines the position relative to the right edge of the text 
object. 

A position of "50" indicates that the text in front of the tabulator will run to a maximum of 50 in the current unit from the left 
edge of the text object, after which it will be either wrapped or cut. Text following the tabulator will start at a distance of 50 
in the current unit from the left edge of the object and run to a maximum to the right edge of the object. 
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 Paragraph Properties 
A paragraph's properties are defined using a Property List whose functioning is identical to the tool window 
"Properties". 

Property Description Value Description 

Paragraph 
spacing 

Space between paragraphs ("paragraph end 
spacing"), vertical blank space 

The spacing is entered in points: To achieve a 
1.5 line spacing with a 10 point font, enter 5 
points. Negative values are allowed. 

Number 

Formula 

  

Formula 
Dialog 

Alignment Here you can, exactly as in word processing, 
define the alignment of individual lines of text. 

0 

1 

2 

Formula 

left 

centered 

right 

Formula 
dialog 

Block Block text is both left and right justified. This 
property is only functional when the selected 
line is wrapped. This means that the line must 
be longer than the available space, consist of 
multiple words and the option "Line Wrap" 
selected. 

The last line will be displayed in accordance 
with the property "Alignment". 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Format The format editor is available in text object 
paragraphs and in table columns and is an 
alternative to formatting with the functions 
Date$() and FStr$() in the formula dialog. 
Using the format editor, you can set the format 
for numbers, currency, dates, times, 
percentages and angles. By default, the 
computer's system settings are used. 

Note that the format settings affect the entire 
expression. If you only wish to format certain 
sections of the expression (e.g. some text and 
numbers within the expression) use the 
functions Date$() and FStr$() in the formula 
dialog. 

True 

False 

Dialog 

Blank-
Optimization 

Blank-optimization can remove undesired 
spaces (leading, enclosed and remaining). 

Imagine that you wish to print a label project 
using the following variables which are to be 
separated with a space: 

<TITLE> <FIRSTNAME> <LASTNAME> 

If there is a record in which no title exists, this 
variable would remain empty but the following 
space would be printed. First name and Last 
name appear with a leading space. If, for 
example, the variable "Firstname" was empty, 
there would be two spaces between "Title" and 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 
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"Lastname" (enclosed spaces). 

If all three variables were empty, both spaces 
would remain (remaining spaces). This line is 
then not empty and would not be automatically 
ignored. 

In these cases, the option "Space-
Optimization" assists in the automatic removal 
of leading, enclosed and remaining spaces. 
Multiple enclosed spaces will be automatically 
reduced to one space. 

Font If default is set, the default font will be used. 
The Font Definition dialog can be opened 
using the font button. All properties in this 
properties group can be set in one dialog. 

 
Font dialog 

Default Default font will be used instead of the set 
values. 

You can define the default font by selecting the 
command Project > Options. Default 
values set on the card "Objects" are valid for 
all new objects, until they are changed. 

True 

False 

Formula 

Default font 

No 

Formula 
dialog 

Name The name of the font. Fonts 
list 

  

Character 
Set 

Defines country interpretation of the character 
set. 

Number Character set 

Size Font size in points. A list of available sizes for 
the selected font will be shown. 

Number 

  

Formula 

Predefined 
size 

Formula 
Dialog 

Font Width Font width. 0 signifies standard width; 
otherwise the average character width will be 
used. Other values define a "run width" which 
narrows or enlarge the character. 

Number 

Formula 

Width 

Formula 
Dialog 

Bold Sets / Resets s the text property "Bold" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Italic Sets / Resets the text property "Italic" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Underlined Sets / Resets the text property "Underlined" True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Strike Out Sets / Resets the text property "Strike Out" True Yes 
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False 

Formula 

No 

Formula 
dialog 

Uneraseable Lines that remain completely empty will be 
ignored. The following lines will be moved up. 
This usually comes handy, but at times can be 
undesirable. With the option "Uneraseable" 
the empty line will remain if it would be empty 
after use of the variable. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Line 
Spacing 

Line spacing defines the space between 
individual lines of a paragraph. 

The spacing is entered in points: To achieve a 
spacing of 1.5 lines with a 10 point font, enter 
the value 5. Negative values are also allowed. 

Number 

Formula 

  

Formula 
dialog 

Line Wrap Determines the behavior, if the text becomes 
too long for a line. 

If the text consists not of several words, but 
only of a long word, it is cut off likewise at 
value "1". 

0 

1 

2 

3 

Formula 

Truncate 

Wrap 

Shrink 

Compress 

Formula 
dialog 

Keep 
Together 

With this property you define whether the 
paragraph will be kept together during a page 
break. 

True 

False 

Formula 

Wrap 

Keep together 
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Inserting Lines 

 

 Inserting Lines 

 To create a line object, select Objects > Insert > Line (CTRL+L). 

  

 
See also: 

Properties 
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Properties 

Property Description Value Description 

Width Line width in the measuring system used in 
workspace 

Number 

Formula 

  

Formula 
dialog 

Color, 
Appearanc
e 
Condition, 
Frame, 
Position,  
Pagewrap 
Before 

See Chapter  Common Object Properties     
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Inserting Rectangles 

 

 Inserting Rectangles 

 To create a rectangle object, select Objects > Insert > Rectangle (CTRL+R). 

  

 
See also: 

Properties 

  



Detailed information 

377 

 

Properties 

Property Description Value Description 

Filled See Chapter  Common Object Properties     

Define whether the rectangle should have a border. 0 

1 

 
Formula 

transparent 

pattern / block color 

Formula dialog 

Border 

Color Color of the frame. See Chapter 
 Common Object Properties 

    

  Width Width of the frame in the 
measuring system used in 
workspace 

Number 

Formula 

  

Formula dialog 

Rounding Rounding factor for the corners of the rectangle in 
%. 

0% signifies angular 

100% signifies: The corners of the rectangle are 
completely rounded. 

Number 

Formula 

  

Formula dialog 

Shadow Define whether the rectangle should have a 
shadow. 

0 

1 

 
Formula 

transparent 

pattern / block color 

Formula dialog 

  Pattern Shadowpattern. See Chapter 
 Common Object Properties 

    

  Color Shadowcolor. See Chapter 
 Common Object Properties 

    

  Width Width of the shadow in the 
measuring system used in 
workspace 

Number 

Formula 

  

Formula dialog 

Appearance 
Condition, 
Position,  
Pagewrap 
Before 

See Chapter  Common Object Properties     
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Inserting Ellipses 

 

 Inserting Ellipses 
Ellipse objects are also available, as a special type of ellipse, for the display of circles. 

 To create an ellipse object, select Objects > Insert > Ellipse  (CTRL+I). 

  

 
See also: 

Properties 
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Properties 

Property Description Value Description 

Filled Define if the ellipse object should be empty or if it 
should be filled with a pattern and/or color. See 
Chapter  Common Object Properties 

    

Circle Define if the ellipse should always be displayed as 
a circle centered in the. 

True 

False 

Formula 

Yes 

No 

Formula dialog 

Border Define if the ellipse should have a border. 0 

1 

 
Formula 

transparent 

pattern / block color 

Formula dialog 

  

  Color Color of the frame. See Chapter 
 Common Object Properties 

    

  Width Width of the frame in the 
measuring system used in 
workspace 

Number 

Formula 

  

Formula dialog 

Appearance 
Condition, 
Position,  
Pagewrap 
Before 

See Chapter  Common Object Properties     
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Inserting Picture Objects 

 

 Inserting Picture Objects 

 To create a drawing or picture object, select Objects > Insert > Picture (CTRL+D). All available formats are 
shown in the files dialog. If you evaluate a file name or a variable as data source, you can do these also by doubleclick on 
the object to select. 

 
See also: 

Properties 
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Properties 

Property Description Value Description 

Data source Select how the data source for the graphic to be 
displayed is defined. 

File name 

Formula 

  

Variable 

  

Formula dialog 

  File name Existing file name, will be 
evaluated if file name was 
selected in the property "Source". 
Select the desired graphic in the 
Windows familiar dialog. In this 
dialog, by using the option 
"Imbed in Project", you have the 
capability to imbed the graphic 
file into your project. The file is 
then copied into your project and 
is available even though the file 
may be absent. In this case, 
embedded will be displayed 
instead of the file name. 

File name 

 

File > Open dialog 

  Formula The file name is the result of a 
formula, if formula was selected 
in the property "Source". The 
result of this formula must be a 
value of the type "Drawing". You 
can also enter a valid file name, 
but it must first be converted to a 
value of the type "Drawing" with 
the function Drawing(). 

Formula 

 

Formula dialog 

  Variable The file name is the result of a 
variable, if variable was selected 
in the property "Source". 

Select the desired variable from 
the list box. In this box you will 
find all variables of the type 
"Drawing" that were defined in 
your application. 

List of all 
variables of 
the type 
Drawing 

  

  Properties Dependent upon your application, 
a further dialog can be opened in 
which more properties can be 
defined. 

 
Opens dialog 

Keep 
proportions 

Using this option, you define whether the graphic 
should be inserted so that the relationship between 
height and width is kept (True) or if the graphic should 
be adapted to fit the frame of the object (False). 

True 

False 

Formula 

Yes 

No 

Formula dialog 

Appearance 
Condition, 
Frame, 
Position,  Page 
wrap before 

See Chapter  Common Object Properties     
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Inserting Barcode Objects 

 

 Inserting Barcode Objects 

 Barcodes can be used for product labels, price stickers, serial numbers and many other purposes. A barcode 
normally consists of a series of differently sized bars and spaces. The minimum bar size should be 0.3 mm, in InLoox the 
bar width relationship is set at 1:3. 

You can find a description of the barcode formats in Chapter  List of Available Barcodes. To create a barcode object 
select Objects > Insert > Barcode(CTRL+B). 

 
See also: 

Properties 

Barcode Contents 
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Properties 

Property Description Value Description 

(Contents) Opens the "Contents" dialog 
 

Opens dialog 

Bar Color Color for the selected Barcode 

See Chapter  Colors 

    

Bar Width The narrowest bar width in SCM units (1/1000 mm). 
0=automatic adjustment. Not supported by all barcode 
types. 

Formula Formula dialog 

  Orientation Orientation of the barcode 
within the object frame. 

0 

1 

2 

Formula 

left 

centered 

right 

Formula dialog 

Bar Width Ratio The ratio between the bars or spaces. Not supported 
by all barcode types. 

Formula Formula dialog 

Rotation Rotates the object counter clockwise 0 

1 

2 

3 

Formula 

0° 

90° 

180° 

270° 

Formula dialog 

Optimum Size Sets the optimum size for the Barcode. This property 
could affect size changes with the following formats: 
EAN 13 (all), DP-Leitcode, DP-Identcode, German 
Parcel, Postnet and FIM. 

True 

False 

Formula 

Yes 

No 

Formula dialog 

Font Font for the Barcode text. Will only be evaluated if the 
"Show Text" property is activated. 

If the default is set the default font will be used. The 
font definitions dialog can be opened by using the 
button. You can set all properties in this property 
group in a single dialog. 

See Chapter  Common Object Properties. 

 
Font dialog 

        

Show Text Define whether the contents of the barcode should 
also be displayed as clear text. 

True 

False 

Formula 

Yes 

No 

Formula dialog 

Appearance 
Condition, 
Frame, 
Position,  Page 

See Chapter  Common Object Properties.     
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wrap before 
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 Barcode Contents 
You can further define the barcode object using the contents dialog. 

▪     If you wish to print fixed text in barcode form, select the option "Text". Enter the value to be printed in the first field. 
Select your desired type of barcode in the second field. Please note that certain requirements (number of characters, or 
spaces) must be met for the selected type of barcode. If the requirements are not met you will receive an error message. 

▪     For some barcode types, for example Maxicode, additional options exist that can be edited in a further dialog. 
This dialog is opened with the button "Options". 

▪     If you wish to use a formula as a barcode, select the option "Formula" and define a valid formula expression using the 
"Edit" button. The return value of the formula must be of the "Barcode" type. You can also enter variables, but they must 
first be converted to variables of the barcode type using the function Barcode(). 

▪     If you wish to print a variable in barcode form, select the option "Variable". All variables of the type Barcode will be 
displayed in a list box. 
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Inserting Table objects 

 

 Inserting Table objects 

 In order to create lists, tables, reports or similar forms, you need a table object. To create a table object, select 
Objects > Insert > Table (CTRL+E). 

In multi-tables you add a table object over the tool window report structure (See Chapter  Report Structure. 

 
See also: 

Properties 

Table Contents 

Definition of Table Lines 

Defining Line Layouts 

Editing the Line Definitions List 

Define Column Contents 

Format Lines 

Appearance Conditions for Table Lines 

Column Properties 

Defining Footer Lines 

Defining Group Lines 

Define Group Footers 
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Properties 
Note: If the tool window "report structure" is available, other properties apply (See Chapter  Report Structure. 

Property Description Value Description 

(Contents) Opens the "Contents" dialog 
 

Opens dialog 

Data lines       

  Force 
Sums 

Sums will be calculated even with 
the suppression of the data lines. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

  Keep 
Together 

If this property is activated, data 
lines will be kept together (if this is 
possible) after a page break. The 
lines will be printed on the next 
page. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

  Suppress If the option "Data Lines Suppress" 
is selected, all data lines will be 
completely suppressed. This option 
is especially useful in combination 
with the option "Force Sums". The 
last option defines that the sum will 
be calculated when the data line is 
not printed. With the combination of 
both options and the use of groups 
and sum variables, the printing of 
interesting statistics is possible. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

  Zebra 
Pattern 

With the option "Zebra pattern" in the 
"Data Lines" group, you can assign 
alternating colors to the data lines. 
This will improve the clarity of large 
tables. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

    Color Color of the selected 
pattern. See Chapter 
 Colors 

    

    Pattern Pattern, with which 
every other data line 
is assigned. Select 
one of the predefined 
patterns. Each 
number represents a 
different pattern. 

Number 

  

Formula 

Predefined 
pattern 

Formula 
dialog 

Footer lines When using multi-tables, this setting is only 
available for sub-tables and not for the Report 
Container. 

    

  Keep 
Together 

With the property Footer Lines 
"Keep Together", you can define, 
simultaneously with the option 
Lines "Keep Together", that 
footer lines will be kept together 

True 

False 

Yes 

No 

Formula 
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during a page break, as far as is 
possible. 

Formula dialog 

Group Footer 
Lines 

Options for the Group Footer Lines. When using 
multi-tables, this setting is only available for sub-
tables and not for the base object. 

    

  Also Empty 
Groups 

Group Footer Lines will also be 
printed for empty groups 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Group Header 
Lines 

Options for the Group Header Lines. When using 
multi-tables, this setting is only available for sub-
tables and not for the base object. 

    

  Keep 
Together 

Using this option, you can define 
that group lines (intermediate 
headers) will not be separated 
from their data lines by a page 
break, if possible. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Fixed Size If the property "Fixed Size" is selected, the table 
will not automatically adjust its size if less space is 
used than available. If the property is not selected, 
the bottom edge of the table object will 
automatically move up and will be printed directly 
underneath the last data line. If "Fixed Size" is 
false, the footer line will be located at the very 
bottom of the table objects rectangle. 

Please note: objects which may be linked to the 
table can only change their position automatically 
when "Fixed Size" is not selected. When using 
multi-tables, this setting is only available for sub-
tables and not for the Report Container. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

  Separators 
Fixed 

If this property is selected, the 
column separators will be 
continued from the last data line 
to the footer line. If this option is 
not selected, the column 
separators will reach only to the 
last data line. This option is only 
available for tables of "Fixed 
Size". 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Locked See Chapter  Locked. 

When using multi-tables, this setting is only 
available for the Report Container and not for sub-
tables. 

    

Background This property allows you to assign a background 
to your table object. See Chapter  Common 
Object Properties.   

When using multi-tables, this setting is only 
available for the Report Container and not for sub-
tables. 

True 
 
False 

  

Formula 

Background 
color 
no 
background 
color 
Formula 
dialog 

Default Font With this property you can assign the default font 
for the table. The Font dialog can be opened 
using the appropriate button. See Chapter 

 
Font dialog 
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 Common Object Properties.   

When using multi-tables, this setting is only 
available for the Report Container and not for sub-
tables. 

Default Frame With this property you can assign the default 
frame for the table. See Chapter  Common Object 
Properties.   

 
Font dialog 

Page wrap 
Conditions 

Additionally, you can enter a condition which will 
cause a page wrap to be performed as soon as 
the condition is met. 

If Page wrap = True, a page wrap will be 
performed after each line. If Page wrap = False, 
the page wrap will only be performed when 
necessary. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Appearance 
Condition, 
Position,  
Page wrap 
before 

See Chapter  Common Object Properties.     
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 Table Contents 
A table consists of various types of lines that can be defined independently of each other. 

▪     There are header lines, data lines, footer lines, group header lines and group footer lines. 

▪     Headers lines are most commonly used as a description for table columns. 

▪     Data lines contain the formatting information for the data that is to be presented in the table. 

▪     Footer lines are located at the end of the page/table and can contain further information about the data displayed in 
the table. 

▪     Group header and footer lines can be used to further structure the data lines through the use of "intermediate 
headers" and "intermediate footers". 

All line types can be defined independently of one another. The columns for a header line can have a different 
appearance than the data lines or footer lines. The header lines can have a completely different appearance than the 
following data or footer lines. 

Various line layouts or definitions can be defined for the individual types of lines. Special appearance conditions can be 
activated, if needed, for the various line definitions. 

In this way, "sub reports" (tables that contain sub-tables) can be created with a maximum of flexibility. 

All line definitions are defined in the identical manner and consist of columns that can all be individually edited and 
formatted. 

The individual lines types with their definitions and columns can be edited in the dialog "Table Contents". 

 

A card is provided for the definition of every line type and the columns. 
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 Definition of Table Lines 
The procedure for the definition of the various table lines is always the same. Appropriately, the cards for the header, 
data, footer, group header and group footer lines have nearly the same appearance. 

First, select the type of line to be edited by clicking on the appropriate card. If nothing has been defined for this type of 
line, you will be asked if you would like to use an existing line definition for the new line type. 

If line definitions have been created, you can select the definitions to be used in the new line type. 

 

In the example pictured above, the definition for line definition 1 was selected for use in the data line. 

If you are creating a new table and no lines have been defined, this dialog will not appear. 

You also have the possibility to copy one or more columns from one table to another or from one area of a table to 
another, using the clipboard. 
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 Defining Line Layouts 
Various layouts can be defined for each line type. In connection with the appearance conditions, and dependent upon the 
situation, the appropriate layout will be used. In this way, table lines for some records will appear in bold print while others 
are displayed normally. Or, under certain conditions, the table lines contain other columns. 

 

For every line type, there are 100 - 150 different line definitions available. 

To create multiple line layouts for a line, select the line definition that you would like to edit.  If you have defined a layout 
for at least one line, you have the possibility of using the existing layout as a template for the new line layout. 

As described in Chapter  Define Column Contents, you can now define the columns, their contents and properties for the 
new layout. Using the button "Layout" you can define the complete appearance for the new line layout. You can define, 
for example, special frames. 
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 Editing the Line Definitions List 

The Line Definitions list can be edited using the button "Properties". 

You can assign names to the line definitions. This will make it easier for you to find the line in complex layouts. 

The order of the line definitions in the list can be changed using the arrow buttons or per drag & drop. Line definitions can 

be compromised, that means that empty line definitions will be moved to the bottom of the list, by using the  button. 

With the "Display" option you can hide single lines in the workspace. This is very useful when you have a lot of line 
definitions. The controls at the top of the dialog can be used to show/hide several highlighted lines in one step. By right-
clicking the button, all the lines can be shown or hidden. 
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Define Column Contents 

 

 Define Column Contents 
Table lines are column oriented, that means every line definition can contain many columns and every column can be 
separately edited and formatted. 

Every column also has a definite type. The column types that are available are: Text, Drawing, Barcode, RTF-Text, Chart, 
HTML-Text and OLE Container. 

Every column of a table object is represented by a line in the list. Multiple expressions or variables can appear within a 
column. 

 

With the buttons you can: 

▪     start up the field selection assistant 

▪     insert a text column 

▪     insert a column of a certain type, the  button opens an appropriate menu 

▪     edit the selected column(s) 

▪     delete the selected column(s) 

▪     copy the selected columns to the clipboard and then delete them 

▪     copy the selected columns to the clipboard 

▪     insert columns from the clipboard 

▪     move the selected columns to the left 

▪     move the selected columns to the right 

Editing of the column is done in the familiar Formula Editor, in which expressions can be defined as column contents, see 
Chapter  Variables, Formulas and Expressions for more information". 

 
See also: 

The Field Selection Assistant 
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The Field Selection Assistant 
The field selection assistant makes it easier to add new columns. With table objects, the assistant is able to: 

▪     add several columns in a single step. 

▪     assemble the columns using the available fields. 
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 Format Lines 

 With this button you can define the appearance of the current table line. 

You can set the font preference for the complete line using the Select button. Newly inserted columns appear at the 
beginning in this font. Using the appropriate option in the Column Properties, you can select a different font for each 
column. 

In the category "Print Margins", the margins that the table line should have within the table object can be set. 

The margins "Top" and "Bottom" define the space between the individual lines of the table. A bottom margin of 3.0mm 
sets a space of 3mm between a line of the selected type and the following lines. When a top margin for the lines is 
additionally defined, the space between the lines will be resized appropriately. Each data line will be printed with the frame 
line settings in category "Frame". 

With the margins "Left" and "Right", margins relative to the table object or to other table lines can be set. If you have, 
for example, defined a left margin of 10.0 for the header lines and a margin of 20.0 for the data lines, the data lines will be 
indented 10mm in relation to the header line. 
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 Appearance Conditions for Table Lines 

 Appearance conditions for the table lines can be assigned using the button "Appearance Cond." 
Using this button opens the familiar dialog for the definition of logical expressions (see Chapter  Variables, Formulas and 
Expressions). 

These appearance conditions are valid in addition to the project specific appearance conditions assigned defined with 
Project > Filter. 

Appearance conditions for table lines are especially meaningful when you define more than one layout for a table line. 
You can use appearance conditions to change between the various layouts. 

If each table line is to be displayed with a single line layout, ensure that the various appearance conditions assigned to the 
individual lines cancel each other out. Otherwise the same record will appear repeatedly in the table, which means once 
for every line layout that fits the appearance conditions. Sometimes this may be desired, especially when the fields of a 
table are to be displayed over multiple lines. 
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 Column Properties 

The properties of a column are defined using a Property List, which is similar to the tool window "Properties". The 
Property List may be different from column to column, depending on the type of column. 

If more than one column is selected, the common properties can be edited all at once. Properties that are not common to 
all marked columns are not available for editing. 

The column properties correspond to, with some table related restrictions, the properties of the appropriate object type. 

Columns of the type "Text" and "RTF-Text" possess a special characteristic. These text variants can be, also using a 
column property, intertwined. Dependent upon this property, the property list is changed appropriately. 

Property Description Value Description 

Text-Format Defines the text column (normal text or RTF 
text). 

True 

False 

Normal text 

RTF Text 

In addition to the object properties, several properties are available for columns: 

Property Description Value Description 

Link URL Link target (only effective for preview, PDF and 
HTML export. 

Link 

Formula 

  

Formula dialog 

Vertical 
Alignment 

With this option you define the vertical 
alignment of the selected column. 

0 

1 

2 

Formula 

Top 

Centered 

Bottom 

Formula dialog 

Alignment 

(Text) 

With this option, you define the text alignment. 
"Decimal" signifies that number values will be 
aligned at the decimal point. 

0 

1 

2 

3 

Formula 

Left 

Centered 

Right 

Decimal 

Formula dialog 

  Decimal-
position 

The position of the decimal point 
with the field, measured from the 
left corner of the preceding frame.

Number 

Formula 

  

Formula dialog 

Width Width of the selected column. If the sum of the 
column widths exceeds the width of the table, 
you will receive an error notice. The width of a 
field or column can also be changed in the 
workspace using the mouse by selecting the 
table object and moving the right border. The 
property list is recommended for precise 
resizing. 

Number 

Formula 

  

Formula dialog 

Bar color (only 
with barcodes) 

With this option, you define the color of 
barcodes. See Chapter   

    

Bar Width (only 
with barcodes) 

The narrowest bar width in SCM units (1/1000 
mm). 0=automatic adjustment. Not supported 

Formula Formula dialog 
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by all barcode types. 

  Orientation 
(only with 
barcodes) 

Orientation of the barcode 
within the object frame. 

0 

1 

2 

Formula 

left 

centered 

right 

Formula dialog 

Bar Width Ratio 
(only with 
barcodes) 

The ratio between the bars or spaces. Not 
supported by all barcode types. 

Formula Formula dialog 

Show Text (only 
with barcodes) 

Define whether the contents of the barcode 
should also be displayed as clear text. 

True 

False 

Formula 

Yes 

No 

Formula dialog 

Rotation Rotates the object counter-clockwise. E.g. turn 
column titles by 90º 

0 

1 

2 

3 

Formula 

0º 

90º 

180º 

270º 

Formula dialog 

Fit Determines the behavior when the content is 
too long for the line. 

0 

1 

2 

3 

Formula 

Truncate 

Wrap 

Shrink 

Compress 

Formula dialog 

Format The format editor is available in text object 
paragraphs and in table columns and is an 
alternative to formatting with the functions 
Date$() and FStr$() in the formula dialog. 
Using the format editor, you can set the format 
for numbers, currency, dates, times, 
percentages and angles. By default, the 
computer's system settings are used. 

Note that the format settings affect the entire 
expression. If you only wish to format certain 
sections of the expression (e.g. some text and 
numbers within the expression) use the 
functions Date$() and FStr$() in the formula 
dialog. 

True 

False 

Dialog 

Background The background color for the column can be 
defined. 

See Chapter  Common Object Properties. 

    

Height (not for 
Text, RTF Text) 

Height of the selected column in mm. The 
actual height of a table line is the height of the 
tallest column. 

Number 

  

Formula 

  

  

Formula dialog 
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Options 

(for Chart, 
HTML, OLE) 

Opens the contents dialog for the appropriate 
object type.  Opens dialog 

Frame This sets the frame properties and the spacing 
between the frame and the individual cells of a 
table. Along with the font size, the cell edges 
"top" and "bottom" affect the height of the table 
row in text objects. Further information 
regarding the frame dialog can be found in 
 Frame. 

 

  

  

  

Opens dialog 

  

  

Appearance 
Condition, Font 

See Chapter  Common Object Properties.     
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 Defining Footer Lines 
It is often desirable to print footers along with your table. These are considered to be normal table lines with the exception 
that footers always appear at the end of the table on each page. If you want the footers to be printed on the last page 
only, assign the appearance condition LastPage(). Additional information about this function can be found in Chapter  List 
of Available Functions. 
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Defining Group Lines 

 

 Defining Group Lines 
The group lines are another special line type. Their purpose is to combine the data lines to be printed into groups. An 
example would be an alphabetical directory in which letters are used as intermediate headers. The data lines would be 
grouped and printed according to the first letter of the name. 

 Conditions are also important here. Any string, for example "Left$(NAME,1)", can be used as a 
condition. Every time that the result of the expression changes from line to line, the result will be used as an intermediate 
header. 

The assigned column definition for the group line could be: "Letter: «Left$(NAME,1)»" or "Letter: "+Left$(NAME), 
depending on which modus you are in. The syntax assistant will automatically display the proper syntax. For every new 
beginning letter in the NAME, the text "Letter: " followed by the letter will be printed. 

More than one line layout is also possible. Hierarchically indented intermediate headers can be created. You can define a 
line layout, like in the above example, which will generate an intermediate header using the first letter of the variable 
NAME. Additionally, you can define a second line layout which generates an intermediate header using the first two 
characters of the variable NAME. The expression for this would be "Left$(NAME,2)", a suitable column definition would be 
"Letters: «Left$(NAME,2)»". For this second layout, special margins can be set using the button "Layout", for example 
"left" = 10.0 mm. The result could look like: 

..... 

Letter: A 

Letters: AA 

... 

data line 

... 

Letters: AB 

... 

data line 

... 

... 

Letter: B 

Letters: BA 

... 

data line 

... 

Letters: BB 

... 

data line 

... 
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See also: 

Appearance Condition 

Options for Group Header Lines 
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Appearance Condition 

 It is also possible to use appearance conditions for group header lines. Further information can be 
found in the section "Appearance Conditions for Table Lines" in this chapter. 
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Options for Group Header Lines 

By clicking on the button  you open the options dialog for group headers: 

Select the Sum Variable(s) that should be returned by the group header line. This setting is useful to create group sums, 
for example to add the price of all items of a certain item group. 

Hint: We recommend to use the function Sum() for the accumulation. Further information finds you under the description 
of function "Sum ()" in Chapter  List of Available Functions. 

 

Additional options of the group header are defined in a property list: 

Property Description Value Description 

Repeat as 
Header 

Prints the group header again after a page 
break. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Pagewrap 
Before 

Before a group header is printed, a page 
break is triggered. This means every group 
begins on a new page. When several group 
lines are printed with this option on at the 
same time, they will appear underneath 
each other on the new page. In the formula 
dialog you can set specific circumstances 
that trigger a page break before group 
headers, e.g. "Page break before there is 
only 5% space left". 

Further information can be found in the 
appendix under the description of the 
function "RemainingTableSpace". 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 
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 Define Group Footers 
A further special line type is the group footer. In principle, it works in exactly the same way as the group header, but 
appears only after the conditions have changed. 

Property Description Value Description 

Pagewrap 
After 

After a group footer is printed, a page 
break is triggered. This means the next 
group begins on a new page. When 
several group lines are printed with this 
option on at the same time, they will 
appear underneath each other on the "old" 
page. In the formula dialog you can set 
specific circumstances that trigger a page 
break after group footers, e.g. "Page break 
when there is only 5% space left". 

Further information can be found in the 
appendix under the description of the 
function "RemainingTableSpace". 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 
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Inserting Formatted Text 

 

 Inserting Formatted Text 

 With the formatted text object you can, in contrast to normal text objects, change the format within a line. In addition 
you can also use variables in these objects. To create a formatted text object, select Objects > Insert > 
Formatted Text (CTRL+F). 

When should you use the formatted text object and when the text object? Normal text objects should be given preference 
for every day jobs, since they contain less information and they are, therefore, printed faster. Consequently you should 
use a formatted text object in case you either can not realize a special format type with the normal text object or succeed 
only with great effort. 

 
See also: 

Properties 

Text Contents 
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 Properties 

Property Description Value Description 

(Contents) Opens the Contents  Opens dialog 

Rotation Rotates the object counter clockwise. This 
function is only available on Windows NT 
based systems (Windows NT, Windows 2000, 
and Windows XP). 

0 

1 

2 

3 

Formula 

0° 

90° 

180° 

270° 

Formula 
dialog 

Page 
break 

Defines if the object can cause a page break, 
or (in the case of an RTF object) enable 
another object to print the text exceeding the 
object's size. 

With labels, the next label will be started only 
when all objects with this option have been 
printed on the previous label. This option may 
not be available if page break ping is not 
supported by your application. The option is 
activated by default. If you wish to print an 
object on every page of a list project, this 
option must be deactivated or the object will 
otherwise only be printed once per project. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 
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Text Contents 

 

 Text Contents 
The contents of formatted text objects can be edited in the Formatted Text Editor. 

As a source, you may either select an RTF-Variable or "(Free Text)". If you select the latter, an input box and formatting 
aids are displayed in the dialog, which are explained below. Simply select the text to be formatted and select the 
respective format tool: 

▪     Select the font, size, color and character set with the combo-boxes. 

▪     Select Left justified, centered, right justified, block and text background color, Indent paragraph (2.5 mm, right Mouse 
click: indent following lines), Unindent paragraph (2.5 mm, right Mouse click: unindent following lines), Set line and 
paragraph spacing, Enumeration, Insert from clipboard, Undo action, Repeat action 

▪     By clicking the button "Formula" you have access to the Formula Wizard. An important function of the Formula 
Wizard is ToRTF, which you can use to convert variables into RTF-text. 

 

▪     The RTF-Object also supports so called "Embedded Objects", objects that are embedded into the text, for 
example graphics. These objects can be inserted using the clipboard from, for example, MSPaint. 
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▪     What you see is what you get: Word wrapping according to object size. This is only an approximate 
display and minimal differences may occur. 

▪     Tab: CTRL+TAB 

▪     A context menu is available in the editor, by which you can open various formatting possibilities for characters and 
paragraphs. 

  

 
See also: 

Exceeding Text Transfer 
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Exceeding Text Transfer 
If the current RTF-object is linked to another RTF-object in which the option page break is activated, the option "exceeding 
text of ..." is available as data source. If this option is set, input is blocked within the RTF-object since the (rest) text is 
automatically integrated from the other RTF-object. 
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Inserting Chart Objects 

 

 Inserting Chart Objects 

 By selecting Objects > Insert > Chart or clicking the respective icon you can insert a chart object. This object 
is used for analyzing and displaying different types of data. You can visualize the range of sales for example, the 
percentage of different sources or of course "simple" bar charts. A large number of different chart types are available and 
can be used for diverse applications. Most chart types have different sub types. 

In general, three and two axis charts are differed. Three axis charts have three data axes and can be used to visualize the 
sales range per month and employee, for example. A two axis chart has only two data axes and shows e.g. the sales 
range of the whole company over a number of months. 

 
See also: 

Properties 

Selecting the Chart Type 

Selecting the Sub Type 

Chart Properties 

Examples 
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 Properties 

Property Description Value Description 

(Content) Opens the contents dialog  Opens dialog 
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 Selecting the Chart Type 
Double click a chart object to reach to the property dialog. 

 

Select the chart type from the list on the left hand side. The following types are available: 

 

Pie Chart: a typical pie chart. 

  

 

Cylinder/Bar/Pyramid: various types of bar 
charts that differ mainly in the form of the 
bars. 
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Ribbon:  a three dimensional ribbon chart. 

 

Line/Symbols/Line & Symbols: two 
dimensional charts. 
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Selecting the Sub Type 

 

 Selecting the Sub Type 
Depending on the chart type selected, up to eight different sub types may be available. 

 
See also: 

Sub types for cylinder, bar and pyramid charts: 

Sub types for line and symbol charts 
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Sub types for cylinder, bar and pyramid charts: 

 

Multi row: A "normal" 3D chart, showing the 
sales per month and per employee, for 
example 

 

Simple 3D/Simple: Only two axes are 
available, showing the total amount of sales 
per month for example. The simple type is 
without the 3D effect. 

 

Clustered 3D/Clustered: Values on the x axis 
are grouped allowing a direct comparison of 
values. The clustered type is without the 3D 
effect. 

 

Stacked 3D/Stacked: This chart type is 
designed to show the share of each 
contribution, e.g. the share of sales each 
employee contributes to the total. This type is 
not available for pyramid charts. The stacked 
type is without the 3D effect. 
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100% Stacked 3D/100% Stacked: Similar to 
the stacked chart, single contributions can be 
visualized with this chart. This chart type, 
however, shows percentile values. The value 
of a month's sales always equals 100% and 
the percentage of contribution for each 
employee can be extracted from the diagram. 
This type is not available for pyramid charts. 
The stacked type is without the 3D effect. 
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Sub types for line and symbol charts 

 

Simple/Multiple: The values are entered as 
dots in a coordinate system. Depending on 
the type, the dots are connected by lines. A 
multiple diagram contains more than one line. 

  

 

Stacked: This chart type is designed to show 
the share of each contribution, e.g. the share 
of sales each employee contributes to the 
total. 

 

100% Stacked: Similar to the stacked chart, 
single contributions can be visualized with 
this chart. This chart type, however, shows 
percentile values. The value of a month's 
sales is always 100% and the percentage of 
contribution for each employee can be 
extracted from the diagram. 
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Chart Properties 

 

 Chart Properties 
The chart object provides a variety of options. Depending on the chart type, there are two or three data axes. Using the 
cards you can switch from one axis to another. You have the following options: 

 
See also: 

Pie charts 

Options for the data source (Pie charts) 

Options for the chart object 

Colors for the chart object 
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Pie charts 
Pie charts have a special position; there are no actual "axes" but segments. Thus, the configuration differs from that of the 
other chart types. 
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Options for the data source (Pie charts) 

 

Options for the data source (Pie charts) 

 

Data source Select the data source for the segments, e.g. "Name" for people, "Month" 
for date values, and so on. 

Filter 
condition 

If you like you can define a filter condition. Only the records matching the 
condition will be used for the chart data (e.g. Left$(Name,1) = 'A'). 

Legend Select the position of the legend. If you select "at chart" the values are 
given directly at the segments. 

Segment 
labels 

Select the text which should be used to label the legend. Some 
preconfigured values are available, e.g. "Value and Percentage without 
decimals". Alternatively you may enter your own formula, select 
"Formula..." from the list in order to do so. By clicking on the button 
"formula" you may also enter a formula. 

The  allows you to set the font for the labels. A left click opens a font 
dialog; a right click resets the font to the default object font. 

Color data 
row 

The segments are colored with different colors in order to make the 
diagram easier to read. 

Number of 
sample rows 
for the 
Designer 

The Designer has no access to the "real" data which will appear in your 
chart when printing. In order to have a picture of how your chart is going to 
look like, you can set the number of segments to appear in the Designer 
here. 
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Options for the type of calculation (Pie charts) 

 

Calculation 
mode for 
equal values 

Specifies the handling of equal source values. An example: you want to 
have the sum of sales to your customers. In this case, select "sum of 
values". If you're interested in the average price of sales to a customer, 
select "mean value". If only the number of sales to a customer is of 
interest, select "number of values". As the actual value is not of interest in 
this case, the source field will be deactivated. 

Source for 
segment 
size 

Select the data source for the segment size, e.g. "Value", "Price" etc. 

Minimum 
share 

Especially when you have numerous values that make up small 
contributions it may be desirable to summarize these in a common 
segment. Select the maximum value up to which the segments will be 
summarized. 

Summarize 
lower values 
as 

Defines the label for the summarized segment. If you do not enter your 
own formula, the label will be adapted to the "normal" segment label 
layout on the data source card. 
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Options for category and series axis (except pie charts) 

If you chose to have a three axis chart, both axes are available (as x and y-axis). Only the category axis is needed (as x 
axis) for two axis charts. You have the same options for both axes: 

 

Data source Select the data source for the row, e.g. "Name" for people, "Month" for date 
values, and so on. 

Filter 
condition 

If you like you can define a filter condition. Only the records matching the 
condition will be used for the chart data (e.g. Left$(Name,1) = 'A'). 

Legend Select the position of the legend. If you Select "at chart" the values are 
given directly at the axis. Otherwise, a legend will be added on the left, 
right, bottom or top of the chart. 

Data labels Select the text which should be used to label the legend. Some 
preconfigured values are available, e.g. "Value of source". This setting will 
display the source value on the axis, i.e. the name of a customer, the 
month,... 

 Alternatively you may enter your own formula. Select "Formula..." from the 
list in order to do so. By clicking on the button "formula" you may also enter 
a formula. The  button "font" allows you to set the font for the labels. A left 
click opens a file selection dialog; a right click resets the font to the default 
object font. 

Axis label Select a text for your axis label here. By clicking on the button "formula" 
you may also enter a formula. The  button "font" allows you to set the font 
for the labels. A left click opens a file selection dialog; a right click resets 
the font to the default object font. 

Color data 
row 

This attribute may only be selected for either the series or the category 
axis. The selected data row will then be colored in altering colors. 

Number of 
sample rows 
for the 

The designer has no access to the "real" data which will appear in your 
chart when printing. In order to have a picture of how your chart is going to 
look like, you can set the number of values to appear in the designer here. 
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designer 
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Options for the value axis (except pie charts) 

 

Calculation 
mode for 
equal 
coordinates 

Specifies the handling of equal source coordinates. An example: you want 
to sum the sales to customer Smith in January. In this case, select "sum of 
values". If you're interested in the average price of your sales to this 
customer, select "mean value". If only the number of sales to the customer 
is of interest, select "number of values". As the actual value is not of 
interest in this case, the source field will be deactivated. 

Data source Select the data source for the value axis, e.g. "Value", "Price" etc. 

Range You can limit the shown data range in order to e.g. regard huge 
divergences within the values. If your values have high peaks, you can cut 
them off by setting a max limit. If you leave the default setting "automatic" 
the chart will display all values. 

Legend, 
Coordinate 
labels, Axis 
label 

These options are the same as for the series and category axis. The 
legend can only be displayed at the chart or not at all, however. 
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Options for the chart object 
On the options card you may set different layout options for the chart object. 

 

Title Select a title for your diagram. This title will be displayed above your chart. 
By clicking on  the formula-button you may also enter a formula. The font-
button allows you to set the font for the labels. A left click opens a font 
dialog; a right click resets the font to the default object font. 

Width Sets - depending on the chart type - the bar width, the line width or the 
width of the segments. 

Perspective Select the level of perspective for your object here. 

Angle of 
inclination, 
Angle of 
rotation 

Sets the rotation of the diagram. You may also set these angles using the 
rotation buttons which appear when the chart is selected on the 
workspace. 
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Colors for the chart object 
On the colors card you can set the colors for your chart. 

 

Background Select the color for the "back wall" of the chart. Alternatively the wall may 
also be transparent. To select a color, select it from the upper combo box. 
The "..." entry brings up a standard color selection dialog. 

Color map Select the colors and the order of colors for the chart. For a bar chart, this 
is the color of the bars, for a pie chart the segment color. To select a color, 
select it from the upper combo box. The "..." entry brings up a standard 
color selection dialog. 
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Examples 

 

 Examples 
Chart options depend on the available data. Thus, the following examples are kept general. An application may give you 
the fields "Name", "Month" and "Sales", denoting the name of your customer, the month in which a transaction took place 
and the total transaction volume. 

 
See also: 

Multi row bar chart 

Pie chart 

100% stacked bar chart 
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Multi row bar chart 

 

Multi row bar chart 

This would be the simplest way to analyze your data; you'd have a diagram showing the total transaction volume for each 
month and customer: 
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...this is how it's done: 

Insert a new chart object; select "Bar" as type and "Multi row" as sub type. Select "Month" as the data source for the 
category axis and "Customer" as the data source for the series axis. For the value axis, select "Sales". Edit the axis labels 
and title as required - you're finished. 
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Pie chart 

 

Pie chart 

If you're interested in the share each customer contributes to the total sales over a number of months, you'd select a pie 
chart. This chart directly displays the shares: 
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...this is how it's done: 

Insert a new chart object, select "Pie" as type and sub type. Select "Customer" as the data source and "Sales" as the data 
source for the segment size. Edit the axis labels and title as required - you're finished. 
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100% stacked bar chart 

 

100% stacked bar chart 

The pie chart in the last example shows the share over a number of months. However, to quickly take a look at the shares 
for each month and extract trend lines, it would be interesting to see the change in the shares over a number of months. 
The 100% stacked bar chart is perfect for this. 
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...this is how it's done: 

Insert a new chart object; select "Bar" as type and "100% stacked" as sub type. Select "Month" as the data source for the 
category axis and "Customer" as the data source for the series axis. For the value axis, select "Sales". Edit the axis labels 
and title as required - the procedure is exactly the same as for the multi-row bar chart. This is why you can simply switch 
between the two sub types without having to reconfigure your data sources. 
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Inserting a Crosstab 

 

Inserting a Crosstab 

 You have two ways to insert a Crosstab: 

a) In multi-tables you can insert a crosstab object through the report structure tool window (see chapter  Report Structure). 

b) Through Objects > Insert > Crosstab (Pivot Table). 

This object is used to analyze and display different kinds of data in several dimensions. You can use it, for example, to 
investigate the changes in turnover per year and region and analyze sales by unit and customer, then show the totals by 
quarter and year. There are numerous layout options available to you. 

Example 1: Customer sales per sales period and employee 

 

Example 2: Turnover per sales period and country 

 

 
See also: 

Properties 

Axis definition (Grouping) 

Cell definition (Contents) 
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Layout Options and Page Break Behavior 

Crosstab Creation Wizard 

Crosstab Functions 
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 Properties 
Please note: As long as the tool window "Report Structure" is available, other properties are applicable (see P.140). 

Property Description Value Description 

(Contents) Opens the  "Contents"-dialog 
 

Opens 
dialog 

Background Background of the object. See chapter 
 Common Object Properties. 

    

Frame Frame properties and clearances of the 
object frame. See chapter  Common Object 
Properties. 

    

Frame 
defaults, 
minimum 
size, 
columns, 
rows, link, 
PDF index 
text 

Frame default settings for sub-objects. See 
chapter  Layout Options and Page Break 
Behavior. 

    

Display 
properties, 
position, 
page break 
before 

See chapter  Common Object Properties.     
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 Axis definition (Grouping) 
In the "Axis Definition" tab, you can set the groupings for the rows and columns. For example, to create a statistics about 
the turnover by year and country, select "Country" as the group for the rows and "Year" as the group for the columns. For 
the contents of the result cells, select the sum over the turnover. 

 

▪     With the "New" button, you can add a group for rows or columns. 

▪     With the "Properties" button you can edit the selected group. 

▪     With the button "Delete" you can delete the selected group. 

▪     You can add as many groups (layers) as you need, e.g. a group "Year" and another group "Quarter". With the arrow 
buttons, the order can be changed. The lowest row or column is the innermost group. 

▪     In the field "Value of the result cells" the cell contents are defined. Here you can select with the button "Edit group 
result formula" in the dialog "Cell contents" an aggregate function for the content, e.g. sum or quantity. This is the formula 
that is set into the "value" property of each content cell. In the lower part of the dialog "Cell contents", the selected result 
function is displayed. 
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 Cell definition (Contents) 
In the "Cell Definition" tab, the properties of the different cells can be edited. 

 

You can select the cells directly in the sketch in the top part of the dialog and can then edit their properties. To select 
more than one cell, hold the CTRL key and selector drag a frame around the cells with the cursor. 

  

Property Description Value Description 

Value Formula for the cell value. This is evaluated 
by the Crosstab.Cells... functions. 

Formula Formula 
dialog 

Displayed 
contents 

Text to be displayed in the cell, so it can be 
different from the property "Value". 

Formula Formula 
dialog 

Link Link that is opened when clicked (only in 
preview, PDF and HTML export). 

Link Link 

Formula 
dialog 

Rotation Rotates the object anti-clockwise. With this 
function you can, for example, turn column 
titles by 90°. 

  

0 

1 

2 

3 

Formula 

0° 

90° 

180° 

270° 

Formula 
dialog 

Background, 
font, format, 
frame 

See chapter  Common Object Properties.     
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Vertical 
alignment 

Vertical alignment of the contents in the 
available space. 

0 

1 

2 

Formula 

top 

centre 

bottom 

Formula 
dialog 

Alignment 

(with Text) 

The text alignment. Decimal means numbers 
are aligned by their decimal points. 

0 

1 

2 

3 

Formula 

Left 

Centre 

Right 

Decimal 

Formula 
dialog 

  Decimal 
position 

Position of the decimal 
point (only applicable in 
decimal alignment, 
negative means from the 
right). 

Number 

Formula 

  

Formula 
dialog 

Minimum width Sets the minimum width of the cell. Number 

Formula 

  

Formula 
dialog 

Minimum 
height 

Sets the minimum height of the cell. Number 

Formula 

  

Formula 
dialog 
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 Layout Options and Page Break Behavior 
Edit the properties of the crosstab here, e.g. layout and page break behavior. 

 

  

PDF index 
text 

Text for the PDF index. 

Link Link that is opened when clicked (only in preview, PDF and HTML export). 

  

Background, 
Default 
Frame 

See chapter  Common Object Properties. 

Minimum size Sets by how much the crosstab can be shrunk in order to avoid a 
horizontal page break.  50=that it can be shrunk up to 50% to avoid a 
page break; 100=retain original size. 

Minimum 
height 

Sets how much height should be available to an object. If less space is 
available, a page break is triggered. 

Columns Repeat headings Sets whether the column headers are 
repeated after a page break. 

  Page break layer Sets the ideal page break layer. 0=innermost 
group, i.e. the lowest row in the "Columns" 
field of the "Axis definition" tab. 

    force Forces page break after every corresponding 
group. 

Rows Repeat headings Sets whether the row headings are repeated 
after a page break. 
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  Page break layer Sets the ideal page break layer. 0=innermost 
group, i.e. the lowest row in the "Rows" field 
of the "Axis definition" tab. 

    force Forces page break after every corresponding 
group. 
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 Crosstab Creation Wizard 
When you are creating a new crosstab, a wizard is available to you to guide you through the three tabs. 

 

▪     In the first, you set the groups for the rows. For example, to make a statistic about the turnover per year and country, 
select "Year" as the group for the rows and "Country" as the group for the columns. For the contents of the result cells, 
select the sum over the turnover. 

▪     With the "Next" button, you come to the "Cell Definition" dialog. The properties of the different cells are edited here. 
You can select the cells directly in the upper area of the dialog and can then edit their properties. To select several cells, 
hold the Ctrl key or drag a frame around the cells with the cursor. 

▪     With the "Next" button, you come to the dialog for editing the properties of the crosstab, e.g. the layout and page 
break behavior. 
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 Crosstab Functions 
There are several crosstab functions to access to the values of each data record. 

▪     Crosstab.Cells.Avg() returns the average of the cell contents. Only available in crosstab objects. 

▪     Crosstab.Cells.Max() returns the largest value of the cell contents. Only available in crosstab objects. 

▪     Crosstab.Cells.Min() returns the smallest value of the cell contents. Only available in crosstab objects. 

▪     Crosstab.Col$() returns the column header for the cell currently being output. Only available in crosstab objects. 

▪     Crosstab.Col() returns the column index for the cell currently being output. Only available in crosstab objects. 

▪     Crosstab.Row$() returns the row header for the cell currently being output. Only available in crosstab objects. 

▪     Crosstab.Row() returns the row index for the cell currently being output. Only available in crosstab objects. 

▪     Total() can be used for computations over all cells away. Otherwise calculations always run over all values, which 
concern the respective cell 

Additional information about this function can be found in Chapter  List of Available Functions. 
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Inserting Form Controls 

 To use your project for form output and input, different form controls are available with the form control object. To 
insert a form control object into your project, select Objects > Insert > Form Control. 

Form controls can directly be filled by the user in the InLoox preview and HTML or generate actions as e.g. sending an 
email. 

The following determines the basic behavior of the element: 

  

Property Description Value Description 

Type Determines element type. 0 

1 

2 

3 

Edit 

Checkbox 

combo box 

Button 

Corresponding to the type the properties of the control are changing. 

In the following Chapter the different properties of the form control are described according to the chosen type-property: 

 
See also: 

Type Edit 

Type Checkbox 

Type Combobox 

Type Button 
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Type Edit 

Property Description Value Description 

Force Input Determines whether input has to be entered 
by the user. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Field Name Determines the field name of a possibly data 
export via XML/XFDF. 

Name   

Validation 
Expression 

  

Regular expression to validate input.     

Error 
Message 

Message that is given if validation fails     

Value Default value for input object.     

Tooltip Tooltip which should appear     

Multiline Determines whether the input field is 
multilined or not. When multiline is not 
chosen, more characters can be entered and 
the input field scrolls automatically. But when 
printed these characters are cut off. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 
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 Type Checkbox 

Property Description Value Description 

Force Input Determines whether input has to be entered 
by the user. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Field Name Determines the field name of a possibly data 
export via XML/XFDF. 

Name   

Value Default value for input object.     

Tooltip Tooltip which should appear     
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 Type Combobox 

Property Description Value Description 

Force Input Determines whether input has to be entered 
by the user. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Items Available default values of the  combobox List List of default 
values 

Field Name Determines the field name of a possibly data 
export via XML/XFDF. 

Name   

Validation 
Expression 

  

Regular expression to validate input (only 
with variable text) 

    

Error 
Message 

Message that is given if validation fails     

Editable Determines if the user can enter different 
values than the default values. 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

Value Default value for input object.     

Tooltip Tooltip which should appear     
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 Type Button 

Property Description Value Description 

Action Determines the possible performance. Only 
available with type Button. 

0: Send as email. The most relevant fields 
for sending an email can be preset. 

1: Save. By clicking the button, the preview 
file, respectively the entered data will be 
saved in the corresponding format. 

2: Sending via HTTPPost 

3: Defines a hyperlink area. The object is 
transparent and can therefore be displayed 
above other objects. 

0 

1 

2 

3 

Send as 
email. 

Save. 

Sending via 
HTTPPost 

Link 

Text Button text Formula Formula 
dialog 
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Inserting HTML formatted text 
 

 Inserting HTML formatted text 
To display HTML formatted text (e.g. web sites) within your projects, you can use the HTML text object. Please note that 
due to license restrictions GIF files can not be displayed. 

The object supports the HTML 3.2 specification. Partially supported are some extended tags as well as cascading style 
sheets. 

To insert a HTML text object use the toolbar or Objects > Insert > HTML-Text. 

The contents of the object are edited in the property list, where you have various options. 

 
See also: 

Properties 

HTML-Contents 
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Properties 

Property Description Value Description 

(Contents) Opens the "Properties" dialog  Opens 
dialog 
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 HTML-Contents 
You can define the contents of the object in the HTML-Object Properties dialog. 

 

▪     File - select this option to display the contents of a previously saved HTML file. The "Browse..." button opens a file 
selection dialog. The file must be located on a local storage medium or network. 

▪     URL - this option is used to display websites (e.g. www.combit.net). The contents are downloaded at runtime, thus 
you'll need a connection to the Internet. 

▪     Field/Variable - if your application makes HTML contents available, these can be selected here. Refer to your 
application's documentation for details.  

▪     Fit to Object: Select this option to fit the contents into the object. If the option is deactivated, the contents are fit to the 
object width and output may wrap over several pages. 

▪     Proxy: If your access is via a proxy server, you must enter its address in the settings group. By default, your current 
proxy configuration will be set. Leave this setting (without editing the configuration) in order to be able to distribute your 
projects to other systems with a different proxy configuration. The current configuration will always be taken in this mode. 
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 Inserting OLE-Server Documents 

 The OLE Container is available for the insertion of OLE-Server documents into your project. This gives you the 
capability to embed and print documents that were created with other applications, for example Word, Excel, Visio or 
MapPoint, into your project without changes. 

You can create an OLE-Object using Objects > Insert > OLE Container. After defining the size and position of the 
object on the workspace, the standard "Insert Object" dialog will open. You can select the object type and select either 
"Create New" or "Create from File". 

You can select, for example, an existing Excel file and insert it into the object frame. 

Note: Only the first Page of an embedded document can be displayed, as there is no standard for multi-page OLE-
Objects. 

 
See also: 

Properties 

Contents 
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Properties 

Property Description Value Description 

(Contents) Opens "Contents" dialog  Opens dialog 
or host 
application 
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 Contents 
If contents are available the host application will be opened, otherwise the standard "Insert Object" dialog will appear. 
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 Inserting Form Templates 
Form templates are drawings, e.g. scanned pictures, of actual forms that you can place in the background of your 
workspace to aid in the exact placement of objects. The templates are displayed on the workspace but will not be printed 
and cannot be edited. 

To insert a form template in the background of your workspace, use Objects > Insert > Form Templates. 

After creation, select the form template using the tool window Objects. The template can no longer be selected in the 
workspace. 

 
See also: 

Properties 
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Properties 

Property Description Value Description 

File name Select the file that contains the required form 
template. The same formats are supported as 
in graphic files. (See Chapter  Inserting 
Picture Objects). 

File 
name 

 

Open file 
dialog 

Fade color The selected color will be added to the 
template to fade the color. See Chapter 
 Colors 

    

Keep 
proportion
s 

Using the option "Keep Proportions" you can 
define whether the graphic should be inserted 
in the correct relationship between height and 
width (True), or if the graphic should be 
resized to occupy the complete object 
(False). 

True 

False 

Formula 

Yes 

No 

Formula 
dialog 

  

Tip: When using a template to create your own form or to fill out a form, size and position of the template are of critical 
importance. We recommend that the template be placed using the Property List, as this allows a more exact placement 
than the use of the mouse. 
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Appendix 

 

 Appendix 
 
See also: 

List of InLoox Variables 

List of Available Functions 

List of Available Barcodes 

List of ISO 3166 Country Codes 
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List of List & Label Variables 

 

 List of InLoox Variables 
InLoox automatically provides, dependent upon the application, several variables and fields (in list projects). These 
contain general information about the print project, printing etc. You can find the variables and fields in the LL subfolder in 
the variable list. 

 
See also: 

List of Variables 

List of Fields 
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 List of Variables 

Name Description 

LL.SortStrategy Selected sorting can be set, dependent upon the 
application in the Project Menu. 

LL.FilterExpression Selected project filter, can be set in Project-Menu. 

LL.OutputDevice Output device. Can be used to assign object specific 
formats for certain output formats ("HTML", "RTF", 
"PDF",.) 

LL.CountData 

(not for List and Multitab projects) 

Number of records transferred by the program so far 
during this printing process. This number also contains 
the records that were not printed due to filter 
conditions. This number will increase with every record. 

LL.CountDataThisPage 

(not for List and Multitab projects) 

Number of records transferred by the program so far 
during this printing process on the current page. This 
number also contains the records that were not printed 
due to filter conditions. This number will increase with 
every record. 

LL.CountPrintedData 

(not for List and Multitab projects) 

Number of the actually printed records. 

LL.CountPrintedDataThisPage 

(not for List and Multitab projects) 

Number of the actually printed records on the current 
page. 

LL.Device.Page.Size.cx Physical page width of the output device in project 
coordinates in SCM units (1/1000 mm). Can be used in 
formulas to fit objects to larger output formats. 

Example: Set the property Position.Left in the Property 
List to the value 0, the property Position.Right to 
LL.Device.Page.Size.cx. The object will occupy the 
total page width. 

LL.Device.Page.Size.cy Physical page height of the output device in SCM units 
(1/1000 mm). 

LL.Device.Page.Name Name of the output page type (example "A4"). 

LL.Device.PrintableArea.Size.cx Printable page width of the output device in SCM units 
(1/1000 mm). 

LL.Device.PrintableArea.Size.cy Printable page height of the output device in SCM units 
(1/1000 mm). 

LL.Device.PrintableArea.Offset.cx Width of the left non-printable border in project 
coordinates in SCM units (1/1000 mm). 

Example: In the Property List, set the property 
Position.Left to the value 
LL.Device.PrintableArea.Offset.cx. The object will 
always lie exactly on the left edge of the printable area 
of the printer. 

LL.Device.PrintableArea.Offset.cy Height of the top of the non-printable border in project 
coordinates in SCM units (1/1000 mm). 
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LL.Device.Name Name of the output device(printer). 
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 List of Fields 

Name Description 

LL.FcountData Number of transmitted records. This number also 
includes the records that were not printed due to filter 
conditions. 

LL.FcountDataThisPage Number of transmitted records on the current page. 
This number also includes the records that were not 
printed due to filter conditions. 

LL.FcountPrintedData Actual number of printed records. 

LL.FcountPrintedDataThisPage Actual number of printed records on the current page. 

Additionally, depending on 
project type 

  

LL.CurrentRelation Name of the current relation 

LL.CurrentSortOrder Order of the current table 

LL.CurrentTable Name of the current table 

LL.CurrentTablePath Indicates the current table hierarchy, e.g. 
Customers.Orders.Order_Details 
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List of Available Functions 

 

 List of Available Functions 

In the following table you will find all functions, listed alphabetically, available in InLoox. In the left column the function 
names, in the middle column the number and permitted value types of the arguments and in the right column, the 
value type of the return value. 

Function Arguments Return values 

Abs Number Number 

AddDays Date, Number Date 

AddHours Date, Number Date 

AddMinutes Date, Number Date 

AddMonths Date, Number Date 

AddSeconds Date, Number Date 

AddWeeks Date, Number Date 

AddYears Date, Number Date 

Alias$ String, String [,String] String 

Asc String Number 

AskString$ String, Boolean, String, Number String 

AskStringChoice$ String [,Boolean[,String[,Zahl]]] String 

Atrim$ String String 

Avg Number [,Boolean] Number 

Barcode String, String Barcode 

Barcode$ Barcode String 

BarcodeType$ Barcode String 

Case$ Number, String [,String] String 

CheckMod10 String Number 

Chr$ Number [,Number] String 

ChrSubst$ String, String [,String] String 

Cond Boolean, All, All All 

Contains String, String Boolean 

Continued - Boolean 

Count All [,Boolean] Number 

CountIf Boolean [,Boolean] Number 
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Crosstab.Cells.Avg [Boolean [,Number[,Number]]] Number 

Crosstab.Cells.Max [Boolean [,Number[,Number]]] Number 

Crosstab.Cells.Min [Boolean [,Number[,Number]]] Number 

Crosstab.Col$ [Number] String 

Crosstab.Col [Boolean] Number 

Crosstab.Row$ [Number] String 

Crosstab.Row [Boolean] Number 

Cstr$ Number, String String 

Date String Date 

Date$ Date, [String, [String]] String 

DateHMS Number, Number, Number Date 

DateInRange Date, Date, Date Boolean 

DateToJulian Date Number 

DateYMD Number, Number, Number Date 

Day Date Number 

Day$ Date String 

Distinct All All 

Dow$ Date String 

Dow Date Number 

Drawing String Drawing 

Drawing$ Drawing String 

Empty String Boolean 

Even Number Boolean 

Exp Number Number 

Exp10 Number Number 

FirstHeaderThisTable - Boolean 

Frac Number Number 

FStr$ Number, String String 

GeometricAvg Number [,Boolean] Number 

Hour [Boolean] Number 

HSL Number, Number, Number Number 

Hyperlink$ String, String, Boolean String 
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If Boolean, All [,All] All 

Int Number Number 

IsNULL All Boolean 

JulianToDate Number Date 

LastFooterThisTable - Boolean 

LastPage - Boolean 

Left$ String, Number [,Boolean] String 

Len String Number 

LoadFile$ String [,String] String 

Locale$ Number[,String] String 

LocCurr$ Number[,String] String 

LocCurrL$ Number[,String] String 

LocDate$ Date, [,String, [Number]] String 

LocDateTime String [,String] Date 

LocNumber$ Number[,String] String 

LocTime$ Date, [,String, [Number]] String 

Log Number Number 

Log10 Number Number 

Lower$ String String 

Ltrim$ String String 

Max Number | Date Number | Date 

Maximum Number [,Boolean] Number 

Median Number [,Boolean] Number 

Mid$ String, Number [,Number] String 

Min Number | Date Number | Date 

Minimum Number [,Boolean] Number 

Minute [Boolean] Number 

Month Date Number 

Month$ Date String 

Now - Date 

NthLargest Number, Number [,Boolean] Number 

NthLargestIndex Number, Number [,Boolean] Number 
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NthValue All, Number [,Boolean] All 

NULL - All 

NumInRange Number, Number, Number Boolean 

Odd Number Boolean 

Ord String Number 

Page - Number 

Page$ - String 

Pow Number, Number Number 

Previous All All 

ProjectPath$ [Boolean] String 

RainbowColor Number, Number, Number Number 

RegExMatch$ String, String, Number String 

RemainingTableSpace [Boolean] Number 

Rep$ String, Number String 

RGB Number, Number, Number Number 

Right$ String, Number [,Boolean] String 

Round Number, Number Number 

Rtrim$ String String 

Second [Boolean] Number 

Sqrt Number Number 

StdDeviation Number [,Boolean] Number 

Str$ Number | Date [,Number [,Number]] String 

StrPos String, String [,Number] Number 

StrRPos String, String [,Number] Number 

StrSubst$ String, String [,String] String 

Sum Number [,Boolean] Number 

Time$ String Number 

Today - Date 

Token$ String, Number, String [,String] String 

ToRTF$ String String 

TotalPages$ - String 

UnitFromSCM Number Number 
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Upper$ String String 

Val String Number 

Variance Number [,Boolean] Number 

Woy Date, [Number] Number 

Year Date Number 

Year$ Date String 
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Abs 

Purpose: 

Calculate the absolute value of a number. A negative value will be returned as positive and a positive value will remain 
unchanged. 

Parameter: 

Number 

Return value: 

Number 

Example: 

Abs(-3)    = 3 
Abs(3.12) = 3.12 
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AddDays 

Purpose: 

Adds the given number of days to the date, or subtracts the number of days when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddHours 

Purpose: 

Adds the given number of hours to the date, or subtracts the number of hours when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddMinutes 

Purpose: 

Adds the given number of minutes to the date, or subtracts the number of minutes when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddMonths 

Purpose: 

Adds the given number of months to the date, or subtracts the number of months when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddSeconds 

Purpose: 

Adds the given number of seconds to the date, or subtracts the number of seconds when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddWeeks 

Purpose: 

Adds the given number of weeks to the date, or subtracts the number of weeks when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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AddYears 

Purpose: 

Adds the given number of years to the date, or subtracts the number of years when a negative value is entered. 

Parameter: 

Date 

Number 

Return value: 

Date 
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Alias$ 

Purpose: 

Returns the value that is specified for the key (first parameter) in the key/value-pairs (second parameter). 

Parameter: 

String Expression for the value to be searched 

String List of values 

 (Form: <key=value>| [<key=value>]. To be able to use "|" or "=" in the value or key, place a "\" infront of it. 

String (optional) Default if the value cannot be found. 

Return value: 

String 

Example: 

Alias$("DEU", "DEU=Deutschland|USA=United States of America|GB=United Kingdom")  Result: Deutschland 
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Asc 

Purpose: 

Returns the ASCII-Code of the first character of the string. 

Parameter: 

String 

Return value: 

Number 

Example: 

Asc("A")   Result: 65 
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AskString$ 

Purpose: 

With this function, information can be requested from the user during printing. A typical example of use for this function 
would be in a project for a bank transfer form. Information that remains constant, such as name and bank details of the 
sender, can be integrated directly into the project as fixed text or variables. The transfer amount, however, will almost 
always be different. With the function AskString$(), this information can be requested from the user during printing. 

At print time, a dialog will appear in which the needed information can be entered. 

The dialog allows the entered value to be carried over. Abort with "Cancel". 

With the button "All", the entered value will be automatically used for all future result for the AskString$ function during 
thus print job. This is useful when the value remains constant over all records. 

Parameter: 

String The first parameter contains some descriptive text that will appear in the dialog. Since this is a formula, 
fixed text must be entered in quotation marks, for example "Transfer amount:". This first parameter must be 
entered, all remaining parameters are optional. If no other parameter(s) is/are entered, the first string is also 
the default setting for the user input. 

Boolean (optional) 
The second parameter allows you to define whether the dialog should be shown once prior to printing (default, FALSE), or 
if the dialog should be shown for each record (TRUE). 

String(optional) 
The third parameter contains the string that appears as the recommended value for the user input. Since 
this is a formula, fixed text must be entered in quotation marks, for example "50.00 USD". 

Number(optional) 
The last parameter defines the number of characters that can be entered by the user. A value of 16, for 
example, allows the user to enter a maximum of 16 characters. 

Return value: 

String 

Example: 

AskString$("Transfer amount",True,"50.00 USD",16) 

Opens a dialog with the title "Transfer amount", a recommended value of "50.00 USD" and a maximum of 16 characters. 
Since the second parameter is TRUE, the dialog will be shown for each record to be printed. 
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ATrim$ 

Purpose: 

Removes spaces from the beginning and end of a string. 

Parameter: 

String 

Return value: 

String 

Example: 

Assume that you have an address database which contains, among others, the field COMPANY in which a company's 
name has been entered. You want to print a label that contains the company name. So as not to waste space or 
unintentional word wrap, any spaces before or after the company name should not be printed. 

The function ATrim$(COMPANY)removes all spaces that appear in the field COMPANY before or after the company's 
name. 

From "   combit GmbH        ", the return value would be "combit GmbH". 
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Avg 

Purpose: 

Generates the mean of the set of values that is produced by the first argument. 

Parameter: 

Number                        Expression of the value to be calculated 
Boolean (optional)       TRUE: After the output, the values which were stored for the calculation are deleted. 
(default: TRUE). 

Please note that the stored calculation values are generally deleted for every (sub)table end. The second 
parameter only decides whether the values are already deleted within the table. 

Return Value: 

Number 

Example: 

Avg(Order_Details.Quantity*Order_Details.UnitPrice) 
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Barcode 

Purpose: 

This function converts a string to a barcode. This function can only be used in lists. 

Parameter: 

String  Barcode value (contents) 

String Barcode type 

The possible barcode types will be listed by the auto-complete function of the wizard. If the barcode cannot be correctly 
interpreted it will not be printed. Some barcodes require special formats that must be used. Further information can be 
found in Chapter  List of Available Barcodes. 

Return value: 

Barcode 

Example: 

Barcode(Upper$(Name),"3of9") 
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Barcode$ 

Purpose: 

Returns the text contents of a barcode. 

Parameter: 

Barcode 

Return value: 

String 

Example: 

Barcode$(BC_3OF9)          Result: "Item 4711" 
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BarcodeType$ 

Purpose: 

Returns the type of the barcode as a string. 

Parameter: 

Barcode 

Return value: 

String 
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Case$ 

Purpose: 

Converts a number, dependant upon the value, into a string. Assignment is made with a formatting string that contains the 
replacement string for the number values in ascending order. 

Parameter: 

Number           Number to be converted (n).The n-th value of the character string will be copied to the return value 
string. If enough values do not exist, the character string will remain empty. 
String              Collection of strings separated by a particular character. If a third parameter does not exist, 
this is the "|" character, otherwise the first character of this parameter. 

String              (optional) Separator for the formatting string (default: "|") 

Return value: 

String 

Example: 

Case$(Page(),"0|I|II|III|IV|V|VI|VII|VIII|IX|X") 

Result: "III", if Page() = 3 
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CheckMod10 

Purpose: 

Calculate the modulo 10 checksum digit of the string. 

Parameter: 

             String  A string of digits. 

Return value: 

Number 
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Chr$ 

Purpose: 

Converts a number to a character. This character has the entered number as it's ASCII-Code. For multibyte character 
sets, the highword is the lead byte, for Unicode, the value is the Unicode code point. 

Parameter: 

             Number 

Number (optional) Defines the type of the parameter. 0=multibyte character sets, 1=Unicode. Default is dependent on the 
InLoox dll used. 

Return value: 

String 

Example: 

Chr$(64)    Result: "@" 
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ChrSubst$ 

Purpose: 

Searches a character string for a string that is contained in the second parameter. Every occurrence of this string will be 
replaced by the string defined in the third parameter. If no third parameter exists, the strings will be removed. 

Parameter: 

String 

String 

String (optional) 

Return value: 

String 

Example: 

ChrSubst$("Otto", "Oo", "_")               Result: "_tt_" 

ChrSubst$("Normalconsumer", "aeiou","??")  Result: "N??rm??lc??ns??m??r" 

ChrSubst$("Normalconsumer", "aeiou")  Result: "Nrmlcnsmr" 

ChrSubst$("3.1415926535",".",",")          Result: "3,1415926535" 
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Cond 

Purpose: 

Allows to define conditions. The first parameter is a logical expression that will be evaluated as "True" of "False". If the 
first expression is "True", the second expression will be returned as the result. If the expression is "False", the third 
expression will be returned as the result. If no third expression is entered, the return value will assume the following 
standard values, dependent upon its type: 

2. Argument Type Return value if expression = False 

Boolean False 

String "" (empty String) 

Date Julian Date value 0 

Number 0 

Drawing "" (empty String) 

Barcode "" (empty String) 

  

Parameter: 

Boolean 

All 

All (optional) 

Return value: 

All 

Example: 

Imagine that your database contains items that are free samples and the items that you normally sell. 

Cond(PRICE=0,"Free Sample","Price:"+PRICE+" USD") 
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Contains 

Purpose: 

Evaluates if a string contains another string (second parameter). 

Parameter: 

String 

String 

Return value: 

Boolean 

Example: 

Contains("Itemnumber: 12345", "1234") Result: True 
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Continued 

Purpose: 

Indicates that a text or RTF-object had a page break. This means that the current page is a result of the page break. 

Parameter: 

- 

Return value: 

Boolean 
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Count 

Purpose: 

Counts the number of values of the first argument. With this function, all NULL values in the argument are included in the 
count. Use the CountIf() function when you want to disregard NULL values. 

Parameter: 

All                                 Values to count (sets the value to count). Needed to define the table (subtable) for 
which the records shall be counted. 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values will be already deleted within the table. 

Return value: 

Number 

Example: 

Count(Order_Details.ProductID) 

NthLargest(Article.Price,Count(Distinct(Artikel.Stkpreis),True)-1, True) 

Calculates the second-smallest value, only taking repeated values into account once. 
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CountIf 

Purpose: 

Counts the number of values that comply with the condition. Use the function Distinct() when repeated values are only to 
be counted once. 

Parameter: 

Boolean                        Expression for the comparison 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values will be already deleted within the table. 

Return value: 

Number 

Example: 

CountIf (Customers.Region="EMEA") 

CountIf (Distinct(Customers.Region="EMEA")) 
counts repeated values once only 

CountIf (IsNULL (Orders.OrderDate))   
counts all values with empty fields 
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Crosstab.Cells.Avg 

Purpose: 

Returns the average of the cell contents. Only available in crosstab objects. 

Parameter: 

Boolean (optional) 
True: Only defined valuesare entered into the calculation (Default: False). 

Defined values: if you are, for example, analyzing customers and quarters, the quarters without turnover constitute an 
undefined value and can be treated separately in the calculation. 

Number (optional) 
Row layer (0= bottom layer or innermost group, 1= next lowest, ...). Default: 0. 

Number (optional) 
Column layer (0= bottom layer or innermost group, 1= next lowest, ...). Default: 0. 

Return value: 

Number 

Example: 

Crosstab.Cells.Avg(.T.,2,0) 
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Crosstab.Cells.Max 

Purpose: 

Returns the largest value of the cell contents. Only available in crosstab objects. 

For the parameters and their meaning, see function Crosstab.Cells.Avg(). 
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Crosstab.Cells.Min 

Purpose: 

Returns the smallest value of the cell contents. Only available in crosstab objects.            

For the parameters and their meaning, see function Crosstab.Cells.Avg(). 
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Crosstab.Col$ 

Purpose: 

Returns the column header for the cell currently being output. Only available in crosstab objects. 

Parameter: 

Number (optional) Column layer (0= lowest layer or innermost group, 1= next lowest, ...). Default: 0. 

Return value: 

String 
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Crosstab.Col 

Purpose: 

Returns the column index for the cell currently being output. Only available in crosstab objects. 

Parameter: 

Boolean (optional)    True: layer (only cells in this layer count), Default: False. 

Return value: 

Number 
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Crosstab.Row$ 

Purpose: 

Returns the row header for the cell currently being output. Only available in crosstab objects. 

Parameter: 

Number (optional)         

Row layer (0= lowest layer or innermost group, 1= next lowest, ...). Default: 0. 

Return value: 

String 
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Crosstab.Row 

Purpose: 

Returns the row index for the cell currently being output. Only available in crosstab objects. 

Parameter: 

Boolean (optional) True: layer (only cells in this layer count), Default: False. 

Return value: 

Number 
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CStr$ 

Purpose: 

Formats a number according to a format character string. This is identical to the formatting information for the function 
printf() in the language C. The first parameter is a number of double precision, and the conversion operator can assume 
i.e. the following values: 'f', 'g', 'G', 'e', 'E'. 

Parameter: 

Number 

String  format string in C-notation, i.e. '%<format>f' 

Return value: 

String 

Example: 

CStr(Pi,"%5.1f")           Result: "  3.1" 
CStr(100*Pi,"nun: %g")          Result: "nun: 3.141593e+02" 
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Date 

Purpose: 

Converts a string to a date. 

▪     If the string Contains a dot ".", it will be read in the "d.m.y" format (German). 

▪     If the string contains a diagonal slash "/", it will be read in the "m/d/y" format (US English). 

▪     If the string contains a dash "-", if will be read in the "y-m-d" format (ANSI). 

▪     If the input cannot be correctly interpreted, then the date represents a value that is larger than all other values, 
(1e100). The return value can be evaluated for correctness using "JulianToDate(1e100)". 

Parameter: 

String 

Return value: 

Date 

Example: 

Date("17.10.2006") 
Date("10/17/2006") 
Date("2006-10-17") 

Tip: 

When one or two digits represent the year, all values under 30 will be applied to the 21st century (20xx) and all values over 
30 will be applied to the 20th century (19xx). 
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Date$ 

Purpose: 

Converts a date, using a format string, into an appropriately formatted string. 

Composition of the format string: this is a normal string into which placeholders can be embedded. 

Place holder Description 

%d Day (1..31) 

%<n>d Day to <n> digits 

%0<n>d Day to <n> digits, filled on left with '0's 

%w Weekday (1..7) 

%<n>w Weekday to <n> digits 

%0<n>w Weekday to <n> digits, filled on left with '0's 

%m Month (1..12) 

%<n>m Month to <n> digits 

%0<n>m Month to <n> digits, filled on left with '0's 

%y Year 

%<n>y Year, to <n> digits 

%0<n>y Year, to <n> digits, filled on left with '0's 

%D Weekday, written out 

%M Month, written out 

"%e", "%<n>e" Year in the local calendar (Japan: Emperor's year) 

"%g", "%<n>g" Era of the local calendar (Japan: Emperor's era) 

"%g", "%1g" Single letter, Latin letters 

"%gg", "%2g" Single letter, localized 

"%ggg", "%3g" Long name, localized 

"%gggg", "%4g" Long name, Latin letters 

"%x" Localized date, short form 

As long as one of the above formats is used, the optional third parameter can be used to set the locale. If the second 
parameter contains a valid ISO-Country code, the third parameter can be used to set either the short "0" or long "1" 
format. See also Chapter  List of ISO 3166 Country Codes. 

Parameter: 

Date                              Value to be formatted 
String (optional)         Format description or country code 
String (optional)         Country code or date format 
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Return value: 

String 

Example: 

Date$(Today(),"Date: %D, %d/%m/%y") 
Result: "Date: Thursday, 7/11/2006" 

Date$(Today(),"%2wthWeek; %D, %2d/%2m/%4y") 
Result: "45th Week, Thursday, 7/11/2006" 

Date$(Today(),"%D, %3d/%02m/%4y") 
Result: "Thursday,  7/11/2006" 
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DateHMS 

Purpose: 

Converts three numbers for hour, minute and second into a date. 

Parameter: 

Number           Hour 
Number           Minute 
Number           Second 

Return value: 

Date 
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DateInRange 

Purpose: 

Evaluates if the date falls within the entered time interval: 

Minimum Date: JulianToDate(0) 

Maximum Date: JulianToDate(1e100) 

Parameter: 

Date                 Date to be evaluated 
Date           Lower limit of the test interval 
Date           Upper limit of the test interval 

Return value: 

Boolean 

Example: 

DateInRange(Date("2006.10.20"),Date("2006.2.29"),Today()) 

Result: True 
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DateToJulian 

Purpose: 

Calculates the Julian value of a date. Each day (even those in the past) are assigned a unique number. 

Parameter: 

Date 

Return value: 

Number 

Example: 

DateToJulian(Today())        Result: 2453992 
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DateYMD 

Purpose: 

Converts three numbers for day, month and year into a date. 

Parameter: 

Number           Year 
Number           Month 
Number           Day 

Return value: 

Date 

Example: 

Date(2006, 11, 1) 
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Day 

Purpose: 

Determines the day (1...31) of the month and returns it as a number. 

Parameter: 

Date 

Return value: 

Number 

Example: 

Day(Date("17.10.2006"))         Result: 17 
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Day$ 

Purpose: 

Determines the day (1.31) of the month of a date and returns it as a string. 

Parameter: 

Date 

Return value: 

String 

Example: 

Day$(Date("17.10.2006"))   Result: "17" 
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Distinct 

Purpose: 

Affects the higher order aggregate function (e.g. Sum(), Avg(), Count()...) and causes equal values only to be used once 
in the calculation. 

Parameter: 

All 

Return value: 

All 

Example: 

CountIf(Distinct(Customers.Region="EMEA")) 
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Dow 

Purpose: 

Returns the day of the week to a number(1...7), 1=Sunday, 2=Monday, ... 

Parameter: 

Date 

Return value: 

Number 

Example: 

DoW(Today())    Result: 4 

If the day for the current date is a Wednesday. 
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Dow$ 

Purpose: 

Returns the day of the week as a string in accordance with the country settings, "Sunday", "Monday", ... 

Parameter: 

Date 

Return value: 

String 

Example: 

DoW(Today()) Result: "Wednesday" 

If the day for the current date is a Wednesday. 
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Drawing 

Purpose: 

Converts a string type file path into a drawing. 

Parameter: 

String 

Return value: 

Drawing 
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Drawing$ 

Purpose: 

Converts a drawing into a string type file path. 

Parameter: 

Drawing 

Return value: 

String 
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Empty 

Purpose: 

Evaluates if a string is empty. If it is empty, "True" will be the return value, otherwise "False". Useful, for example, to 
determine if the field "ADDRESS" is empty, and if it is, in combination with the IF-THEN-ELSE condition cond(), either 
print the contents of the field "ADDRESS" or "POBOX". 

The third parameter allows the removal of leading and trailing spaces. If this is evaluated as "True", a string consisting 
only of multiple spaces will be recognized as empty. 

Parameter: 

String 

Boolean (optional) 

Return value: 

Boolean 

Example: 

Empty("xyz")    Result: False 

Empty("")                 Result: True 
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Even 

Purpose: 

Evaluates if a number is even. If the number is even, "True" will be returned, otherwise "False". 

Parameter: 

Number 

Return value: 

Boolean 

Example: 

"Page number "+Cond(Even(Page()),"even","odd") 
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Exp 

Purpose: 

Calculates the exponential (ex). 

Parameter: 

Number 

Return value: 

Number 

Example: 

Exp(3)     Result: 20.08553692 
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Exp10 

Purpose: 

Calculates 10 raised to the power of number (10x). 

Parameter: 

Number 

Return value: 

Number 

Example: 

Exp10(3)   Result: 1000 
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FirstHeaderThisTable 

Purpose: 

Returns whether the header of the table is being output for the first time. The function can be used as an appearance 
condition for the header to prevent it being printed more than once if the table continues onto the next page due to space 
limitations. The header is then only printed at the beginning of the table. 

Parameter: 

- 

Return value: 

Boolean 
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Frac 

Purpose: 

Calculates the fractional part of a number 

Parameter: 

Number 

Return value: 

Number 

Example: 

Frac(Pi)   Result: 0.1415926535 
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FStr$ 

Purpose: 

Formats a number according to the format string. 

These consist of the following characters ("if negative" refers to the value to be formatted): 

* Digit or '*'-Prefix 

$ Local currency symbol 

- Digit or sign, if negative 

+ Digit or sign 

( Digit or '('-Prefix if negative 

) ')'-Postfix if negative 

# Digit or space prefix 

& Digit or '0' 

. Decimal point 

, Comma, or space prefix 

A prefix is a sign that precedes a value, when needed. The expression FStr$(1, "***") results in "**1". The value "1" is 
preceded by the characters "**". 

A Postfix is a character that, when needed, is placed after a number. 

These formatting characters can be combined as needed. If the number is too large for the desired format, a "*" string will 
be returned. 

With the third (optional) parameter, additional formatting can be accomplished. 

Value Description 

1 Removal of leading spaces. 

The use is similar to the functions RTrim$() and LTrim$(). 

2 Empty string if value NULL. 

3 Removal of leading spaces and empty strings when value is 0 

Parameter: 

Number 
String               Format string 
Number (optional) Additional formatting 

Return value: 

String 

Example: 
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FStr(3.142, "#")           Result: "3"     
FStr(5003.1,"#,###.&&")          Result: "5.003,10"     
FStr$(3.142,"#.###")       Result: "3,142" 
FStr$(3.142,".######")           Result: "*******" 
FStr$(3.142,"(#.###)")           Result: " 3,142 " 
FStr$(-3.142,"(#.###)")          Result: "(3,142)" 
FStr$(3.142,"+#.###")      Result: "+3,142" 
FStr$(3.142,"-#.###")      Result: " 3,142" 
FStr$(-3.142,"-#.###")           Result: "-3,142" 
FStr$(3.142,"&&&.&&&")           Result: "003,142" 
FStr$(3.142,"***.***")           Result: "**3,142" 
FStr$(3.142,"$$$.$$$")           Result: "$$3,142" 
FStr$(3.142,"###.***")           Result: "  3,142" 
FStr$(5003.1,"#,###.&&")   Result: "5.003,10" 
FStr$(3.142,"#####")       Result: "    3" 
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GeometricAvg 

Purpose: 

Calculates the geometric average of the set of values that result from the first parameter / formula. 

Parameter: 

Number                        Expression for the value to be averaged. 
Boolean (optional) True: The values which were stored for the calculation are deleted after output. (default: TRUE). 
Please note that the stored calculation values are generally deleted for every (sub)table end. The second parameter only 
decides whether the values are already deleted within the table. 

Return value: 

Number 
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Hour 

Purpose: 

Determines the hour of the date and returns it in number format. If the parameter is not used, the hour of the print time will 
be returned. 

Parameter: 

Date (optional) 

Return value: 

Number 

Example: 

A condition can evaluate if the current hour has the value "10". The value of the current hour must be determined and 
then compared to the value "10". 

Hour()=10 
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HSL 

Purpose: 

Calculates a color value in the HSL color space (Hue, Saturation, Lightness) 

Parameter: 

Number                        Hue[0-360] 
Number                        Saturation [0-1] 
Number                        Lightness [0-1] 

Return value: 

Number 
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Hyperlink$ 

Purpose: 

The function Hyperlink$ creates a hyperlink text that can be inserted using an export module. 

When available, the hyperlink will only be embedded if the third parameter returns a result of "True" (=default). 

Parameter: 

String                                        Text 
String                                        Hyperlink 
Boolean           (Optional)        Embed 

Return value: 

String 

Example: 

Hyperlink$("combit","http://www.combit.net") 

Tip: 

To optionally use a hyperlink only on a HTML page, you need to use the InLoox variable LL.OutputDevice: 

Hyperlink$("combit","http://www.combit.net",LL.OutputDevice="HTML") 

If an object text contains the character string: 

<!--begin:hyperlink="target"-->"Display text"<!--end:hyperlink--> 

then a hyperlink will be automatically created in the exported HTML page. The hyperlink function automatically creates a 
string with the correct syntax. 
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If 

see Cond 

  



Detailed information 

531 

  

Int 

Purpose: 

Calculates the integer value of a number. The value will be truncated. 

Parameter: 

Number 

Return value: 

Number 

Example 

Int(3,1)   Result: 3 
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IsNULL 

Purpose: 

Checks whether the transferred value or the result of the expression is NULL, e.g. an empty date field. 

Parameter: 

All 

Return value: 

Boolean 
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JulianToDate 

Purpose: 

Interprets a number as a Julian date (each day is assigned a unique number) and returns the appropriate date. 

Parameter: 

Number 

Return value: 

Date 

Example: 

JulianToDate(2453992) Result: 2006.09.14 
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LastFooterThisTable 

Purpose: 

Returns whether the footer of the current table is being output for the last time. This function can be used as an 
appearance condition for the footer, in order to prevent the footer being printed if the table is continued on the next page 
due to space limitations. The footer is then only printed on the last page of the table. 

Parameter: 

- 

Return value: 

Boolean 
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Lastpage 

Purpose: 

Returns if the current page is also the last page. 

Note: This function can only be used in the footer lines of tables or in objects linked with tables! In all other cases, the 
result of Lastpage() is always False. 

Parameter: 

- 

Return value: 

Boolean 

Example: 

Cond(Lastpage(),"Total sum","Subtotal") 
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Left$ 

Purpose: 

Reduces a string from the right so that only the number of characters set under Number remain. If the original string is 
already small enough, it is not affected. 

Parameter: 

String                           The value to be shortened 
Number                        maximum number of positions of the result 
Boolean (optional)       

True: The cut off value is ended with "..." (Default: False). With numbers < 3 the setting is ignored. 

Return value: 

String 

Examples: 

If you had a customer database that contains, amongst other things, the field NAME for the surname. You now wish to 
search for all customers whose surname starts with "C". To do this, you must first identify the starting letters. 

Left$(NAME, 1)                Result: the first letter of the NAME string. 

Left$("combit", 2)               Result: "co" 

Left$("combit", 4,.T.)                Result: "c." 

Left$("combit", 2,.T.)                Result: "co" 
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Len 

Purpose: 

Returns the number of characters in a string. 

Parameter: 

String 

Return value: 

Number 

Example: 

Len("1234"+"12") Result: 6 
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LoadFile$ 

Purpose: 

Outputs the contents of the file as a character string. 

Parameter: 

String 
String  (optional)         When the file is not available, the value set here is used. 

Return value: 

String 

Example: 

LoadFile$("C:\log.txt","File not found!") 
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Locale$ 

Purpose: 

Returns information about the country settings, for example currency, decimals, separators, language and country code. 
The code for the appropriate country is entered in the second parameter, if no second parameter is used the default 
country settings will be used. 

Parameter: 

Number                        Index of Locale Entry 
String(optional)                      Country code 

Return value: 

String 

Example: 

Locale$(42,"USA")          Result: "Monday" 

Possible constants for index entry: 
http://msdn.microsoft.com/library/default.asp? url=/library/en-us/intl/nls_8rse.asp 

See also Chapter  List of ISO 3166 Country Codes. 
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LocCurr$ 

Purpose: 

Returns a string with the valid currency format without the currency symbol for the entered country. 

Parameter: 

Number          Value to be formatted 
String(optional)          Country code 

Return value: 

String 

Example: 

LocCurr$(123,"USA")   Result: "123.00" 

See also Chapter  List of ISO 3166 Country Codes. 
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LocCurrL$     

Purpose: 

Returns a string with the valid currency format and currency symbol for the entered country. 

Parameter: 

Number                        Value to be formatted 

String  (optional)         Country code 

Return value: 

String 

  

Example: 

LocCurr$(123,"USA")   Result: "$123.00 " 

See also Chapter  List of ISO 3166 Country Codes. 
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LocDate$ 

Purpose: 

Returns a string with the valid date format for the entered country. 

Parameter: 

Date                              Value to be formatted 
String  (optional)         Country code 
Zahl     (optional)         Format 

Return value: 

String 

  

Example 

LocDate$(Date("17.11.2006"),"USA") Result: "11/17/2006" 

See also Chapter  List of ISO 3166 Country Codes. 
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LocDateTime 

Purpose 

Converts the character string into a date (with time if required) in the relevant format for the country. 

Parameter: 

String                           Date 
String  (optional)         Country code 

Return value: 

Date 

Example 

LocDateTime(Date("17.11.2006"),"DEU") Result: "17.11.2006" 

See also Chapter  List of ISO 3166 Country Codes. 
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LocNumber$ 

Purpose: 

Returns a string with the valid number format for the entered country. 

Parameter: 

Number       Value to be formatted 
String (optional)   Country code 

  

Example: 

LocNumber$(123,"USA")                 Result: "123.00" 

See also Chapter  List of ISO 3166 Country Codes. 
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LocTime$ 

Purpose: 

Returns a string with the valid time format for the entered country. 

Parameter: 

Date  Value to be formatted 
String (optional)   Country code 
Number (optional)         Format 

Example: 

LocTime$ (Now(),"USA")           Result: 9:05:22 AM" 

See also Chapter  List of ISO 3166 Country Codes. 
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Log 

Purpose: 

Calculates the natural logarithm ln(x). 

Parameter: 

Number 

Return value: 

Number 

Example: 

Log(Exp(1))           Result: 1 
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Log10 

Purpose: 

Calculates the base-10 logarithm log(x). 

Parameter: 

Number 

Return value: 

Number 

Example: 

Log10(1000)           Result: 3 
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Lower$ 

Purpose: 

Converts the characters of a string into lower case letters. 

Parameter: 

String 

Return value: 

String 

Example: 

Lower$("George") Result: "george" 
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LTrim$ 

Purpose: 

Removes the leading spaces of a string. 

Parameter: 

String 

Return value: 

String 

Example: 

LTrim$("   George")        Result: "George" 

  



Detailed information 

550 

  

Max 

Purpose: 

Returns the largest of the two values. 

Parameter: 

Number orDate 
Number orDate 

Return value: 

Number orDate 
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Maximum 

Purpose: 

Calculates the maximum of the set of values that result from the first parameter / formula. 

Parameter: 

Number 

Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

Maximum(Order_Details.ProductID@Products.ProductID:UnitsInStock) 
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Median 

Purpose: 

Calculates the median of the set of values that result from the first parameter / formula. 

Parameter: 

Number              Expression for the value to be averaged. 
Boolean (optional)    

The values which were stored for the calculation are deleted after output. (default: TRUE). Please note that the stored 
calculation values are generally deleted for every (sub)table end. The second parameter only decides whether the values 
are already deleted within the table. 

Return value: 

Number 

Example: 

Median(UnitsInStock) 
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Mid$ 

Purpose: 

Returns a part of a string. The desired number of characters starting at the starting position will be returned. 

If the third parameter is not used, the string will be returned from the starting position to the end. 

The first character of the string has the Position 0. 

Parameter: 

String 
Number                                     Starting position 
Number           (optional) Number of characters to be displayed 

Return value: 

String 

Example: 

Mid$("Normalconsumer",6)         Result: "consumer" 
Mid$("Normalconsumer",6,30)           Result: "consumer" 
Mid$("Normalconsumer",6,3)            Result: "con" 
Mid$(Name,0,6)                   Result: "Normal" 
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Min 

Purpose: 

Returns the smallest of the two values. 

Parameter: 

Number orDate 

Number orDate 

Return value: 

Number orDate 
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Minimum 

Purpose: 

Calculates the minimum of the set of values that result from the first parameter / formula. 

Parameter: 

Number 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

Minimum(Order_Details.ProductID@Products.ProductID:UnitsInStock) 
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Minute 

Determines the minute of the entered date, and returns the result as a number. If the parameter is not used, the minute of 
the time of printing will be returned. 

Parameter: 

Date (optional) 

Return value: 

Number 

Example: 

Whether the current minute has the value "10" should be determined by a condition. The value of the current minute will 
be determined and compared with the value "10": 

Minute()=10 
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Mode 

Purpose: 

Calculates the mode (most common value) of the set of values that result from the first parameter / formula. 

Parameter: 

Zahl           Expression for the value to be examined. 
Boolean (optional)    The values which were stored for the calculation are deleted after output. (default: TRUE). Please 
note that the stored calculation values are generally deleted for every (sub)table end. The second parameter only decides 
whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

Mode(UnitsInStock) 
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Month 

Purpose: 

Determines and returns the month (1...12) as a number. 

Parameter: 

Date 

Return value: 

Number 

Example: 

Month(Date("2006.10.17")) Result: 10 
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Month$ 

Purpose: 

Determines and returns the month (1...12) as a string. 

Parameter: 

Date 

Return value: 

String 

Example: 

Month$(Date("2006.10.17")) Result: "10" 
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Now 

Purpose: 

Returns the current date and time. 

Parameter: 

- 

Return value: 

Date 
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NthLargest 

Purpose: 

Calculates the nth-largest value of the set of values that result from the first parameter / formula. 

Parameter: 

Number 
Number <n>, i.e. the index for the value which is to be returned (1-based). 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

NthLargest(Order_Details.ProductID,2) calculates the second-largest number 
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NthLargestIndex 

Purpose: 

Calculates the index of the nth-largest value of the set of values that result from the first parameter / formula. 

Parameter: 

Number 
Number <n>, i.e. the index for the value which is to be returned (1-based). 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

NthLargestIndex(Order_Details.ProductID,2) 
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NthValue 

Purpose: 

Calculates the nth value of the set of values that result from the first parameter / formula. 

Parameter: 

All 
Number                        <n>, i.e. the index for the value which is to be produced, calculated e.g. with 
NthLargestIndex(). 
Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

NthValue(NthLargestIndex(Order_Details.ProductID,2)) 
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NULL 

Purpose: 

Returns a NULL value (value not available). 

Parameter: 

- 

Return value: 

All 
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NumInRange 

Purpose: 

Evaluates if a number falls within the desired range. 

Parameter: 

Number 

Number           Upper limit 

Number           Lower limit 

Return value: 

Boolean 

Example: 

NumInRange(Page(),1,10) 

Result: True, if the page number is between 1 and 10. 
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Odd 

Purpose: 

Evaluates if a number is odd. If the number is odd "True" will be returned, otherwise "False".  

Parameter: 

Number 

Return value: 

Boolean 

Example: 

"Page number "+Cond(Odd(Page()),"odd","even") 
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Ord 

Purpose: 

Returns the ASCII value of the first character. 

Parameter: 

String 

Return value: 

Number 

Example: 

Ord("Combit")   Result: 67 
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Page 

Purpose: 

Returns the current page number. 

Parameter: 

- 

Return value: 

Number 

Example: 

Case(Odd(Page()),"Even","Odd")+" page number" 
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Page$ 

Purpose: 

Returns the page number of the printed page as a character string. 

Parameter: 

- 

Return value: 

String 

Example: 

"Page "+Page$()+"/"+TotalPages$()     Result: Page 1/3 
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Pow 

Purpose: 

Corresponds to the function (Base) ^ (Exponent). 

Parameter: 

Number           Base 

Number           Exponent 

Return value: 

Number 

Example: 

Pow(2,3)   Result: 8 
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Previous 

Purpose: 

Returns the previous value of the variable, field or formula, i.e. the value it had for the last record. 

Parameter: 

All        Variable, field or formula 

Return value: 

All 

Example: 

Previous(NAME)  Result: "consumer" 

  



Detailed information 

572 

  

ProjectPath$ 

Purpose: 

Returns the path of the project file, optionally including the file name (otherwise with "\" at the end) 

Parameter: 

Boolean            True: Sets that the path is returned including the file name (Default: False). 

Return value: 

String 

Example: 

ProjectPath$(.T.)       Result: C:\Program Files\LL12\crosstab.lsr 
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RainbowColor 

Purpose: 

Calculates a color value between violet and red corresponding to the value of the first parameter e.g. for rainbow colors in 
crosstabs. 

Parameter: 

Number                        Value to be displayed. 

Number                        Limiting value for violet. 

Number                        Limiting value for red. 

Return value: 

Number 
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RegExMatch$ 

Purpose: 

Returns the part of the string that corresponds to the regular expression or the group passed in the third parameter. 

The regular expression corresponds to Pearl 5 Syntax, which in most details equals the regular expression syntax of the 
Visual Basic Scripting engine. 

Parameter: 

String 
String 
Number 

Return value: 

String 

Example: 

Division of the "STREET" field to street and number: 

"Street: " + RegExMatch$(STREET,"((?:\w* )+)(\d+[\w ]*$)",1) 
"Number: " + RegExMatch$(STREET,"((?:\w* )+)(\d+[\w ]*$)",2) 

RegExMatch$("test1234xyz0815", "[0-9]+") Result: "1234" 
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RemainingTableSpace 

Purpose: 

Returns the space available to data and group lines in a table object. The parameter defines the unit of the return value. 
The function can be used to carry out conditional page breaks before group lines, e.g. "Page break before only 5% space 
is left". 

Parameter: 

Boolean (optional)       TRUE: the value is in units which are independent of the system (SCM-units), FALSE: the value 
is a percentage of the entire table size (default: FALSE). 

Return value: 

Number 
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Rep$ 

Purpose: 

Returns a string that contains the appropriate number of strings defined in the first parameter. 

Parameter: 

String 
Number 

Return value: 

String 

Example: 

Rep$("-",10)    Result: "----------" 
Rep$("+-",5)    Result: "+-+-+-+-+-" 

  



Detailed information 

577 

  

RGB 

Purpose: 

Calculates the color value using the relative red, green and blue saturation values (between 0 and 255). No saturation has 
the value 0, full saturation the value 255. This function can be used to set the font color using a formula. 

Parameter: 

Number           red saturation 

Number           green saturation 

Number           blue saturation 

Return value: 

Number 

Example: 

Cond(Amount<0, RGB(255,0,0), RGB(0,0,0) 

Result: red for negative amounts 
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Right$ 

Purpose: 

Reduces a string from the left so that only the number of characters set under Number remain. If the original string is 
already small enough, it is not affected. 

Parameter: 

String 
Number 
Boolean (optional)       

True: The cut off value starts with "..." (Default: False). If Number < 3 the setting is ignored. 

  

Return value: 

String 

Example: 

Right$("normalconsumer", 8)        Result: "consumer" 

Right$("normalconsumer", 11,.T.)          Result: "...consumer" 
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Round 

Purpose: 

Rounds a value to the entered number of decimal places. Default is 0. 

Parameter: 

Number 

Number  (optional) 

Return value: 

Number 

Example: 

Round(3.1454,2)      Result: 3,15 
Round(3.1454)         Result: 3 
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RTrim$ 

Purpose: 

Removes spaces from the end of a string. 

Parameter: 

String 

Return value: 

String 

Example: 

RTrim$("John    ")         Result: "John" 

  



Detailed information 

581 

  

Second 

Determines the second of the entered date and returns the result as a number. If the parameter is not used, the second of 
the print time will be returned. 

Parameter: 

Date (optional) 

Return value: 

Number 
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Sqrt 

Purpose: 

Calculates the square root of a number. 

Parameter: 

Number 

Return value: 

Number 

Example: 

Sqrt(4)         Result: 2 
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StdDeviation 

Purpose: 

Calculates the standard deviation of the set of values that result from the first parameter / formula. 

  

Parameter: 

Number 

Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

StdDeviation(Order_Details.Quantity*Order_Details.UnitPrice) 
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Str$ 

Purpose: 

Converts a number into a string. The number will be formatted with 6 decimal places that may be rounded. The length is 
variable. 

Parameter: 

Number           

Number           (optional) Defines the length of the string (default:6). If the number is too large for this format, the resulting 
string may then be longer than desired. If the number is too small, spaces will be attached dependent upon the prefix, 
right (negative) or left (positive). 

 
Number           (optional) Defines the precision (number of decimal places). If the number is positive, the number will be 
displayed as a floating-point number, if negative in scientific format. 

Return value: 

String 

Example: 

Str$(Pi)              Result: "3.141593" 
Str$(Pi,3)                 Result: " 3" 
Str$(Pi,3,0)          Result: " 3" 
Str$(-Pi,12,-3)       Result: "-3.141e+00" 
Str$(Page())          Result: "5.000000" 
Str$(Page(),10)      Result: "     5" 
Str$(Page(),-10)      Result: "5     " 
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StrPos 

Purpose: 

Returns the position of the nth appearance of a search string. The third parameter determines which appearance will be 
returned. Default is 1. 

The first character in the string has the position 0. 

-1 as return value signifies the search string no longer appears. 

Parameter: 

String 

String                           Search string 

Number (optional) 

Return value: 

Number 

Example: 

StrPos("Normalconsumer","or")         Result: 1 
StrPos("Normalconsumer","r")          Result: 2 
StrPos("Normalconsumer","r",1)   Result: 2 
StrPos("Normalconsumer","r",2)   Result: 13 
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StrRPos 

Purpose: 

Returns the position of a search string within a string. This is a backwards search. The third parameter, determines which 
appearance will be returned. Default is 1. 

The first character in the string has the position 0. 

-1 as return value signifies the search string no longer appears. 

Parameter: 

String 

String               Search string 

Number           (optional) 

Return value: 

Number 

Examples: 

StrRPos("Normalconsumer","or")        Result: 1 
StrRPos("Normalconsumer","r")         Result: 13 
StrRPos("Normalconsumer","r",1)       Result: 13 
StrRPos("Normalconsumer","r",2)       Result: 2 
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StrSubst$ 

Purpose: 

Searches a string for the appearance of a search string and replaces it with the string contained in the third parameter 
(replacement string). If no third parameter is used, the string located using the search string will be deleted. 

Parameter: 

String 

String               Search string 

String               (optional) Replacement string 

Return value: 

String 

Example: 

Assume that you want to print address labels that contain the company name. You do not have much space available on 
the label and cannot afford to completely print long company names, for example, "Forrer Construction, Incorporated". 

With the expression StrSubst$(COMPANY,"Incorporated","Inc.") every appearance of "Incorporated" in the COMPANY 
field will be replaced with "Inc." 
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Sum 

Purpose: 

Calculates the sum of the parameter / formula in the parameter. 

Parameter: 

Number 

Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

Sum (Order_Details.UnitPrice) 
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Time$ 

Purpose: 

Returns the current time in string format. 

The following formats are available: 

Placeholder Description 

%h Hours in 24 hour format 

%H Hours in 12 hour format 

%m Minutes 

%s Seconds 

%P Display the part of day (A.M. / P.M.) 

%p Display the part of day (a.m. / p.m.) 

Parameter: 

String 

Return value: 

String 

Example: 

Time$("%02h:%02m:%02s")    Result: "18:30:45" 
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Today 

Purpose: 

Returns the current date. 

Parameter: 

- 

Return value: 

Date 

Example: 

Date$(Today(),"%D, %m.%d.%4y") 

Result: "Friday, 11/8/2006" 

  



Detailed information 

591 

  

Token$ 

See Case$ 
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ToRTF$ 

Purpose: 

Returns a string in RTF-format. This is necessary because some strings may contain one of the specially defined RTF-
format symbols. ('\', '{' or '}'). 

Parameter: 

String 

Return value: 

String 

Example: 

If, for example, the field PRODCODE could contain one of the characters, then the text should be inserted in the following 
way: 

"<<SALUTATION>> <<NAME>>, You have received our product <<PRODUCT>>, Code <<ToRTF$(PRODCODE)>>..." 
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TotalPages$ 

Purpose: 

Returns the total number of pages. The returned character string is replaced by the total number of pages when printing. 

Please note when using this function that the timing behavior of the print process can be affected. A progress bar may 
reach 100% faster, but because of further processing of the output, there may be a delay before the actual printout is 
produced. No calculations may be performed with the result of this function. 

Parameter: 

- 

Return value: 

String 

Example: 

"Page "+Page$()+"/"+TotalPages$()     Result: Page 1/3 
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UnitFromSCM 

Purpose: 

Converts a SCM-Unit (1/1000 mm) to the print unit (inch/mm). Important for the definitions of property values independent 
of the selected print unit. 

Parameter: 

Number 

Return value: 

Number 

Example: 

Cond(Page()=1,UnitFromSCM(100000),UnitFromSCM(20000)) 

Result: 10cm for Page 1, 20 cm for the other pages. 
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Upper$ 

Purpose: 

Converts the characters of a string to capital letters. 

Parameter: 

String 

Return value: 

String 

Example: 

Upper$("Otto")        Result: "OTTO" 
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Val 

Purpose: 

The string is interpreted and returned as a number. If an error occurs, the return value is 0. The decimal sign must always 
be entered as ".". 

Parameter: 

String 

Return value: 

Number 

Example: 

Val("3.141")                     Result: 3.141 
Val("3,141")                     Result: 3 
Val("3.141e2")                   Result: 314.2 
Val(ChrSubst$("3,141", ",", "."))     Result: 3.141 

  



Detailed information 

597 

  

Variance 

Purpose: 

Calculates the variance of the set of values that result from the first parameter / formula. 

Parameter: 

Number 

Boolean (optional)       TRUE: The values which were stored for the calculation are deleted after output. 
(default: TRUE). Please note that the stored calculation values are generally deleted for every (sub)table 
end. The second parameter only decides whether the values are already deleted within the table. 

Return value: 

Number 

Example: 

Variance(Order_Details.Quantity*Order_Details.UnitPrice) 
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Woy 

Purpose: 

Returns the week number of a given date. 

The optional second parameter determines the setting for the first week of the year. 

0 Week with the first working day 

1 Week of January, 1 

2 First week with at least 4 days 

3 First week with 7 days 

4 Week with the first Monday 

Parameter: 

Date 
Number           (optional) 

Return value: 

Number 
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Year 

Purpose: 

Determines the year of a date and returns it as a number. 

Parameter: 

Date 

Return value: 

Number 

Example: 

Year(Today())              Result: 2006 
Year$(Date("1.1.2006"))         Result: 2006 
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Year$ 

Purpose: 

Determines the year of a date and returns it as a string. 

Parameter: 

Date 

Return value: 

String 

Example: 

Year$(Today())             Result: "2006" 
Year$(Date("1.1.2006"))         Result: "2006" 
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List of Available Barcodes 

 

 List of Available Barcodes 
InLoox supports a wide range of barcode formats. Normally, no special printers, fonts, etc. are necessary, the barcodes 
will be printed directly from InLoox. 

The following bar codes are available in InLoox: 

 

  

  

  

 
See also: 

2-of-5 Industrial 

2-of-5 Interleaved (ITF) 

2-of-5 Matrix 

2-of-5 Datalogic 
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Aztec 

Codabar 

Alpha39 (or also 3-of-9 or Code39) 

Code39 with CRC 

Code93 (simple and extended) 

Code128 

CODE11 

Datamatrix 

DP-Identcode 

DP-Leitcode 

EAN128 

EAN13, JAN13 

EAN14, UCC14 

EAN8, JAN8 

FIM Barcode 

German Parcel 

Japanese Postcode 

MSI 

Maxicode and PDF417 

Pharma-Zentral-Nummer 

Postnet 

RM4SCC, KIX( 

Royal Mail 

SSCC/NVE 

UPC-A 

UPC-E 
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2-of-5 Industrial 
A number code of low information density. 

Permitted characters: '0'..'9' 

A Code is (14*number of characters+18) bar widths wide. 
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2-of-5 Interleaved (ITF) 
A number code of high information density, requires high print quality. 

Permitted characters: '0'..'9'. The number of characters must be even. 

A code is (9*number of characters+9) bar widths wide. 
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2-of-5 Matrix 
A number code of high information density, requires high print quality. 

Permitted characters: '0'..'9'. 

A Code is (10* number of characters +18) bar widths wide. 
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2-of-5 Datalogic 
A number code of high information density, requires high print quality. 

Permitted characters: '0'..'9'. 

A code is (10* number of characters +11) bar widths wide. 
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Aztec 
2D barcode system with high information density and excellent scanability, which is highly optimized and has high error 
tolerance. The Aztec barcode is mostly used in medicine technology, transport sector and administration. Character set: 
All available and unprintable characters. Minimum length 12 characters up to approx. 3000. 
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Codabar 
The Codabar-Code is a numerical code with 6 special characters. The information density is low. The code must conform 
to the following format: 

"fnnnnf" 

  

with 

▪     f       = Frame code ('A', 'B', 'C', or 'D') 

▪     nnnnn = arbitrary quantity of numbers or special characters ('0'..'9', '-', '$', ':', '/', '.', '+') 

Every character is either 2*3+6*1 (characters '0'..'9', '-', '$') or 3*3+5*1 (characters ':', '/', '.', '+', 'A'..'D') bar widths wide. The 
characters for the frame code will not be printed with the text. 
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Alpha39 (or also 3-of-9 or Code39) 
One of the few codes that can also display letters. All characters must be entered; the customary bracketing with ´*´ 
should also be entered ('*TEST*'). 

Permitted characters: ' ','$','/','%','*','+','-','0'..'9','A'..'Z' 

The expanded code can be activated by a combination of the standard code: for example: '+A' -> 'a'. Every character is 16 
bar widths wide, a text has (16*number of characters -1) bars. 
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Code39 with CRC 
Character set: ' ','$','/','%','*','+','-','0'..'9','A'..'Z' 
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Code93 (simple and extended) 
Code93 is an extension of Code39, but has the advantage that it is somewhat smaller. It covers the complete 128 bytes of 
the ASCII character set, including zero. This must be transferred as chr$(255). 

It contains two check digits that are automatically generated by InLoox. 

The characters consist of 9 bar widths, that each have 3 bars and 3 spaces. There are two options for the extended code: 

- transfer of the shift character from the host program as 

$        chr$(254) 

%       chr$(253) 

/        chr$(252) 

+       chr$(251) 

- transfer of the desired character, L&L adds the appropriate shift character. 
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Code128 
This code is basically identical to EAN128, with the exception that the first character (FNC1 ... FNC4) is defined by the 
user. 

The explanations with EAN128 apply here as well. 
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CODE11 
Character set: '0'..'9','-'. 

Code 11 has, depending on the length, 1 or 2 check digits. InLoox calculates only 1 instead of 2 check digits if the length 
of the text is a maximum of 10 characters. 
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Datamatrix 
(Application dependent) 

This barcode is used in many different industrial areas. Most printable characters can be displayed. In addition, very 
dense information is provided and can still be scanned correctly with extensive damage. You can freely choose symbol 
size or choose a symbol size which is  automatically adapted to object size. These properties can be found in the option 
dialog of the barcode. 
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DP-Identcode 
A number code of high information density, requires high print quality. 

Permitted characters: '0'..'9'. 

The code must conform to the following format: 

"nn.nnnnn.nnnn" 

"nn.nnnn.nnnnn" 

"nn.nnn.nnnnnn" 

A Code is (9*Number+9) bar widths wide. 

Width: 32,0mm - 58,5mm (Clear zone right and left: minimum 5mm). height: 25mm. 

The check digit is calculated automatically; Relation: 4:9; Special code of 2 of 5 IL. 
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DP-Leitcode 
A number code of high information density, requires high print quality. 

Permitted characters: '0'..'9'. 

The code must conform to the following format: 

"nnnnn.nnn.nnn.nn" 

A Code is (9*Number+9) bar widths wide. 

Width: 37,25 mm - 67,5 mm (Clear zone right and left: minimum 5mm). Height: 25mm. 

The check digit is calculated automatically; Relation: 4:9; Special code of 2 of 5 IL. 
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EAN128 
This code can display all printable ASCII-characters, as well as non-explicit characters, umlauts and 'ß'. The text can have 
any appearance. The width is not easy to display because certain characters have different widths. 

Special characters            must be replaced with: 

Character              Replacement [using chr(...), chr$(...)] 

NUL              chr$(255) 

FNC1            chr$(254) 

FNC2            chr$(253) 

FNC3            chr$(252) 

FNC4            chr$(251) 
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EAN13, JAN13 
The EAN13-(International Article Numbering)-Code is a very common barcode. The number string used with EAN13 must 
conform to one of the following formats: 

"cc|nnnnn|aaaaa"   (normal EAN13) 

"cc|nnnnn|aaaaa|xx"        (EAN13 for periodicals, "ISSN") 

"cc|nnnnn|aaaaa|xxxxx"   (EAN13 for books, "Bookland") 

"ppp|nnnn|aaaaa"   (normal EAN13) 

"ppp|nnnn|aaaaa|xx"       (EAN13 for periodicals, "ISSN") 

"ppp|nnnn|aaaaa|xxxxx"  (EAN13 for books, "Bookland") 

  

with 

  Description ValueRange 

Cc Country code c='0'..'9' 

Ppp Product code   

Nnnnn Company code n='0'..'9' 

aaaaa Article code a='0'..'9' 

'|' = Character code chr(124)   

xx, xxxxx Supplemental code x=´0´..´9´ 

  

The check digit will be calculated and attached automatically. Each character is 7 bar-widths wide, a code should have a 
minimum width of (12*7+11)*0.3 mm = 2.85 cm. 

Ideal size (bar symbol) nominal size SC2: 

Width = 31.4 mm 

Height = 24.5 mm 

  

Minimum offset that should be kept free around the symbol: 

left:    3.6 mm 

top:    0.3 mm 

right:  2.3 mm 

bottom:        0.0 mm 

The text may partially exceed this area. 
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EAN14, UCC14 
These number codes require a high print quality. 

Permitted characters: '0'..'9'. The code must be 14 characters long. 
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EAN8, JAN8 
The number string in EAN8 must conform to the following format: 

"nn|nnnnn" 

with 

▪     n       = '0'..'9' 

▪     |       = Character code chr(124) 

Each character is also 7 bar widths wide, a code should then have a minimum width of (8*7+11)*0.3 mm=2.01 cm. 

Ideal size (bar symbol)        nominal size SC2: 

▪     dx :                  22.1 mm 

▪     dy:                   19.9 mm 

Minimum offset that should be kept free around the symbol: 

▪     left:          2.3 mm 

▪     top:          0.3 mm 

▪     right:         2.3 mm 

▪     bottom:             0.0 mm (if printed, otherwise 0.3 mm) 

The text may partially exceed this area. 
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FIM Barcode 
Minimum size: 1/2" * 5/8" = 12.7 mm * 15.87 mm. 

Transfer values: "A", "B" or "C". 

The FIM-Barcode is always printed to the size required by the United States Postal Service. It can expand beyond the 
object frame. 
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German Parcel 
A number code of low information density. 

Permitted characters: '0'..'9'. 

A Code is (14*Number+18) bar widths wide. 

Relation: 1:2 
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Japanese Postcode 
Japanese postcode. 

Allows characters: n=[0-9], Address=[A-Z], [0-9], [-] 

Formats:   nnn-nnnn, then max. 13 character address 
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MSI 
MSI is a binary barcode in which every character consists of 8 bars. 

The character set is limited to '0'..'9' and is suitable only for the display of numbers. Commonly used in libraries. 
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Maxicode and PDF417 
(Application dependent) 

Character set: Most available and also non-printable characters. To use non-printable characters in barcode text, tags in 
the form {binary:xx} can be used in the barcode text, with xx standing for any sequence of two digit hexadecimal numbers. 
This is especially important when Maxicodes are to be created to UPS specifications. The required special characters can 
be entered in this way. 

Example 1: To encode a NULL and a backspace (BS) symbol in the data, use "{binary:0008}" (corresponds to 
"{binary:00}{binary:08}"). 

Example 2: To pass on a page break, use "Hello{binary:0d0a}World". 
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Pharma-Zentral-Nummer 
Character set: '0'..'9' 

The PZN code is used for identifying pharmaceuticals. The pharmaceutical central numbers (=PZN) are distributed by the 
"Informationsstelle für Arzneispezialitäen IfA GmbH''.  The represented string of numbers  has to correspond to the 
following format: 

"nnnnnn" 
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Postnet 
This is a barcode used by the United States Postal Service. It is available in three variants. In reference to placement and 
offset from other objects, please refer to the specifications in the appropriate literature. 

5-digit:         "nnnnn" 

10-digit:       "nnnnn-nnnn" 

12-digit:       "nnnnn-nnnnnn" 

Minimum size: 1.245" * 4/16" = 31.6 mm * 6.35 mm (10-digit). 

Minimum bar spacing 1/24" = 1.058 mm. 

The error-correction digit will be automatically amended. 

This barcode will be automatically printed in the correct size. 
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RM4SCC, KIX® 
Character set: '0'..'9', 'A'..'Z', 'a'...'z'. 

This barcode is used by the Dutch post in distribution. Make sure to pass on a content according to the specification. For 
further information please contact the Dutch post. 
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Royal Mail 
Character set: '0'..'9', 'A'..'Z', 'a'...'z'. 

This code is used with the mail merge procedures "Cleanmail" and "Mailsort" by the British "Royal Mail" to encode postal 
codes. Royal Mail postal codes contain a combination of numbers and letters. The character set therefore includes the 
numbers 0..9 and capital letters A..Z. The space character is not included. 

Either the postal code (e.g. LU17 8XE) or the postal codes with an additional "Delivery Point" (e.g. LU17 8XE 2B) are 
encoded. The maximum number of usable spaces is therefore limited to 9 digits. 
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SSCC/NVE 
The SSCC (Serial Shipping Container Code) barcode is being increasingly used in the logistics industry. 

Character set: [0-9] 

Format: nnnnnnnnnnnnnnnnn (17 figures) 
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UPC-A 
The UPC-A-Code (Universal Product Code) is common in the USA. The code must conform to the following format: 

"c|nnnnn|aaaaa" 

with 

▪     c       = Number system 

▪     nnnnn = Company code 

▪     aaaaa = Article code 

▪     |       = Character code chr(124) 

The check digit will be calculated and attached automatically. Each character is also 7 bar widths wide, a code should 
then have a minimum width of (13*7+6)*0.3 mm=2.88 cm. 
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UPC-E 
The UPC-E-Code (Universal Product Code, short version) is common in the USA. The code must conform to the following 
format: 

"c|nnnnn" 

with 

▪     c       = Number system 

▪     |       = Character code chr(124) 

▪     nnnnn = Code, interpretation dependent upon the last digit 

The check digit will be calculated and attached automatically. Each character is also 7 bar widths wide, a code should 
then have a minimum width of (13*7+6)*0.3 mm=2.88 cm. 
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 List of ISO 3166 Country Codes 
The following country codes can be used with, among others, the Loc.. functions. (CountryCode: Prefix): 

  

ALB 355 COL 57 GTM 502 NIC 505 SVK 42 

ARG 54 CRI 506 HND 504 NLD 31 SVN 386 

AUS 61 CZE 42 HRV 385 NOR 47 SWE 46 

AUT 43 DEU 49 HUN 36 NZL 64 TTO 1 

BEL 32 DNK 45 IDN 62 PAN 507 TUR 90 

BGR 359 DOM 1 IRL 353 PER 51 UKR 380 

BLR 375 ECU 593 ISL 354 POL 48 URY 598 

BLZ 501 ESP 34 ITA 39 PRI 1 USA 1 

BOL 591 EST 372 JAM 1 PRT 351 VEN 58 

BRA 55 FIN 358 LIE 41 PRY 595 ZAF 27 

CAN 2 FRAU 33 LTU 370 ROM 40     

CAR 1 FRO 298 LUX 352 RUS 7     

CHE 41 GBR 44 LVA 371 SLV 503     

CHL 56 GRC 30 MEX 52 SPB 381     
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Troubleshooting 

INLOOX ERROR MESSAGES 

Below is a list of error messages and proposed solutions. 
If the problem cannot be solved from here, please refer to our support service, who can be reached online under 
www.inloox.com/support/ 

  

Database-oriented errors 

Error message Solution 

Error: The InLoox database is not available. 
Error on establishing link with the server... 

• Check that the network is accessible. 

• Check whether offline configuration, if any, is 
correct. 

• Refer to your system administrator. 

You are using InLoox client version X.X. 
The InLoox database version is Y.Y.  
Please ensure that you are using the appropriate 
version of the product or refer to your system 
administrator. 

The InLoox client version being used does not match 
the database version on the server. please update the 
InLoox client. 

  

  

Licence-oriented errors 

Error message Solution 

The licence code input does not tally with version of 
InLoox being used. 

The licence code you have input is for an earlier or later 
version of InLoox. More information can be found in the 
chapter on Licence Management 

A licencing error has occurred. Please check the licence 
code or refer to your system administrator. 

The licence code you have input is not valid for the 
installed version of InLoox. Please request a valid 
licence code. More information can be found in the 
chapter on Licence Management 

The maximum number of clients has been reached. It is 
not possible to use InLoox. 
Please check the licence code or refer to your system 
administrator. 

Your InLoox installation is licenced for a specific number 
of workstations. This number has been exceeded. 
Please obtain a supplementary licence for the required 
number of additional workstations. More information can 
be found in the chapter on Licence Management 

  

  

  

Report-oriented errors 
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Error message Solution 

The report template contains an error. An expression 
used in the template is incorrect.  
Please correct the report template. 

Please check the report template with the help of 
Documentation for the InLoox Report Designer 

The report contains no data. Empty reports cannot be 
created. 
Please edit the report template. 

The report template is empty. Please update the 
template with the help of the chapter Detailed 
Information: Configuration: Customizing Report 
Templates and the Documentation for the InLoox 
Report Designer 

No printer is installed. 
Please install a printer to output reports. 

A printer must be installed to output a report. Please 
install the driver needed by your printer. For more 
information please refer to the user manual for your 
printer. 
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PROGRAM EXCEPTIONS IN INLOOX 

There are certain rare configurations that will cause the software to behave unpredictably. To cater for this we have 
developed a special message dialog box which permits more accurate examination of the problem. If such an exception 
occurs in your installation, there are various ways of informing us of it. These options are described below. 

  

InLoox dialog box for exception handling: 

 

This dialog box allows our developers to localize an unpredicted condition more precisely and make future versions of 
InLoox more stable. 

  

Click on Details: 

 

  

All the exception data that the system has compiled are displayed. 

Use the button Send report by email to send us the error via your email program. 

This mail does not contain any personalized information or database contents, except your sender email address. This 
allows our technical staff to solve the exception in direct collaboration with you. 

  

This information is sent to our technical staff: 
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You can, of course, also contact our Support directly in the usual manner. Please be sure to have the contents of the 
exception dialog box to hand. 
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Extending and Customizing InLoox 

DETAILED INFORMATION: CONFIGURATION: CHANGING THE LANGUAGE 

InLoox is a multilingual system. The operating language adjusts automatically to the Region and Language Options in 
the Windows Control Panel. The language can be changed manually during operation of InLoox at any time without the 
need to restart. 

  

A brief instruction on changing the operating language: 

1. Click on the menu Tools in the InLoox Toolbar 

2. Move the cursor to the menu command Tools >> Language 

3. Select a language, e.g. German, English, French, Spanish, Italian, from the list 
InLoox changes the language of all screens. 
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DETAILED INFORMATION: CONFIGURATION: CUSTOMIZING THE INLOOX LANGUAGE 
FILES 

InLoox uses so-called resource files for all texts and messages that it displays. These are located in the program folder on 
the InLoox client. 

  

Important Notes: 

• Changing the files can cause problems with the program, especially if data are deleted. 

• When you re-install the InLoox client setup will overwrite any changes you have made to the language files. 

  

List of language files (as delivered) 

Filename Contents 

InLoox.resources Standard language (English) 

InLoox.de.resources German-language version 

InLoox.fr.resources French-language version 

InLoox.es.resources Spanish-language version 

InLoox.it.resources Italian-language version 

  

A brief summary of how to customize the language resource files: 

1. Close Outlook on the client concerned. 

2. Open the relevant language file with the InLoox Resource Editor. This tool can be found in the Download 
area of the Support Center. 

3. Make the required changes to the file and save. 

4. Test the changes on the InLoox user interface. 

5. Distribute the file among other InLoox clients as required. 
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LICENCE MANAGEMENT 

At the time of Installation you have specified a valid licence code. 

The licence code consists of five groups of four alphanumeric characters each in the following format: 1111-2222-3333-
4444-5555 

  

Your licence code is valid as follows: 

• for one version of InLoox (Personal 5.x/Workgroup 5.x/Enterprise 5.x) 

• for a specific number of clients and servers 

• for an unlimited time 

  

The following restrictions apply: 

• InLoox Personal cannot be used as a server 

• When the maximum number of registered clients (workstations / computers) has been reached, InLoox will no 
longer function on any clients on which it was last installed or started. 

• The licence manager on the terminal server counts the number of active users for whom InLoox has been 
released. 

   

InLoox monitors the permissible number of clients. The following message is displayed to indicate that there are too few 
licences: 

"The maximum number of clients has been reached. It is not possible to use InLoox. 
Please check the licence code or refer to your system administrator." 

  

The following procedure is needed initially to be sure that only those clients and/or active users onn which InLoox is 
currently installed are counted: 

1. Click on the menu command Tools >> Licence in the InLoox Toolbar  
This menu command is only displayed to users with InLoox administrator permission. 

2. In the dialog box InLoox Licence Manager click on the button Remove Client Licenses 

3. Click on OK 

If the error message persists, InLoox must be removed from the excess clients or additional licenses acquired. Please 
refer to your reseller or the manfacturer for this. You will receive by return a license to release the required number of 
clients for operation of InLoox. 
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Personal Views / Workflows 

DETAILED INFORMATION: CONFIGURATION: HINTS ON PERSONALIZED VIEWS 

InLoox provides many options for sorting and organizing data. Furnishing your projects with personalized views is 
particularly easy and quick. These help the flexible display of data.  

  

Hint: How to change a standard view: 

• It is possible to add and delete columns in the Project Overview. If a required aspect of the data is missing, 
simply add the corresponding field:  

1. Click on the column Number in the InLoox Project Overview with the right-hand mouse button 

2. Click on the menu point Choose Fields 
The dialog box Choose Fields is displayed 

3. Click in a field, e.g. Customer, hold the mouse button down and drag the field next to the column 
Number 
Two red arrows are displayed 

4. Add the field to the view by simply letting go the mouse button. 

 

Further hints: 

• All features provided by Outlook for sorting, grouping and filtering can be used in the InLoox Project Overview. 
Click for example on a column to sort by it or drag the column into the area above the column headers to set up 
a grouping 

• Create new views and offer them to all users, e.g. Open costs, Projects by Customer or Projects by Status. 
Instructions can be found in the chapter on Defining Views 

• Define individual filters for all users, e.g. by project status. This is a way to transact simple workflows. 
Example: The development department staff only sees projects with the status development. If the status 
changes to Bill, the project becomes visible to accounting staff; for other persons the project remains hidden. 
Instructions can be found in the chapter on Finding projects under "Filter" 
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DETAILED INFORMATION: CONFIGURATION: GENERATING PERSONALIZED VIEWS 

InLoox provides many options for sorting and organizing data. Furnishing your projects with personalized views is 
particularly easy and quick. These help the flexible display of data.  

  

Use of a personalized view is as follows: 

1. Click on the button InLoox Folder in the InLoox Toolbar 
Outlook switches to the InLoox Project Overview 

2. Click on the list Current View 

3. Select a view from the list, e.g. Project Controlling 

  

Hints on the customizing of views can be found in the chapter on Hints on Personalized Views 

The following views are included in InLoox as standard: 

Name Appearance/Filter/Grouping Purpose 

Active Projects Filter; all non-completed projects  To show all active projects, for example to 
create turnover lists or support customers 

Inactive Projects Filter; all completed projects To inspect archived project records 

Projects by 
Category 

Grouping; all projects grouped by the field 
Category 

Helps to maintain overview as projects 
multiply 

Projects by Status Grouping; all projects grouped by the field 
Status 

Displays internal procedure 

Projects by Project 
Manager 

Grouping; all projects grouped by the field 
Project Manager 

Displays internal responsibilities and 
allocated projects 

Projects by 
Customer 

Grouping; all projects grouped by the field 
Customer 

Displays external responsibilities and 
allocated projects 

Negative Gross 
Result 

Filter; all projects in which the total costs 
are higher than the invoices rendered 

To identify losses and determine financing 
requirements 

Open Calculations Filter; all projects with open budgets of type 
Calculation 

To determine turnover potential and follow 
up on offers 
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Legal Notices and Agreements 
END USER LICENSE AGREEMENT (EULA) 
   

License Terms of IQ medialab GmbH  

End-User License Agreement (EULA) 

   

By using this Software Product (including installation and copy) you declare that you agree with this Agreement as a 
natural person and legal entity. If you do not agree with this EULA you are not entitled use the Software.  

  

§ 1 Validity of the Terms of Agreement  

(1) This End User License Agreement (EULA) is concluded between you – hereinafter also referred to as Customer – and 
IQ medialab GmbH – hereinafter also referred to as IQ medialab . The licensing / purchase of Software and obligations 
precedent to the Agreement shall exclusively be subject to the Terms of Agreement unless otherwise agreed. We 
exclusively refer to the regulations of the General Terms of Business of IQ medialab which are integrated into this 
Agreement and form an essential part of it. The Customer confirms that he has taken note of the General Terms of 
Business of IQ medialab. The regulations of the General Terms of Business are extended and/or supplemented by the 
objective License Terms of IQ medialab with regard to the use of software and other software-specific regulations and the 
corresponding rights and obligations. In case the General Terms of Business of IQ medialab deviate from this Agreement 
or if they are inconsistent with it, these License Terms shall prevail.  

(2) IQ medialab licenses/sells the enclosed Software to the Licensee (Customer) exclusively on the basis of the License 
Terms hereinafter. In case you do not agree with these Terms, do not open the package or seal of the Software, refrain 
from installing the Software, click on the “No” button of the installation process and uninstall the Software when the 
corresponding inquiry occurs during the installation and return the properly purchased Software together with packaging, 
license key and receipt voucher to the Software vendor within 30 days of the purchase of the Software. Subsequently, you 
will receive full reimbursement of the purchase price you paid.  

   

§ 2 Subject Matter of the Agreement  

(1) Subject matter of this Agreement is the granting of the rights of use in accordance with §3 depending on the type of 
license purchased in each case and its extent of functions. By purchasing this Software you become the owner of the 
Software storage medium (e.g. a CD-ROM), but not of the Software itself. The Software is licensed, not sold. The 
Software shall always remain the intellectual property of IQ medialab. As a purchaser of the Software you shall only be 
entitled to use the proprietary object, i.e. to use the Software as agreed upon. IQ medialab grants this right of use in the 
form of a license.  

(2) The Customer has checked whether the Software specification meets his desires and requirements before concluding 
the Agreement. He knows the essential functional qualities and conditions of the Software.  

(3) Product descriptions and presentations in test programs are service descriptions but are not warranties. Warranties 
require a written statement from IQ medialab company management.  

(4) The Customer is not entitled to receive a license for the source program.  

(5) IQ medialab renders all deliveries and services in accordance with the state-of-the-art.  

(6) IQ medialab reserves all rights which are not explicitly mentioned in this EULA.  

(7) If the Software is marked “Not for resale” (or “Nicht zum Weiterverkauf bestimmt”) in any way it may neither be resold 
nor transferred.  

(8) The Software may then be exclusively installed on a network server if the License purchased by the Customer is 
explicitly designated as “server license”. In the event that the Software is used in a network the Customer must ensure 
that there is a License for each data processing unit having access to the server and the possibility to use the Software.  
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(9) The software is licensed as a whole. You may not separate its components and/or use it for distinct application on 
more than one computer other than described in the software user documentation.  

  

§ 3 The Customer's Rights to the Software  

(1) The Software, all additional programs, the symbols used, IQ medialab logo, written documents as well as 
documentation are legally protected. The copyright, patent rights, trademark rights and all other rights in goods and 
services as well as industrial property rights to the Software and other above-mentioned objects which IQ medialab makes 
available or hands over to the Customer as part of the process to set up and implement the Agreement are the exclusive 
property of IQ medialab in the relationship of the Parties. Should third parties be entitled to any rights, IQ medialab shall 
have the corresponding rights of use.  

(2) The Customer purchases the Software in order to use it for his own purposes on a permanent basis (non-exclusive 
license). The Customer is entitled to use the quantities of Software for which he purchased licenses. The Customer shall 
ensure that the number of copies of the Software installed simultaneously corresponds to the maximum number of 
purchased licenses. IQ medialab hereby grants the Customer the right to use the programs which are necessary for these 
purposes as well as the right to copy programs on the main memory and hard disks as well as the right to correct errors. 
The Customer is entitled to make backup copies of the programs necessary for safe operation. The backup copies must 
be marked as backup copies. Copyright notes must not be deleted, changed or suppressed. The Customer may 
exclusively use the Software for each license on a standalone computer, no matter if it is a workstation, notebook or PDA 
except in such cases where he purchases a network license. The use of the Software also implies loading the Software 
into the temporary memory of a computer or similar object or installing the software on a permanent storage medium (e.g. 
hard disk, DVD, CD-ROM, or similar). However, the Parties may come to differently worded agreements in an individual 
Agreement issued in writing.  

(3) A user manual and any other documents possibly provided by IQ medialab may only be copied for the company's 
internal purposes.  

(4) The Customer shall not be entitled to transfer the Software without the written consent of IQ medialab; this applies in 
particular in the event of sale. IQ medialab shall agree to the passing-on of the Software (in whole or in part) to a third 
party under the following conditions:  

– The Customer hands over the original data storage media (if there is one), this EULA and the General Terms of 
Business of IQ medialab to the third party, deletes all other copies in particular on data storage media, in read-only 
memories or main memories, he definitely stops using the Software and submits a written confirmation of the fulfilment of 
his duties to IQ medialab.  

– The third party declares to IQ medialab in writing that it has received the aforementioned components and 
acknowledges them as binding in the legal relationship with IQ medialab, noting the General Terms of Business and this 
EULA.  

 – There are no important opposing reasons.  

(5) All other acts of utilisation, in particular leasing, industrial sale (unless explicitly stated otherwise by written reseller 
agreement/authorised dealer agreement), lease and distribution of any tangible or intangible property are prohibited 
without the prior written consent of IQ medialab. IQ medialab notes, that customers who violate copyright laws, are liable 
for all damages that occur as a result of these copyright law violations.  

(6) Any subject matter of the Agreement, documents, proposals, test programs, etc. of IQ medialab to which the Customer 
gains access after conclusion of the Agreement shall be considered intellectual property and must be treated 
confidentially as a business and company secret of IQ medialab in accordance with § 9.  

  

§ 4 Contractual Obligation and Termination of the Agreement  

In the event of termination due to infringement of this EULA you are obliged to return or destroy all original versions and 
copies of the Software and all other components and to notify IQ medialab of the destruction in writing.  

  

§ 5 Obligations of the Customer  
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(1) In the event that you are a business owner you undertake to inspect all delivery items of IQ medialab immediately 
upon receipt of the goods in accordance with the regulations of commercial law (§ 377 of the German Commercial Code) 
and to make complaints in respect of defects with an exact description of the defect, submitted in writing. Each Customer 
is obliged to test all modules with regard to usability in the concrete situation before starting any operative use. This also 
applies to programs the Customer receives in the context of supplementary performance or a possible maintenance 
agreement.  

(2) The Customer shall take adequate precautions to counter situations where the program does not operate properly in 
whole or in part (e.g. by data backup, error diagnosis, regular check on the results). The Customer shall be responsible for 
ensuring the operation of the working environment of the program. He shall be obliged to carry out the necessary 
adjustments to his firewall, virus scanners or similar data protection mechanisms in his network as well as his server. IQ 
medialab shall not bear the risk of incompatibility of the Software with the software or hardware used by the Customer.  

(3) You shall not be entitled to use or modify the logo and/or trademarks of IQ medialab unless the company management 
of IQ medialab has given its prior agreement to the use or modification of the logo in writing.  

(4) Subject to the provisions of § 69 e German Copyright Act (UrhG) you may not reverse engineer, decompile or 
disassemble the Software.  

(5) You undertake to indemnify and defend IQ medialab from all claims of third parties, including reasonable lawyers' fees 
arising or resulting from any use of this Software against the agreement.  

  

§ 6 Warranty  

1. Delivered software possesses the agreed-upon characteristics, is suitable for the applications assumed by the contract 
and which are otherwise standard, and has usual quality of software of this type. Not every flaw which is connected with 
the software is a defect which implies warranty rights. An impairment in the software's functioning which results from 
hardware defects, environmental conditions, improper operation and the like, is not a defect. An insignificant deterioration 
in quality will not be taken into account. IQ medialab guarantees that no rights of third parties are violated through the use 
of the software by the customer in accordance with the provisions of the contract.  

2. Customers who are consumers within the meaning of § 13 German Civil Code (BGB) have in respect to defects of the 
purchased good the rights set out in the German Civil Code (BGB). In case that a consumer is entitled to claim damages 
hereafter, § 7 applies accordingly.  

3. In all other cases of liability for defects the following terms apply:  

a) IQ medialab may first attempt to remedy any material defects. IQ medialab may choose to remedy the defect by 
eliminating it, i.e. also by demonstrating possibilities by means of which the effects of the defect can be avoided, or 
through delivery of a program which does not contain the defect. An equivalent new program version or the equivalent 
previous program version which had not contained the faults is to be accepted by the customer, when this is reasonable. 
In the case of defects in title, IQ medialab shall give the assurance that it will provide the customer with legally 
unchallengeable option to use either the software or equivalent software, at its option.  

b) The customer shall support IQ medialab in the analysis of faults and removal of defects by specifically describing 
problems which occur, providing IQ medialab with complete information and granting it the necessary time and 
opportunities to remove the defect. IQ medialab may also remove the defect on-site or at its place of business, at its 
discretion. The performance of IQ medialab may also take the form of remote maintenance. The customer must ensure 
the necessary technical prerequisites at his own expense and, after due prior notification, provide IQ medialab with 
access to his computer equipment.  

c) IQ medialab may levy additional charges, when the software is modified, employed outside the environment provided 
for or incorrectly operated. It may demand compensation if no defect is found or if it is incorrectly/insufficiently informed of 
a fault. The burden of proof lies with the customer in accordance with § 254 German Civil Code (BGB).  

d) If IQ medialab ultimately refuses to remedy the defect, if it ultimately is unsuccessful or if this is unreasonable for the 
customer, he may withdraw in writing from the contract or correspondingly curtail the payment and in accordance with § 7 
demand damages or reimbursement of expenses.  

e) Insofar as the above has not been otherwise agreed, further liability on the part of IQ medialab within the meaning of 
liability for defects is excluded. In particular, liability for defects does not apply if and to the extent that the software is 
improperly used by the customer or used in a defective or incompatible hardware or software environment. The same 
applies in the event that the customer undertakes unauthorised modifications of the software.  

g) The statute of limitation for claims for defects is one year as of the statutory commencement of the limitation period.  

   



Legal Notices and Agreements 

646 

§ 7 Liability  

The following limitations of liability apply in case of claims for damages of the customer arising from liability for defects or 
from any other reasons:  

1. IQ medialab is liable for intent and gross negligence in accordance with the statutory provisions. The same applies to 
injury of life, body or health as well as to claims arising from warranties or from the German Product Liability Act 
(Produkthaftungsgesetz, ProdHaftG).  

2. Moreover, IQ medialab is only liable for culpably infringing contractual obligations the fulfilment of which renders a 
correct execution of the contract possible, and the customer can always trust on said material obligations being observed 
(cardinal obligation). This includes, in particular, the obligation to fulfil a performance free from defects. In this case IQ 
medialab's liability is limited to the loss or damage foreseeable upon conclusion of the contract.  

3. A further liability of IQ medialab is excluded.  

4. Should the liability for damages on the part of IQ medialab be excluded or reduced, this shall also apply with regard to 
personal liability for compensation for damages on the part of its employees, representatives and persons employed in 
auxiliary tasks.  

5. The right to contest the charge of contributory negligence remains open to IQ medialab. It is pointed out to the 
customer that, within the framework of his obligation to exercise diligence, before using the software for the first time, he 
must test whether the installation of the software might lead to particular interference with pre-installed software, and that 
he must further ensure back-up of his data before the first installation as well as during the course of operations and, in 
the case of a suspected fault in the software, that he implements all additional reasonable measures required for security.  

6. The statute of limitation for claims of the client who is not a consumer is one year as of the statutory commencement of 
the limitation period.  

   

 § 8 Software Updates and Upgrades  

At the sole discretion of IQ medialab, users may be provided with updates and upgrades to the Software. IQ medialab 
retains the right to provide upgrades for a fee. Upon installation of an upgrade, users shall not use, separate or transfer 
the previous version to a third party separately. Unless IQ medialab provides other terms and conditions with an update or 
upgrade, the terms and conditions of this EULA shall continue to apply. Users may refuse to accept an update or upgrade. 
However, upon release of an update or upgrade, IQ medialab may have no further obligation to support the previous 
version.  

  

 § 9 Start and End of the Customer's Rights  

(1) The ownership of the supplied items and the rights in accordance with § 2 and § 3 shall not be transferred to the 
Customer until complete payment of the purchase price. Before that, he only has a preliminary right of use in accordance 
with the law of obligations, revocable in accordance with § 9 (2).  

(2) IQ medialab shall be entitled to revoke the rights in accordance with § 2 and § 3 for important reasons, in particular for 
the reasons specified in § 3 of the General Terms of Business of IQ medialab or to terminate the Agreement respectively. 
An important reason particularly exists if the Customer does not effect the due payment, if he continues to infringe the 
obligations under § 2 and § 3 of this Agreement in a substantial way, despite written reminders, or in the event that a 
petition of bankruptcy has been filed in respect of the customer's assets.  

(3) If the right of use in accordance with § 3 in conjunction with § 2 does not occur or if it should end, IQ medialab shall be 
entitled to demand from the Customer the return of the provided goods or demand a written assurance that they have 
been destroyed and that all copies have been destroyed, along with the written assurance that this has been effected.  

  

§ 10 Secrecy  

(1) The Contracting Parties undertake to treat all objects they receive from the other Contracting Party or objects they gain 
knowledge of (e.g. software, documents, information) which are legally protected, contain business or company secrets or 
are designated as confidential, confidentially - even beyond the expiration of the Agreement, unless these objects are 
publicly known without any infringement of the obligation of secrecy. The Contracting Parties shall store and save these 
objects in such a way that any unauthorised access by third parties is excluded.  
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(2) The Customer permits access to the subjects of the Agreement only by his personnel or third parties requiring access 
in order to perform their assigned tasks. He shall inform these persons about the need for these objects to be kept 
confidential.  

   

§ 11 Applicable law, legal venue  

The law of the Federal Republic of Germany shall be applicable, excluding the United Nations Convention on Contracts 
for the International Sale of Goods. The place of performance and legal venue for all disputes arising from and in 
connection with this Agreement shall be the registered office of IQ medialab GmbH (Munich , Bavaria) for agreements 
with business owners (traders). This also applies if the customer does not have a general place of jurisdiction in Germany 
or if his place of residence or usual abode is unknown at the time the proceedings are brought forth.  

  

§ 12 Safeguarding Clause  

If any provision of this Agreement should be or become invalid, such invalidity shall not affect the validity of the other 
provisions of this Agreement even if essential provisions are concerned. The Parties agree to replace the invalid provision 
by a legally effective regulation which comes as closest to the contractually stipulated legal and economic intent of the 
invalid provision and ensures the operability of the Agreement in the sense of what both Parties had intended. The same 
shall apply in the event that the Parties have not discovered a gap in the provisions at the time the Agreement was 
concluded or if such a gap becomes known or occurs later. In that case, the Parties shall be obliged to generate a written 
supplement to the Agreement in the sense of the aforementioned.  

   

Date: 2007-04-12 
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COPYRIGHT, TRADEMARKS 
   

InLoox® Copyright© 1999-2008 IQ medialab GmbH. All rights reserved. InLoox® and IQ medialab® are registered 
trademarks of the respective holders of the rights. 

Important notice: This software program is protected by copyright law. Unauthorized copying or sale of this software 
program or part thereof is punishable by law and will be prosecuted at both civil and criminal level and can result in severe 
punishment and claims for damages. 
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TROUBLESHOOTING 
Microsoft Outlook is a highly sophisticated product which is constantly under development. With ongoing Office and 
security updates, Exchange Server service packs and new versions of Windows, there is a wide range of supported 
platforms for InLoox. 

Solutions for error messages are to be found under InLoox error messages. 

Customers of IQ medialab, the manufacturer of InLoox, have access to a comprehensive, up-to-date support service for 
the entire range of InLoox products. Support service can be reached online under www.inloox.com/support/ 

  

Note: 

• Please have your customer number to hand. 

• You can also contact the manufacturer directly. 
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TRADING PARTNERS 
Would you like to include InLoox in your portfolio? As an InLoox partner you will, of course, be a reseller of software 
licences in the classical sense. But much more than this, you will also be providing consulting, after-sales, training, 
customizing, development and system integration services. We are offering a product of high quality with an excellent 
price/performance ratio, targeted at a broad and highly-challenging market.  

InLoox is a product of the Munich-based company IQ medialab GmbH. We are pleased to support our partners with 
marketing and sales documentation, training, and technical services and support. If you are interested in a partnership 
with IQ medialab, we will be very glad to hear from you. Our normal office hours are 9:00 am till 5:00 pm, Mondays to 
Fridays. Please note that we are in the CET time zone (GMT+1). 

IQ medialab GmbH  

Address: Lotte-Branz-Strasse 14, D-80939 Munich, Germany 

Internet: www.inloox.com  

Email: info@inloox.com  

Phone: +49 (89) 323 919 22  

Fax: +49 (89) 323 919 55  

 

 

 


